
 

 
 
 
 
 
 

PreciseVision Machine Vision System 
 
 
 

 

Introduction and 
Reference Manual 

 
Version 3.1.0, April 5, 2012 

P/N: PVS0-DI-00010 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Precise Automation Inc., 727 Filip Road, Los Altos, California 94024 
www.preciseautomation.com 

 



 

Document Content  

The information contained herein is the property of Precise Automation Inc., and may not be copied, 
photocopied, reproduced, translated, or converted to any electronic or machine-readable form in whole or 
in part without the prior written approval of Precise Automation Inc. The information herein is subject to 
change without notice and should not be construed as a commitment by Precise Automation Inc.  This 
information is periodically reviewed and revised.  Precise Automation Inc. assumes no responsibility for 
any errors or omissions in this document. 

Copyright © 2004-2012 by Precise Automation Inc.  All rights reserved. 

The Precise Logo is a registered trademark of Precise Automation Inc. 

Trademarks

Guidance 3400, Guidance 3300, Guidance 3200, Guidance 2600, Guidance 2400, Guidance 2300, 
Guidance 2200, Guidance 1400, Guidance 1300, Guidance 1200, Guidance 0200 Slave Amplifier, 
Guidance 0006, Guidance 0004, Guidance Controller, Guidance Development Environment, GDE, 
Guidance Development Suite, GDS, Guidance Dispense, Guidance Programming Language, GPL, 
Guidance System, Guidance System D4/D6, PrecisePlace 1300, PrecisePlace 1400, PrecisePlace 2300, 
PrecisePlace 2400, PreciseFlex 400, PreciseFlex 1300, PreciseFlex 1400, PrecisePower 300, 
PrecisePower 500, PrecisePower 2000, PreciseVision, RIO are either registered or trademarks of Precise 
Automation Inc., and may be registered in the United States or in other jurisdictions including 
internationally.  Other product names, logos, designs, titles, words or phrases mentioned within this 
publication may be trademarks, service marks, or trade names of Precise Automation Inc. or other entities 
and may be registered in certain jurisdictions including internationally. 

Any trademarks from other companies used in this publication are the property of those respective 
companies.  In particular, Visual Basic, Visual Basic 6 and Visual Basic.NET are trademarks of Microsoft 
Inc. 

Disclaimer

PRECISE AUTOMATION INC., MAKES NO WARRANTIES, EITHER EXPRESSLY OR IMPLIED, 
REGARDING THE DESCRIBED PRODUCTS, THEIR MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE.  THIS EXCLUSION OF IMPLIED WARRANTIES MAY NOT APPLY TO YOU.  
PLEASE SEE YOUR SALES AGREEMENT FOR YOUR SPECIFIC WARRANTY TERMS. 

Precise Automation Inc.  
727 Filip Road 
Los Altos, California 94024 
U.S.A. 
www.preciseautomation.com 



 

Warning Labels

The following warning and caution labels are utilized throughout this manual to convey critical information 
required for the safe and proper operation of the hardware and software.  It is extremely important that all 
such labels are carefully read and complied with in full to prevent personal injury and damage to the 
equipment. 

There are four levels of special alert notation used in this manual.  In descending order of importance, 
they are: 

 
 

DANGER: This indicates an imminently hazardous situation, which, if not 
avoided, will result in death or serious injury. 

 

 
avoided, could result in serious injury or major damage to the equipment. 

 

WARNING: This indicates a potentially hazardous situation, which, if not 

 

 

CAUTION: This indicates a situation, which, if not avoided, could result in 
minor injury or damage to the equipment. 

 

 

  NOTE: This provides supplementary information, emphasizes a point or 
procedure, or gives a tip for easier operation 
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PreciseVision Machine Vision System 

PreciseVision Introduction 
PreciseVision is a powerful, full featured 2D machine vision software package.  This software application 
includes a complete toolkit with everything that is needed to acquire vision images, identify and locate 
randomly positioned and oriented parts, measure key features and inspect parts for specific defects.  
Each of the basic vision functions is provided as a type of "Tool" in the vision toolbox and is internally 
designed as a modern software "Object".  

PreciseVision executes on a Windows PC system and includes a built-in interface to communicate with a 
Precise Controller via Ethernet. This software package has been designed to operate with the Guidance 
Programming Language, which executes on a Precise Guidance Controller, to produce flexible vision-
guided motion applications.  The Guidance Programming Language, GPL, includes a complementary 
built-in communications interface to PreciseVision and has classes and objects for easily controlling the 
operation of PreciseVision and retrieving vision results.  A complete vision guided robot application 
consists of a list of vision tools executing in PreciseVision and a GPL program executing on a Guidance 
Controller that takes the vision results and utilizes this information to alter the actions of a robot. 

PreciseVision includes a very easy-to-use visual programming interface that allows both simple and 
complex vision programs to be constructed by dragging-and-dropping tools into a list.  Training of the 
tools is performed by visually positioning and sizing tools on top of a captured camera image.  The 
parameters for each tool can also be access via a "Properties Table".  Since each tool is a software 
object, the output of one tool can be easily linked to the input of other tools.  This is a very powerful 
capability that allows the placement and the actions of tools to be a function of the results of previously 
executed tools and permits the results of several tools to be combined. 

To capture an image, PreciseVision supports third party Ethernet and USB cameras.  Vendor and part 
number information for purchasing and installing recommended hardware and drivers are provided in this 
document. 

While the most common configuration is to have PreciseVision interfaced to a single robot, information is 
also provided on executing PreciseVision without a robot or when connected to multiple robots.  

In addition to the normal mode of executing tools on a real camera image, this package also permits a 
sequence of images to be easily saved to disk and then subsequently played back.  This allows vision 
tools to be tested off-line and provides a convenient means for customers to obtain assistance from 
Precise and its partner companies remotely. 

In this document, instructions for installing PreciseVision and the supported 3rd party hardware is 
presented.  This is followed by an overview and quick start section that introduces machine vision 
newcomers to PreciseVision's principal concepts and permits experienced individuals to quickly use the 
system. Finally, the last sections of this manual provide detailed information on the system's user 
interface, toolkit and camera calibration procedures. 
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PreciseVision 

For further information on programming a vision guided robot application in GPL, please refer to the 
Guidance Programming Language, Introduction to GPL. 
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Supported Hardware and Software Installation 

Supported Vision Hardware 
PreciseVision is a software package and does not include hardware. This software is designed to capture 
vision images that are generated by either Ethernet or USB cameras. PreciseVision permits three camera 
options: 

1. DALSA Genie™ GigE cameras that communicate via a 10/100/1000 Ethernet 
connection 

2. IDS Imaging uEye™ cameras that communicate via a USB 2.0 connection 
3. Other 3rd party USB cameras (No customer support provided)  

Each of these options offers a range of camera resolutions, imaging element sizes and a choice of 
monochrome or color image capturing. The DALSA and IDS cameras have many of the same industrial 
features and a wide range of models are fully supported by PreciseVision. There are a host of other USB 
cameras available that range from very inexpensive web cams, to astronomy cameras, to industrial grade 
cameras, all with different prices, characteristics and installation procedures. Please contact Precise to 
determine if a specific USB camera has been qualified with PreciseVision. Precise is not able to 
provide support for USB cameras that have not been tested and qualified. 

When using the standard version of PreciseVision, the system can connect to multiple DALSA cameras 
or multiple USB cameras. However, you cannot connect to both DALSA and USB cameras 
simultaneously. In the Multi-Instance version of PreciseVision, the same rule applies to each instance, i.e. 
a single instance cannot be connected to a mix of DALSA and USB cameras. However, different 
instances can be connected to either DALSA or USB cameras. 

There are a number of trade-offs that should be considered when selecting the type of camera to use with 
PreciseVision. The following table summarizes the trade-offs between the DALSA and IDS cameras. 

Characteristic DALSA GigE  IDS uEye USB  

Cost Typically more expensive  

Typically 20% less expensive than 
equivalent DALSA cameras. Non-
industrial 3rd party USB cameras can 
be significantly less expensive.  

Resolutions 640x480 up to 1600x1200  
640x480 up to 2560x1920 with even 
higher resolutions to be announced 
soon.  

Acquisition time  Very similar to IDS for same 
resolution  

Very similar to DALSA for same 
resolution using USB 2.0 (480 
Mbits/sec). USB 3.0 (4.8Gbits/sec) due 
in 2011 will reduce the requisition time. 

Hardware 
synchronization  

Supports trigger input and 
acquisition output  Same as DALSA.  
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PC CPU Loading  Reduced load relative to 
USB cameras 

Higher load relative to Ethernet 
cameras. Multiple cameras will require 
a higher performance CPU. 5 or more 
cameras may degrade acquisition time. 

Cable length  100M 5M. Powered USB hubs might be able 
to extend length  

Max. number of 
cameras per PC  

Limited to 13-18 cameras 
per Ethernet subnet, 
maximum of 6 cameras per 
PV instance.  

Limited by how many cameras can be 
connected to and serviced by a PC 
using hubs, maximum of 6 cameras 
per PV instance.  Adding cameras to a 
port will reduce the pixel clock rate.  

Installation and 
support  

Fewer steps but more prone 
to complications due to 
firewalls, Ethernet card 
compatibility, Ethernet 
switch problems, and 
somewhat more 
complicated driver 
installation.  

Typically easier for single cameras if 
wired point to point since no firewalls, 
less issues with USB hardware 
interface, simpler driver installation.  
 
Multiple cameras are a bit more difficult 
to setup since each must be assigned 
an ID and registered with the 
DirectShow interface.  

Arm-mounted 
cameras  

Simpler to install on Precise 
robots since Ethernet cable 
and power available at end-
of-arm  

Requires extra external cable for 
Precise robots 

Power 12VDC 4 watts provided in 
second cable from extra PS 5VDC taken from single USB cable  

Size / weight 29x44x67 mm, <125g  34x32x34.4 mm, 75g  

In the following sections, part numbers are provided to allow hardware to be directly purchased from the 
hardware vendors together with simplified wiring drawings that illustrate how the components should be 
connected. 

Option 1:  DALSA Ethernet Cameras

• Each instance of PreciseVision supports up to 6 DALSA Genie™ GigE Ethernet 
cameras. See the table below for the recommended/supported camera models.  

• DALSA cameras can be directly connected to the PC running PreciseVision or 
through an Ethernet switch. 

• The PC must include a standard Ethernet card, but a GigE card is recommended 
for the best performance. 

• For more information, visit the DALSA website at www.imaging.com. For 
ordering, contact Manish Shelat at DALSA Digital Imaging, phone: (510) 249-
5664, email: manish.shelat@DALSA.com. 
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Hardware Specification  

ETHERNET 
CAMERAS 

 

M640-1/3, 640x480 resolution, 60 frames/second raw frame rate, 

 

M1400, 1392x1040 resolution, 15 frames/second raw frame rate, 

te, 

PreciseVision fully supports a number of DALSA Genie GigE 
Vision Cameras.  All models listed below provide Progressive 
scan, have metal cases, C-Mount or CS mount lens adapters, are 
available in monochrome (M) or color (C), and support an external 
trigger (DIN) and a digital output (DOUT). Effective frame-to-frame 
time depends on the exposure time that ranges from 100 
microseconds to 4 seconds, controlled via software, plus PC 
overhead. For total time, add vision processing time, which is 
typically less than 100ms. PreciseVision supports up to 6 DALSA
cameras. 
 
  
1/3" sensor.  
  M1024, 1034x779 resolution, 20 frames/second raw frame rate,
1/3" sensor. 
  
1/2" sensor.  
  M1600, 1600x1200 resolution, 15 frames/second raw frame ra
1/1.8" sensor. 

MOUNTING 
ADAPTER 

Optional DALSA mounting bracket assembly, 1/4" screw mount, 

 standard tripod. 
part # CA-GENA-BRA00.  This bracket is used for mounting the 
camera on a
Each camera requires 4 watts, 11 VDC to 13 VDC.   
 
Option 1: If you wish to break out the camera’s I/O p
DALSA part # CA-GENA-PS120 and the DALSA Ge

CAMERA POWER  

ins, order 
nie I/O and 

power breakout cable assembly, part # CA-GENC-IOP00. 

Option 2: If you do not need I/O signal break out, an alternative is 
the Intercon PSISP10, which includes a connector compatible 
with the camera but no I/O signal break out, 
www.nortechsys.com/intercon/index.html

ETHER
SW

net Switch. Netgear GS605 10/100/1000, or NET Standard GigE Ether
ITCH equivalent. 

ETHERNET CARD Standard GigE PC Ethernet card. Netgear GA311 PCI Gigabit 
Adaptor, or equivalent. 

ETHERNET CABLE Standard Cat-5 Ethernet cable. Total of 3 required. 
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Option 2:  IDS uEye USB 2.0 Cameras 

• Each instance of PreciseVision supports up to 6 IDS uEye™ USB 2.0 cameras. 
See the table below for the recommended/supported camera models.  

• IDS cameras are typically connected directly to the PC running PreciseVision 
although a USB hub can be used. 

• The PC must support USB 2.0 (not 1.0) and must have DirectX 9 or higher 
installed. PreciseVision uses DirectShow (DirectX) to interface to the camera 
driver.  

• It is highly recommended that only uEye ca port "Global" shutters 
be utilized and not "Rolling" shutters. A Gl r exposes all of the pixels of 
the imaging element at one time. A Rolling shutter exposes lines at different 
times. This can result in smearing if there is any movement in the image.  

• For flexibility in selecting the appropriate lens for your application, a camera with 
a C-Mount or CS-Mount is highly desirable. 

meras that sup
obal shutte

        

 

Hardware Specification  

USB CAMERAS 

PreciseVision fully supports the IDS Imaging Development 
Systems GmbH uEye USB 2.0 Cameras listed below.  All of the
models have Global Shutters, metal cases, C-mount lens 
adapters, are available in monochrome (M) or color (C), DB9 
signal/power connector, and support an external trigger (DIN) 
a digital output (DOUT). Effective frame-to-frame time depend
the exposure time and PC overhe

se 

and 
s on 

ad.  For total time, add vision 
 

eras. 

n, 15 frames/second raw 

w 

processing time, which is typically less than 100ms. PreciseVision
supports up to 6 USB cam
 
  UI-2410-M/C, 640x480 resolution, 75 frames/second raw frame 
rate, 1/3" CCD sensor.  
  UI-2230SE-M/C, 1024x768 resolution, 30 frames/second raw 
frame rate, 1/3" CCD sensor.  
  UI-2240SE-M/C, 1280x1024 resolutio
frame rate, 1/2" CCD sensor. 
  UI-2250-M/C, 1600x1200 resolution, 12 frames/second ra
frame rate, 1/1.8" CCD sensor.  
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CAMERA POWER  
C's power supply.  

Power is supplied directly by the USB cable and is generated by
the P

USB INTERFACE  PC must be equipped with USB 2.0 interface (not 1.0). 
USB CABLE, IDS uEye industrial cam
TRIGGER 

era cable: High speed 2.0 Extension 
cable - Screw type 4-Pin USB type A (F) TO 5-Pin micro-USB 

SUPPORT, NO 
DOUT  

type B (M). 3 meter length. Cable breaks out trigger input as 
separate input. CB-IDS-9UD-A-T-3M 

USB CABLE, 
TRIGGER AND 

Right angled trigger cable for uEYE-Cameras, 3 meter uEye Micro 
Sub-D connector, 90° angled with screws. USB signal via 
shielded USB 2.0 cable to USB-A. Breakout cable for trigge

DOUT SUPPORT and digital output, cable with open ends. CB-IDS-9UD-A-ST3M-
RT 

r input 

Option 3:  Other 3rd Party USB 2.0 Cameras 

The a
hobbyis
differen
gua te vide 
ass ta

Non he
plea  c

• lly optimized for the IDS 
u

• 

onment.  
• Many inexpensive cameras utilize the standard USB connectors that are retained 

by friction. It is relatively easy for these to become accidentally disconnected as 
compared to screw in DB connectors such as those used in the IDS uEye cameras.  

ntegrated fixed lens or lens mounts that 
re available. Also, many lens do not have 

screws for locking in the focus or F-stop adjustments.  

uirements. 
Also, since communication standards have not be established for these features, 
e eVision will probably not be 
a

Installing PreciseVision on a PC 
PreciseVision tes on a Windows PC system.  For the 

re e a wide variety of 3rd party USB 2.0 cameras that are available for the home, 
t, commercial and industrial markets. Due to the large number of vendors, their 
t installation procedures and their individual idiosyncrasies, Precise cannot 

r

ran e that any camera brand that you select will work properly and we cannot pro
is nce for any camera that has not been tested and qualified by Precise.

et less, if you wish to interface an unsupported camera without Precise's assistance, 
se onsider the following when selecting a USB camera. 

• PreciseVision utilizes DirectShow to interface to the camera. Therefore, the USB 
camera must be compatible with DirectShow, which is quite common.  
PreciseVison's image acquisition tool has been specia
Eye family of cameras. Other USB cameras will take somewhat more time to 

acquire an image.  
For similar features, a camera in a plastic case will be less expensive that a 

camera in a metal case. You must determine if the additional ruggedness of a metal 
case is important for your envir

• Many inexpensive cameras either have i
do not support the full range of lens that a

• Most cameras do not have trigger inputs and digital outputs. These are important 
features for conveyor belt tracking and other real-time image capture req

ven if the camera has these hardware features, Precis
ble to access this capability. 

 is distributed as a standalone application that execu
best results, it is suggested that this software be executed on the following equipment: 

• 2.3Ghz or faster Pentium 4 PC running Windows XP 
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• Depending upon the type of cameras to be utilized:  
o Gigabit Ethernet (recommended and required for certain cameras), 

otherwise 100Mb Ethernet interface 

 At least 1 GB of space on the PC's disk 
• A 2x CD-ROM drive interfaced to the PC 

While Preci e able to 
commun ided 
motion appli

o USB 2.0 interface  
• 512 MB of RAM 
•

seVision can be executed by itself to develop Vision Processes, the PC must b
icate with a Precise Guidance Controller via Ethernet in order to run a complete vision-gu

cation.  Please see the “Guidance System Setup and Operation, Quick Start Guide” for 
instruc communicate with each other.tions for configuring the PC and the Guidance Controller to 

If you pr
performing the steps below. If you are installing PreciseVision for the first time, you can 
instructi

eviously installed PreciseVision on your computer, you should un-install the old version by 
skip the first set of 

ons. 

»   Shut down all programs that are running including virus protection programs. 
 
»   Bring up the Window's Control Panel by clicking “Start > Settings > Control Panel”. 
 
»   Double click on the “Add or Remove Programs” selection. 
 
»   In the “Add or Remove Programs” popup window, scroll down and click on “PreciseVision”.
 
»   Click the “Remove” button and click on “Yes” to confirm the action. 
 
»    Close all of the windows that you opened. 

To install PreciseVision on your computer, perform the following steps: 

»   Shut down all programs that are running including virus protection programs. 
 
»   Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive. A panel should pop 
up that welcomes you to the Setup Wizard. If the installer does not automatically start, click 
“Start > Run”, type in “D:\setup.msi” (where D is the CD-ROM drive), and click “Ok”. 
 
»   Follow the instructions in the Setup Wizard to install PreciseVision.   Note, PreciseVision 
relies upon the Microsoft .NET Framework in order to operate.  This is a standard module that 
Microsoft provides free of charge.  If the Setup Wizard detects that this module is not available, 
you will be asked if you wish to install the Framework now.  You should respond "Yes".  This 
will launch a browser to take you to the download site for the required software. 

At the conclusion of this process, PreciseVision will be installed on your PC.  This software by it
sufficient to exec

self is 
ute PreciseVision with camera images that have already been captured and saved to a 

disk file.  But, to operate this software with a camera, one of the camera interface installation 

a following section.  

procedures in the following sections must be performed.  In addition, in order to continue to use 
PreciseVision beyond the trial period, you must register this product with Precise Automation.  The 
registration process is described in detailed in 
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Installing and Configuring the DALSA Genie™ Camera 
Interface 
If your system is equipped with a DALSA Genie™ GigE camera, the procedure described in this section 

a, please 
skip to the next section of the documentation. 

Prior to executing this pro

 DALSA Genie™ camera must be interfaced to the PC via a 100MB or 
1000MB (Gigabit) Ethernet card.  A 1000MB card will produce the best 

le performance for 
many applications. 

The firs tall the DALSA device driver and its configuration software. 

must be executed to interface and configure this device.  If your system does not use this camer

cedure, ensure that the following requirements are satisfied: 

• The

performance although a 100MB card will produce acceptab

t step in the process is to ins

»   Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive. 
 
»   In the "DALSA/SaperaLT/" folder, double click "Setup.exe" to execute the installation 
procedure. 
 
»   Follow the instructions in the Setup Wizard to install the driver. 
 
»   In the "DALSA/Genie/" folder, double click "Genie_1.nn.nn.nnnn Release.exe" to execute 
the installation procedure. 
 
»   Follow the instructions in the Setup Wizard to install the driver. 
 
»   After installing the Genie drivers, the PC must be rebooted. 

After rebooting the PC, you should see a small camera icon.  in the task bar in the right hand corner but 
with a re

Plug the Genie camera into the network. r over the 
icon, the tool tip will indicate the number s are 
located, A

e ie Installation

d ‘X’ over it. 

After a period of time the ‘X’ will disappear. If you hove
 of Genie cameras that have been located. If no camera

 Genie Installation Trouble Shooting" table. 

 Trouble Shooting  

 please see the following "DALS

DALSA G n

Trouble  Possible Solutions  

When the PC boots up it is not 
displaying the little .  camera 
icon in the system tray. installing the Genie driver. 

The Genie driver did not properly install. If you have 
VPN software installed, try removing this and re-

The camera .

If you have multiple network cards, try opening

 icon is 
displayed but always has a red 
‘X’ over it . 

Package". 
 
Select the "Network" Adapter you are using with the 
camera. Select the "DHCP/LLA" mode in the Device 
Configuration sectio

 up the 
 Network Configuration Tool’. This is found in 
> DALSA -> Sapera Network Imaging 

n. 

‘DALSA
"Start -
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If you are still having difficulty with the operation of your DALSA camera, please see the FAQ 
this manual for additional step-by-step trouble shooting instructions.chapter of  

Verifying the Camera Firmware is Up-to-Date

At this point, the basic camera driver installation is completed.  However, it is po
that shipped with your DALSA Genie camera may not match the PC driver that you just insta

ssible that the firmware 
lled.  If the 

firmware and the driver do not match, the camera may not operate reliably. To determine if the camera 
firmware needs to be updated, perform the following steps: 

»   Ensure that the camera is properly communicating with the PC per the instructions above.  
 
»   Open the DALSA Device Manager firmware update dialog.  This is accomplished from the 
Window's Start menu by clicking: "Start > Programs > DALSA > Genie > Firmware Update". 

A list of available cameras will be displayed as shown in the following picture.  

 

t most column labThe righ eled "Update" indicates the firmware status of each camera. 

»   If the "Update" status is "Not Required", the camera firmware matches the driver and the 
following steps can be skipped. 
 
»   If "Required" is indicated, the camera firmware must be updated for proper operation.  To 
update the firmware, click on the "Automatic" button.  
 
»   Allow up to 3 min. for the camera to update.  Do NOT unplug the camera during this time.  
 
»   After the camera re-initializes the LED on the camera next to the power connector should 
return to a solid BLUE state.  This indicates that the process is completed and you can now exit 
from the DALSA Device Manager.  

Selecting Ethernet Cameras Instead of USB Cameras

10 
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PreciseVision can operate using either Ethernet cameras or USB cameras or in a demonstration mode 
without a camera.  However, at any given time, only one camera type is permitted for each instance of 
PreciseVision.  The first time PreciseVision is executed after being installed, it prompts for the type of 
camera to be used.  Thereafter, the camera type is remembered until it is explicitly changed.  The 
following procedure can be used to change the camera type or to verify that PreciseVision is properly 
configured to capture images from the correct type of camera. 

»   Launch PreciseVision by selecting "Start > Programs > Precise Automation > PV_ > 
PreciseVision". 
 
»   Open the Preferences pop-up by selecting the following within PV:  "File > Preferences" 
and open the "Camera Hardware" tab. 
 
»   Ensure that the "Genie (Dalsa Ethernet Camera)" option is selected. 
 
»   Restart PreciseVision if the selected camera type is changed.  

 

Assigning (Mapping) Dalsa Cameras

The first time the DALSA Genie camera option is selected, PreciseVision will automatically scan
available Genie cameras. When a camera is located, the camera list will be created. Each locate
camera is automatically assigned a camera number and will be identified by it

 for all 
d 

s MAC ID. The MAC ID is a 
unique number that is permanently assigned to every Ethernet compliant hardware component in the 
world. 

»   To view the available Genie cameras and their assigned camera numbers, while still viewing 
the "Camera Hardware" tab as described above, click on the "Genie Mapping" button. 

11 
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Up to 6 Genie cameras can be "Accepted" for use by each instance of PreciseVision.  Once the Genie 
camera
have the
physical cam contents of this 
table an

When P mera will 
automatically be assigned to the first available slot (logical camera number). 

If a camera is disconnected or powered down, the slot for this camera is NOT cleared. This is important 

amera will be assigned to the first 

 list is created, a user can manually copy and paste MAC ID’s to change the camera order. To 
 changes take effect, PreciseVision must be restarted.  Each time PreciseVision is started, the 

eras will be assigned to the same logical camera numbers based upon the 
d the camera's MAC ID numbers. 

reciseVision is restarted, if a new camera is found on the network, the new ca

since there are unique calibration files for each physical camera and vision applications expect to take 
pictures using specific cameras. 

With the Genie camera, it is possible to assign the same camera to several camera slots. This allows 
different calibrations for the same camera if needed. 

For a single camera configuration, simply start PreciseVision and the c
camera slot and can be referenced as logical camera #1. 

Camera "Binning"

For DALSA cameras, the system supports "binning".  At the camera hardware level, this process 
combines every other pixel horizontally and vertically and returns half of the standard number of pixels in 
each ro

This pro me manner as averaging 
two ima image acquisition time is 
reduced.  However, the acquisition time is not reduced proportionally to the reduction in pixels.  Although 
there are only 1/4th the number of pixels, for a 640x480 camera the speed improvement is only a few 
percent and for a 1392x1040 camera the speed improvement is approximately a factor of two.  This is 
because the camera performs the vertical binning in the analog domain, which results in a 2x 
improvement, but the horizontal binning is performed in the digital domain so all pixels in a row are still 
sampled.  In addition, there is some overhead that further reduces the speed improvement.  Nonetheless, 

w and only every other row of pixels.   

cess has the advantage of increasing the contrast in an image in the sa
ges.  Also, since there are fewer pixels transmitted by the camera, the 
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for high resolution Dalsa cameras, binning can be used to reduce the image capture time when lower 
resolution is acceptable. 

»   If you wish to turn on binning for a camera, in the "Genie Camera Mapping" panel shown 
above, check the "Enable Binning" next to the camera's MAC address. 
 
»   If you wish to access a camera in both full resolution and binning mode, in the "Genie 
Camera Mapping" panel, copy the MAC address to another logical camera number and 
enable binning on one of the logical cameras for the same physical camera. 
 
»   PreciseVision must be restarted to have any changes take effect.  

Whenever a logical camera with binning enabled is accessed, binning will automatically be performed. 

When binning is turned on for a camera, the camera calibration for this logical camera must be re-
computed.  This is required since the pixel to mm scale factors will have changed. 

Releasing DALSA Cameras to Other PreciseVision Applications 

For multiple cameras on the same Ethernet network that are accessed by a different PC or for cameras 
that are accessed by a different instance of Multi-Instance PreciseVision on the same PC, there is an 
ignore list. Cameras that are listed as one of the "Ignore" entries are released from the current 
PreciseVision and available for use by other copies of PreciseVision. 

»   If you do not wish to utilize a camera within the current PreciseVision application, cut and 
paste the camera's MAC ID from the "Accept" list to the "Ignore" list. 
 
»   PreciseVision must be restarted to have any changes take effect.  

 

This com s via 
this cam

pletes the DALSA Genie™ camera setup.  PreciseVision can now acquire camera image
era(s). 
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Installing and Configuring the IDS uEye™ USB Camera 
Interface 
If your syste mera, the IDS uEye device driver must be installed 
and the unicate 
with the  the 
documentation. 

t the following requirements are satisfied: 

he IDS USB device driver and its associated configuration and 

m is equipped with an IDS uEye™ USB ca
 camera must be configured. PreciseVision utilizes DirectShow and the IDS driver to comm
 camera. If your system does not use this type of camera, please skip to the next section of

Prior to executing this procedure, ensure tha

• Initially, it is preferable if your IDS camera is NOT connected to the PC.  After the 
IDS driver is installed, the camera can be attached and the PC will automatically 
discover the camera. 

The first step in the process is to install t
diagnostic software. 

»   Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive. 
 
»   In the "uEye" folder, double click "uEye32_xxxxx.exe" to execute the installation 
procedure. If your computer contains a 64bit version of Windows, then visit the IDS web site to 
download the 64bit version of the driver. 
 
»   Follow the instructions in the Setup Wizard to "Install driver". When asked what type of 
installation should be performed, select "USB".  You should NOT install any Ethernet or 
custom drivers. 

At this p d.  oint, the required system driver and the support software have been loaded and installe

»   Plug the uEye cameras into the PC.  This will permit the PC to discover this new hardware 
and configure the cameras for use. 
 
»   Execute the uEye demo software to verify that the cameras are functioning property.  
Launch the demo software by clicking: "Start > Programs > IDS > uEye > uEye Demo". 

Assigning ID's to Multiple uEye Cameras

For Ethernet cameras, each camera's Ethernet MAC ID uniquely identifies the camera and is used to 
associate each camera with the same vision operations whenever PreciseVision is restarted.  
Unfortunately, USB connections do not have a similar identification mechanism.  So, to ensure that the 
correct cameras are associated with vision operations, a unique camera ID must be stored into the 
NVRAM of each IDS camera. 

The camera ID ranges from 1 to n and is automatically added to the name of each camera.  For example, 
if the ID is set to 3, the camera will be

If you on  camera to your PC, you can skip to the next section since the 
camera

 identified as "uEye Capture Device 3".  

ly intend to connect a single USB
s default ID of 1 can be used. 

»   To assign camera ID's, execute the uEye Camera Manager by clicking on "Start > 
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Programs > IDS > uEye > uEye Camera Manager". 

 

»   Select a desired camera by clicking on a line in the Camera List and click "Camera 
Information". 
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»   Change the "Camera ID" to a unique number.  These should be assigned so there are no 
gaps in the numbering (1,2,3,..). 
 
»   When completed, click "OK" and close the Camera Manager when done. 

Before PreciseVision can discover multiple USB cameras, they must be registered using the uEye 
DirectShow Capture Device Manager. 

»   To register each of the IDS cameras, click "Start > Programs > IDS > uEye > DirectShow 
device manager". 

 

»   Clear the list by clicking on "remove device" multiple times. 
 
»   Populate the list by clicking on "add device" a number of times until the highest camera ID 
that you have defined is listed. If the camera ID's were not sequentially assigned, there can be 
N/A placeholders as shown above.  This will not create a problem. 

Selecti ad of Ethernet Camerasng USB Cameras Inste

PreciseVision can operate using either Ethernet cameras or USB cameras or in a demonstration 
without a camera.  However, at any given time, only one camera type is permitted for each instance of 
PreciseVision.  The first time PreciseVision is executed after being installed, it pro

mode 

mpts for the type of 
camera to be used.  Thereafter, the camera type is remembered until it is explicitly changed.  The 

s properly following procedure can be used to change the camera type or to verify that PreciseVision i
configured to capture images from the correct type of camera. 

»   Launch PreciseVision by selecting "Start > Programs > Precise Automation > PV_ > 
PreciseVision". 
 
»   Open the Preferences pop-up by selecting the following within PV:  "File > Preferences" 
and open the "Camera Hardware" tab. 
 
»   Ensure that the "DirectShow (USB)" option is selected. 
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»   Restart PreciseVision if the selected camera type is changed.  

 

Assigning Cameras, Selecting the Camera Resolution and Display Mode

When the PC boots or whenever a USB camera is connected or disconnected, Windows automatically 
assigns each camera an index in a list of cameras.  The ordering of the cameras is dependent upon the 
USB interface to which they are connected.  For a given configuration of cameras, the index of each 
camera will always be the same.  However, if a new camera is connected, it will not necessarily be added 
to the start or the end of the list.  

rectShow 

To review or change the current camera assignments and settings, perform the following.  

Unlike Ethernet cameras, USB cameras typically have several different formats that can be used to 
retrieve the image data at different resolutions.  The formats that PreciseVision and its Di
interface support include the following: 

RGB8 (8-Bit Grayscale) 
RGB24 (24-bit color with 8-bit R,G,B components) 
YUY2 (16-bit color) 

When PreciseVision is started, it retrieves information on all of the connected USB cameras and 
automatically assigns them to a logical camera buffer and selects a format with the highest resolution.  
PreciseVision permits these automatic assignments to be manually over-written. 

»   While still displaying the PreciseVision "Preferences" pop-up, and viewing the "Camera 
Hardware" tab (as shown above), click on the "DS Mapping" button. 
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For each discovered USB camera, this panel displays the logical number (Camera buffer) that it has been 
assigned, together with its resolution and format, and the index number that Windows has automatically 
assigned.   The "Enable" checkmark indicates that a camera will be exclusively used by the current 
instance of PreciseVision.   

»   If the Multiple-Instance version of PreciseVision is being executed, a camera can be 
released for use by another instance by unchecking "Enable" and restarting PreciseVision. 

If you wish to assign a camera a different logical camera number or change its format and resolu
the following.  

tion, do 

»   While still displaying the USB Camera Mapping panel, click on the "Select" button for the 
camera of interest. 
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If you wish to access the same camera in different formats or want to utilize more than one set calibration 
data, the same c ffer numbers.  

Subsequent Changes in Camera Assignments

amera can be assigned to multiple logical camera/bu

If a USB
Precise mbers can all be changed.  If a camera name is 
unambiguous, as is the case for IDS cameras that have been assigned unique camera ID numbers, 
PreciseVision attempts to assign the cameras to the same logical camera number/buffer as the last 
session independent of their Windows index number. If camera names are not unique, PreciseVision 
utilizes the Windows camera index numbers to determine their logical camera numbers.  At the end of this 
process, if the camera mapping has changed relative to the previous session of PreciseVision, the 
following message is displayed to alert you to a possible problem. 

 camera is disconnected or a new camera is connected to the PC, the next time that 
Vision is started, the Windows camera index nu

 

»   If the error message above is displayed, review the USB camera assignment by going to 
"File > Preferences > Camera Hardware > DS Mapping" and correcting any errors.  

This com es 
via this came

 you must start the application on the PC. 

pletes the IDS uEye USB configuration setup.  PreciseVision can now acquire camera imag
ra(s).  

Activating PreciseVision 
To begin using PreciseVision,

»   To launch PreciseVision, click on "Start > Programs > Precise Automation > PV xxx > 
PreciseVision". The first time PreciseVision begins execution, you will see the following 
popup. 
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The license that you purchased for PreciseVision permits you to use this software to build and execute 

ted.  

If for so
each tim eVision.  To re-display the activation popup from within PreciseVision, click on 
"Help >

Vision Processes on a single PC.  To complete the software activation process, you must send 
information concerning the PC to Precise Automation.  To allow time for sending the information and 
receiving a reply, PreciseVision is fully functional for 30 days without being activa

me reason, you do not wish to initiate the activation process now, this popup will be displayed 
e you start Precis
 Product Activation". 

»   To initiate the activation process, click "Yes" in the popup above.  This will display the 
following activation popup. 

 

This popup displays the "Computer ID" that you need to submit to Precise as part of the activation 
process. 

»   To obtain a license key to activate PreciseVision, please send an email to Precise 
Automation that contains the following information: 

To:       sales@preciseautomation.com 
Subject: PreciseVision License Key Request 
 
Customer Name:          <your name here, optional> 
Customer Company:     <your company name here> 
Telephone Number:       <your phone number here, optional> 
 
PreciseVision Serial Number:      PVS0-0xxx-xxxxxx 
Computer ID Number:   xxxx-xxxx-xxxx-xxxx 
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»   You can obtain the PreciseVision Serial Number from the PreciseVision License Certificate 
that you received with your order. Below is a picture of the top portion of a typical PreciseVision 
License with the serial number circled in red. 

 

»  The Computer ID number should be copied from the Product Activation popup. 
 
»   As a convenience, if you are viewing this help in the Precise Documentation Library, you 
can click on the following link to get an email template: sales@preciseautomation.com. 
 
»   Alternatively, if you do not have email access, please Fax this information to 408-516-8348 
together with your own fax number. 

Your name and your phone number are optional.  However, we recommend that you provide this 
information in case there is a problem with your license and we need to get in touch with you.  A sample 
email should look as follows. 
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In response to your request, you will receive a license key. 

»   When you receive your license key, access the Product Activation popup by restarting 
PreciseVision or  Activation". clicking in the PreciseVision menu item "Help > Product
 
»   Enter the license key in the "License Key" box and press "Activate". 

PreciseVision is now activated. 

 position. 

Configuring PreciseVision to Read Positions from a Controller

Configuring Communication Between the PC and the 
Controller 
In order for PreciseVision to exchange information with a Guidance Controller, each system must know 
the Ethernet IP address of the other unit.  During normal runtime execution, the Guidance Controller 
initiates all communications and so it must know where to send its commands.  During the Robot Vision 
Camera Calibration procedure, PreciseVision needs to know where to send its commands to read the 
current robot

To permit PreciseVision to query a Guidance Controller for the current position of the robot, the IP 
address of the controller must be defined in the system Preferences. 

»   Launch PreciseVision by clicking on "Start > Programs > Precise Automation > PV xxx > 
PreciseVision". 
 
»   Open the panel for setting the controller IP address by selecting "File > Preferences > 
Client Settings".

The panel for setting the IP address should resemble the following: 
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»   Enter the Guidance Controllers Ethernet IP address and press the "Update" button. 

  

Configuring a Controller to Send Commands to PreciseVision

Whenever the Guidance Controller issues a command to PreciseVision, the controller automatically 
establishes an Ethernet connection utilizing an IP address that is specified in the controller's Parameter
Database.  This database is stored in the controller's flash disk and is preserved even if the controller is 
turned off and restarted.  To modify this database value, perform the following operations. 

 

»   Please see the “Guidance System Setup and Operation, Quick Start Guide” and follow the 
instructions for bringing up the web based Guidance Operator Interface for the controller. 
 
»   In the web interface, open the database page for the vision IP address, "Setup > 
Parameter Database > Controller > Network > Vision IP ". 

The web interface page should look like the following: 

 

»   Enter the IP address of the PC executing PreciseVision into the value for the "Vision server 
IP address (DataID 424)". 
 
»   Press the "Set New Values" button to store this setting into memory. 
 
»   Press the "Save All to Flash" button to store this setting in the flash disk. This ensures that 
this setting will remain in effect if the controller is restarted.  The button will flash for 10-30 
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seconds as the data is being written.  DO NOT TURN OFF YOUR CONTROLLER WHILE THE 
BUTTON IS BLINKING SINCE THIS MAY CORRUPT THE FLASH DISK.

The controll ciseVision.   It is not nece start the 
controller

er is now setup to send 
. 

commands to Pre ssary to re
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Overview and

PreciseVisi n Ov
This chapter introduces PreciseVision's principal con ewcomers to 
machine vision, this chapter will provide background information prior to reading the detailed descriptions 
contained in the following chapters.  For individuals with experience applying machine vision, the 
information in this chapter should be sufficient for you

PreciseVision has been designed to operate in combi and its 
embedded Guidance Programming Language (GPL) to easily produce flexible and powerful vision-guided 
motion applications. The following diagram illustrates the key software components in a vision guidance 
application. 

 Quick Start 

o erview 
cepts, terminology and features.  For n

 to start using the system.  

nation with a Precise Guidance Controller 

 

In PreciseVision, each fundamental vision runtime fun ol" and 
the collection of all possible types e 
function that captur  a pictur t isition 
Tool"; the operation that fits a line to a set of edge poi  function that 
uses an advanced, patented algorithm to identify and der Tool". 

To perform an element of a vision application, any number of Vision Tools can be combined into a 
"Vision Process". Normally, an Acquisition Tool is the first tool in each Vision Process.  This is followed 
by one or more tools to perform part location, metrology or inspection operations. Multiple copies of the 
same type of tool can be included within the same Vision Process.  The individual characteristics of each 

ction is represented as a type of "Vision To
o as the "Vision Toolkit".  For example, th
ores the result in a frame buffer is the "Acqu
nts is the "Line Fitter Tool"; and the
 locate parts is the "Fin

of tools is referred t
e from a camera and ses
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tool (i.e. its size, position, algorithm parameters) are stored in Object "Property Lists".  After a tool is 
executed, its output data is stored in its Property List in a "Tool Results" section. To simplify their 
definition, tools can be positioned and sized by dragging their graphical handles on top of the display of a 
camera image.  

A Vision Process is the basic unit of execution that can be controlled by a GPL procedure.  Using a built-
in "Vision Class", a GPL pro ure running on a Precise Guidance Controller can start the execution of 
a Vision Process in PreciseVision via Ethernet and m ess 
completes executio , the GPL ecuted 
Vision Process by accessing t reciseVision is 
not connected to a Guidance Controller, another prog he PC or on another processor 
can be used to trigger a Vision Process and retrieve t s Remote 
PC Control for additional information).  

In most cases, only a single V ut ision 
task.  Typically, this Vision Process will take a picture nd 
validate some key features or dimension.  However, if a more complex machine vision operation is 
required, a GPL procedure can execute any number of Vision Processes.  For convenience, multiple 
Vision Processes can be store e 
Vision Project can be loaded i o xecuting. 

In order for PreciseVision to return Tool Results in meaningful units, e.g. millimeters, and in an 
appropriate coordinate system, any camera used for vision guidance must first be "Calibrated".  As a 
convenience, PreciseVision in "Ca d in a 
later section.  Once a camera a re sults 
Class will be in millimeters and in the world coordinat

In a typical application, a single copy of PreciseVision will be executed on a PC and will be connected to 
a single robot or motion controlle otion 
controllers, please see the ap

In the following sections, the Vision Tools are briefly d and 
editing Vision Projects, Vision Processes, and tools w

Vision Toolkit Summary 
In order to effectively analyze ision 
images, locating and identifying parts, pe g me ction of 
key features. In this section, the function of each tool i ized and a picture displaying how 
the tool appears on the Camera Display Window is pr

An important feature of PreciseVision is that the outp ut for 
another tool.  For example, after the Finder Tool loca rts, a tool that measures the 
distance between two edges can be easily placed relative to the located part.  This measurement tool can 
then test if a critical dimension of the part is within the desired tolerance.  Since this measurement is 
performed relative to the output of the Finder, it will operate correctly even if the part's position or 

than one part, the measurement tool will be 
 complex measurements and tests to be 

ced
onitor its progress.  When the Vision Proc
 the Tool Results of any tool within the ex
ults Class".  In applications where P

ram executing in t

n  procedure can retrieve
he built-in GPL "VisRes

he results (see the appendix that describe

ed in order to perform the complete machine v
 and then utilize Vision Tools to locate a part a

ision Process is exec

d in a "Vision Project
nto PreciseVision and 

" in PreciseVision.  At any given time, only on
nly one of its Vision Processes can be e

cludes a number of 
 is calibrated, all dat

mera Calibration" methods that are describe
trieved by a GPL procedure via the VisRe
e system of the robot.  

r.  If you wish to prov
pendix that describes M

ide vision results to a number of robots or m
ulti-Instance Execution.  

escribed along with the methods for creating 
ith their associated Property Lists.  

 images, PreciseV
rformin

includes a full set of vision tools for acquiring 
trology operations and executing visual inspe
s briefly summar
esented. 

ut of one tool can be easily utilized as the inp
tes one or more pa

orientation changes. Furthermore, if the Finder locates more 
automatically applied to each located part. This ability allows
easily built-up from the basic tools that are provided. 
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For a complete description of each tool, please read the "Vision Toolkit" chapter. (Note:  The algorithm
for the complete set

s 
 of tools has been developed and will be released in future upgrades to PreciseVision 

during 2007. If you cannot find a tool that you require, please contact Precise Automation.) 

Graphical Display  Vision Tool Description

N/A  Acquisition Tool
Cap e from a camera or loads 

mage into 
tures an imag

it from a disk file, and stores the i
a frame buffer. 

 

Arc Fitter Tool
Searches a specified region for arc edge 
points and returns the arc or circle that best 
fits the edges. Returns both the arc center 
point and radius.  

 

Barcode Reader Tool
Reads a variety of standard 1-D and 2-D 
barcodes and returns the barcode type and 
the value of the barcode. 

 

Clear Grip Tool
Verifies that there is no obstruction within 
the bounds of a defined window. Typically 
used to confirm that gripping a part will not 
result in a collision. 

 

Connectivity Tool

Searches a specified region for binary blobs 
and returns the centroid and other features 
of each blob. In addition, this tool can return 
data that defines the perimeter of any 
located blob. 

 

Edge Locator Tool

Detects edge points with sub-pixel accura
along a linear path in a vision ima

cy 
ge and 

 of their 

returns their positions.  Alternately, this tool 
can return an array of the intensities along 
the linear path or a histogram
values. 

 

Find Centerline Tool
Searches a specified region for edge points 
and returns the centerline between two 
located bounding lines. 
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Locates the edge point that is closest to the 
line that defines the start of the tool's search 

dicular to) the search 
direction. 

region.  The XY position of the point is 
returned with sub-pixel accuracy along (and 
pixel accuracy perpen

Find Point Tool

 

 

Finder Tool
Most powerful vision tool that identifies 
randomly placed parts in a camera image 
and returns their position, orientation and 
scaling to within sub-pixel accuracy. 

Places a reference frame at a fixed image 
coordinate or at a constant offset relative to 

 

repeatedly execute any linked tools. 

Fixed Frame Tool another vision object.  Can optionally index
the frame in an X and/or Y grid pattern to 

 

 

Image Process Tool
Performs image filtering, edge extraction, 
thresholding and morphological operations 
on a specified area in the camera image. 

N/A  Inspect Frame Tool

Passes through the XPos, YPos and Angle 
renced tool and optionally 

rotates and shifts the Results based upon 
an inspection. The inspection can consist of 
the arithmetic combination of the Results of 
two other tools. So, this tool also provides a 
means for performing simple mathematical 
operations on the results of two tools. 

Results of a refe

N/A  Inspect List Tool

Passes through the XPos, YPos and Angle 
Results of a referenced tool and tests up to 
12 different Results from multiple tools to 
determine if the object is good or bad.  This 
tool provides a convenient way to perform 
complex testing of a located object and 
generating an equivalent location with a 
single Pass/Fail indicator. 

N/A  Inspect Region Tool

Inspects the perimeter and the interior of an 
opaque object to determine if there are any 
flaws in the object's outline or holes in the 
interior.  This tool was designed to inspect 
wafers, where slight changes in the overall 
size and shape of the wafer are permitted, 
but chips in the perimeter or interior holes or 
cracks are unacceptable.  
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Light Recorder Tool

Acquires a sequenc

brightness of each image, and returns the 

e of camera images for 
a specified period of time, determines the 

brightness readings in an array for 
sequent analysis. sub

 

Line Fitter Tool Searches a specified region for edge points 
and returns the line that best fits the edges. 

 

Line-Line Frame Tool
Determines the intersection of two lines 
defined by vision tools and returns a 
reference frame. 

 

Pixel Window Tool

Counts edges or binary pixels or collects 
gray-scale statistics within a rotated 
rectangular or circular region. Used for 
quickly detecting the presence of features or 
collecting general intensity information about 
a region.  

 

Pixel Color Window 
Tool

Tests if the general color of a rectangular or 
circular region matches a trained color 
within a specified tolerance.  

Point-Line Frame 
Tool

Takes a point and a line from two vision 
tools and returns a reference frame. 

 

 

Point-Point Line Tool Computes a line given two points from two 
vision tools. 
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Sensor Window Tool 

Detects motion in a window region. Ensures 
the scene is stable prior to other operations 
or waits until motion is detected. Can be 
used in place of physical sensors in flexible 
parts feeding where parts can take time to 
settle.  

N/A  Text Label Tool
Displays string constants plus inspection 
and results data from a referenced tool.  
Text is shown relative to the position of the 
referenced tool. 

N/A  Tool Filter Tool
Takes the output from another tool that 
generates multiple sets of results, and 
returns a subset of the results based upon 
specified criteria. 

Graphical User Interface Overview 
This section summarizes the purpose and use of each of the major components of the PreciseVision 
graphica t a 
Vision P

For detailed information on each of the components of the GUI, please read the "PreciseVision User 
Interface" chapter. 

l user interface (GUI).  The user interface has been designed to allow you to quickly construc
rocess and to easily define the properties for each of the utilized vision tools. 

 

GUI Component Description
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1. Main Menu and 
Toolbar

Provides access to the major functions available within 

zooming the camera image up.  

PreciseVision, e.g. loading and saving projects, selecting the 
camera output to view, etc. The toolbar includes buttons for putting 
the camera into "live video" mode, taking a single snap shot, and 

2. Vision Camera 
Display

Displays the output of the last selected camera.  This can be either 
a frozen snapshot or a live camera image.  When a Vision Process 
is being evaluated, the tool Results graphics will be overlaid on top 
of the camera image. When a tool is being edited, its outline will be 
displayed on top of the camera image. To reposition or resize a 
tool, simply drag its handles in this window. 

3. Process Manager

within the currently loaded Vision Project.  Each process can be 
expanded to show the sequence of Vision Tools that are executed 
within the process. Tools can be deleted or re-ordered within the 
process.  To add a new tool, simply drag a defined tool from the 

lbar.  This will execute a process 

Displays and permits editing of all of the Vision Processes defined 

Vision Tool Definition window and drop it on a process name. To 
preview how a Vision Process will perform, click on the "Test 
Process" green button in the too
once or continuously without requiring a GPL procedure to trigger 
this activity. 
Lists all of the possible types of Vision Tools that can be created.  

4. Vision Toolbox and select "Create tool".  Each tool must be 
To create a new copy of a tool, double click on the tool or right-click 

assigned a unique 
name.  New copies of tools are automatically added to the lists in 
the Vision Tool Definition window. 

5. Vision Tool 
not be utilized in a proces
the Process Manager win

Definition Window

Displays all of the tool that have been created.  A created tool will 
s until you drag the tool and drop it into 
dow.  If a tool is relative to another tool or 

requires other tools as inputs, they will be listed below the tool.  
This provides a quick visual queue as to the relationships between 
tools. 

6. Vision Results 
Window

Whenever a Vision Process is executed, the output of each tool 
(i.e. its Vision Results) will be displayed in this window. 

7. Property Displa
Whenever a copy of a vision tool is selected in the Vision Tool 

y Definition window, all of the properties of the tool will be displayed 
in this window.  Dimmed properties are read only. 

8. Status Bar 
Process execution 

time, live video/snapshot indicator, networking indicator, camera 
Displays status information such as the last 

calibration type, etc.  

Tuto
The firs derstanding of how vision 
tools operate and how to edit tools.  Fortunately, PreciseVision provides a very convenient means for 

nd camera images from disk files 
that are distributed with PreciseVision.  One thing to note is that this Sample Project and image files were 
generat  
able to c
customers or to relay problems to Precise and our partners. 

rial 1:  Testing Processes and Editing Vision Tools 
t step in learning how to apply PreciseVision is to gain more of an un

experimenting with the tools without needing a camera, robot or any parts. 

In the following procedure, you will be using a Sample Vision Project a

ed using standard PreciseVision facilities.  So, once you are familiar with the system, you will be
reate your own Sample Projects and stored images to illustrate your work to co-workers or 
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Prior to executing this tutorial, the following steps must first be performed: 

• The procedure for "Installing PreciseVision on a PC" must be completed. 
• No camera hardware of any sort is required. 

In this first example, two Edge Locators are executed to compute a line along the side of a part. 

»   Start by launching PreciseVision.   Click on "Start > Programs > Precise Automation > PV 
xxx > PreciseVision".

If this is the first time PreciseVision is executed, a pop-up window will be displayed requesting the 
specification of the camera hardware followed by a window requesting that the software be activated.  
Both of these actions are good to perform and you should return to the installation chapter and follow the 
instructions for completing these procedures.  However, if you wish, you can cancel out of these pop-up's 
since neither of these setup steps is required to initially execute the Sample Projects. 

The following "Quick Start" pop-up window should now be displayed. 

 

If you hover the cursor over the th
to provid

ree buttons on the left, the text in the center window panel will change 
e more information about each selection. 

»   Click on the "Samples" button.  A standard file selection pop-up window will be displayed 
that lists a number of Sample PreciseVision Project files (*.pvp). 
 
»   Click on the "ComputeLineExample.pvp" file and press "Open" to load this Project. 
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show 

If you examine the Process Manager, you will see that this Project has one Vision Process defined, 
"ComputeLine".  This Process consists of an Acquisition Tool, "picture", and a Point-Point Line Tool, 
"cl_compute_line".  The Acquisition Tool would normally be set to capture an image from a camera.  In 
this case, it is configured to read the image from a disk file.  cl_compute_line does the work of computing 
a line from the output of two Edge Locators.  The two Edge Locators are implicitly executed and not listed 
in the Vision Process (more about this later). 

The default PreciseVision application layout should now be visible and the Camera Display should 
the picture of a "T" part with two green Edge Locators as shown above. 

»   To test the Vision Process, click on "ComputeLIne" in the Process Manager and then click 
on the circular green "Test Selected Process" button in the window's toolbar. 

Each time that you click on the "Test Selected Process" button, the Acquisition Tool loads an image file 
from the disk and then the Point-Point Line Tool executes the two Edge Locators and fits a line between 
their first detected edges.  The first time you click the test button, the Camera Display should resemble 
the following.  You will note that the output line of the Point-Point Line Tool is indicated in yellow.  
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For this Sam e the captured image and the results will 
change each time you click the test button. 

pl  Project, there are multiple image files and so 

»   To continuously execute the Sample Project, pull down on the arrow next to the test button 
in the toolbar and select "Test Loop".  
 
»   To stop the execution, click the "Stop Test Loop" button in the toolbar.  
 
»   Next, to examine the defined tools, in the Vision Tool Definition Window, click on each of the 
"+" boxes to expand all of the displayed items. 

 

The items in the left-most column of the Vision Tool Definition Window are folders that contain all created 
tools of a specific type.  If a type of tool has not been created, the corresponding tool folder is hidden.  
The top
success
the "picture" and the "cl_compute_li ge Locators, "el_edge_locator1" and 
"el_edg n 
the top- cond time under the "cl_compute_line" tool.  This second 
listing indi these two Edge Locators are referenced by and used in 
the com

Since the system knows that the Edge Locators are needed for the computation of the Point-Point Line 
Tool (more about how to specify this later), the Edge Locators are automatically executed by the Point-

-level items listed in the tool type folders are the names of the created tools.  The third and 
ive levels are lists of tools that are referenced by the tool above it.   In this example, in addition to 

ne" tools, two Ed
e_locator2" have been created.  Note that the names of the Edge Locators appear twice, once i
level Edge Locator tool type list and a se

cates that the output (i.e. "Results") of 
putation of "cl_compute_line". 
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Point Line Tool if necessary and they need not be included in the Vision Process.  Including the Edge 
Locators in the Vision Process before the computation of the Point-Point Line Tool is a matter of personal 
preference and does not effect execution time.  

The Vis ols whether or 
not the 
represe

ion Tool Definition Window provides a convenient means to access all created to
tools are included in any Vision Process.  This window also provides a simple graphical 
ntation of how tools are dependent on and connected to other tools. 

»   In the Vision Tool Definition Window, click on either of the "el_edge_locator1" names to 
select this tool for editing. 

 

Once the Edge Locator is selected for editing, it will be displayed in the Camera Display with graphical 
handles (as shown above) that allow it to be repositioned and resized.  

»   To practice repositioning the tool, click anywhere along the green li  and drag the tool to ne
translate it. 
 
»   Click on the blue square that indicates the start of the Edge Locator and drag it to stretch or 
shrink the tool. 
 
»   Click on the blue circle that indicates the end of the tool and drag it to rotate the tool's 
orientation. 
 
»   T te lick o st the Vision Process with a new tool position and size, in the Process Manager, c
on "Com n the circular green "Test Selected Process" button in the puteLIne" and then click o
win 'dow s toolbar. 

When the Edge 
automatically dis ning 
and sizing th  to d into 
groups based up

For each of the er of this 
document.  

Locator was selected for editing, you might have noticed that its properties were 
played in the Property List Display as shown below.  In addition to graphically positio

is ol, you can also enter new values into this panel. The properties are organize
 on their function.  Readonly values are displayed in dimmed characters. 

tool types, all of the properties are described in detail in the Vision Toolkit Chapt
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»   In the Property List Display, try editing the "Angle", "Length", and "XPos" and "YPos" 
properties and note the effect in the Camera Display. 
 
»   If you wish to save your changes to the Sample Project, select "File > Save Vision Project 
As..." and assign a new name to your project so the original Sample is preserved.  

This com

Tuto

and validates if this 
dimension falls within an acceptable range.  In an application that required high precision, you would 
probabl dge 
Locator

Prior to ust first be performed: 

pletes the tutorial on testing a Sample Project and editing a tool. 

rial 2:  Adding Vision Tools 
In this tutorial, we again make use of the ComputeLineExample Sample Project.  In this case, we 
present the procedure for adding a Vision Tool to an existing Vision Process.  For demonstration 
purposes, we will add an Edge Locator that measures the width of the stem of the "T" 

y use two Line Fitters for locating the edges of the "T" stem, but for training purposes, an E
 will suffice.  

executing this tutorial, the following steps m

• The procedure for "Installing PreciseVision on a PC" must be completed. 
• No camera hardware of any sort is required. 

»   If PreciseVision is not running, click on "Start > Programs > Precise Automation > PV xxx 
> PreciseVision". 
 
»   If PreciseVision is already running, select "File > Quick Start".
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If a pop-up window is displayed requesting the specification of the camera hardware or a
displayed requesting that the software be activated, you can cancel out of these pop-up'

 window is 
s since neither of 

these setup steps is required to initially execute the Sample Projects. 

»   In the Quick Start window, click on the "Samples" button.  A standard file selection pop-up 
window will be displayed that lists a number of Sample PreciseVision Project files (*.pvp). 
 
»   Click on the "ComputeLineExample.pvp" file and press"Open" to load this Project. 

 

en Edge Locators as shown above. 

For robustness, the visual inspection should be designed such that the measured width of the stem is 

The default PreciseVision application layout should now be visible and the Camera Display should show 
the picture of a "T" part with two gre

accurate independent of the orientation of the "T".  To achieve this, the new Edge Locator should be 
oriented perpendicular to the computed Point-Point Line.  If the Edge Locator was just placed at a fixed 
position and orientation, the width measurement would return too large a value if the "T" is rotated.  To 
create the new tool, the following should be executed. 

»   Double click on the "Edge Locator" in the Vision Toolbox. 
 
»   In the Name pop-up, enter "el_measure_width" as the name of this new tool and press 
"Ok".  The new tool will be created and will appear in the Vision Tool Definition Window. 
 
»   Click on the new tool in the Vision Tool Definition Window and drag it to the Process 
Manager and drop it on "ComputeLine".  This will evaluate the new tool after the Results of 
cl_compute_line are computed. 
 
»   In the Property List Display, pull down the entries for "RelativeToolName" and select 
"cl_compute_line".  This makes the position and orientation of the new tool relative to the 
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computed position and orientation of the Point-Point Line Tool. 
 
»   In the Camera Display Window, resize and position the new tool so that it is approximately 
perpendicular to the yellow line for cl_compute_line and stretched across the stem of the "T". 

The Cam n 
across the and approximately perpendicular to the yellow line for cl_compute_line. 

era Display should resemble the following picture that shows the el_measure_width tool draw
stem of the "T" 

 

»   To ensure that el_measure_width is exactly perpendicular to cl_compute_line, in the 
Property display, edit "RelAngle" to be an even multiple of 90.  For example, if it has a value of 
-628.2, change this to -630. 
 
»   To automatically test the width of the stem, change "InspectType" to 
"Distance_From_First_To_Last".  This defines the inspected results as the computed 
distance between the first and last edge found by el_measure_width. 
 
»   To define the width dimensions that we will accept as valid, set the "InspectMax" value to 
"31.8" and the "InspectMin" value to "31.2".  
 
»   To display a pass or fail label on the tool in the Camera Display, change "InspectLabel" to 
"Pass_and_Fail". 
 
»   To test the new tool, in the Process Manager, click on "ComputeLine" to select it and then 
click on the circular green "Test Selected Process" button in the window's toolbar. 

Each tim ddition to the three former tools.  
The new rpendicular to the yellow computed line and should be labeled to 
indicate  a typical image in the Camera 
Display.

e you click the test button, you should now see the new tool in a
 tool sho rawn peuld be d

 if the width dimension is acceptable.  The following illustrates
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execute the modified Process, you should review the data displayed in the Results Window to se
erical value of th

As you e 
the num e computed width.  All of the Results information is also available by selecting 
individual tools and viewing the data in the Properties List Display. 

»   If you  your changes to the Sample Project, select "File > Save Vision Project  wish to save
As..." and assign a new name to your project so the original Sample is preserved. 

This completes the tutorial on adding a tool to an existing Vision Process. 

Tuto

  As an example, in the first tutorial, three tools were combined to locate 
a known part.  But, in that case, the part was only expected to translate and rotate within a limited range.  
The Finder Tool utilizes an advanced patented algorithm to both identify and locate parts that are 
randomly positioned 

In this tutorial, we ste ple Project.  
This tutorial also in l ision Project. 

Prior to executing this tutorial, the following steps must first be performed: 

rial 3:  Applying A Finder Tool 
The Finder is the most general purpose tool available for identifying parts or sections of parts and locating 
their position, orientation and scale.  For constrained or special situations, other tools can be combined to 
perform some of these functions.

based upon a simple one-shot training technique. 

p through the procedure for creating and teaching a Finder using a Sam
udes an example of creating a new Vision Process within an existing Vc

• The procedure for "Installing PreciseVision on a PC" must be completed. 
• No camera hardware of any sort is required. 

»   If PreciseVision is not running, click on "Start > Programs > Precise Automation > PV xxx 
> PreciseVision". 
 
»   If PreciseVision is already running, select "File > Quick Start".
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If a pop-up window is displayed requesting the specification of the camera hardware or a window is 
displayed requesting that the software be activated, you can cancel out of these pop-up's since neither of 
these setup steps is required to initially execute the Sample Projects. 

»   In the Quick Start window, click on the "Samples" button.  A standard file selection pop-up 
window will be displayed that lists a number of Sample PreciseVision Project files (*.pvp). 
 
»   Click on the "LocateRandomlyOrientedPart.pvp" file and press "Open" to load this 
Project. 

The default PreciseVision application layout should now be visible and the Camera Display should show 
the picture of a circular plastic part with a "V" shaped attachment as shown below. 

 

This Sample Project already includes a Finder as its principal tool.  In this tutorial, we will go through the 
steps of re-creating this Vision Process including the Finder.  Before beginning, the supplied Process 
should be tested to see how the Finder performs on this part. 

»   To see the Finder in operation, click on "Main" in the Process Manager and then click on 
the circular green "Test Selected Process" button in the window's toolbar. 
 
»   To continuously execute the Sample Project, pull down on the arrow next to the test button 
in the toolbar and select "Test Loop".  
 
»   To stop the execution, click the "Stop Test Loop" button in the toolbar. 

We will now begin creating a new Vision Process.  In order to perform the image capture, we will reuse 
the existing Acquisition Tool since it has already been initialized to read the desired image disk files. 
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»   Click on the "Add a new Process" button in the Process Manager toolbar. 
 
»   In the Process Name pop-up window, fill in "my_process" as the name and press "Ok" to 
create the Process.   
 
»   In the Vision To  the "picture" tool and ol Definition Window, in the Acquisition folder, click on
drag and drop it on top of the "my_process" in the Process Manager. 

Before performing the next step of creating and tra
information and hints that will aid in applying this to

ining a new Finder, the following is background 
ol. 

When you create a new Finder or re-teach ("re-train") an existing Finder, red and yellow rectangles will be 
drawn in the Camera Display as shown below. 

 

The red rectangle defines the "Finder Template" for the part to be located.  When PreciseVision 
subsequently searches for the part, it is looking for matches for the Template in the image.  When the 
system reports the position and orientation of a matched part, it is actually stating the position of the 
center of the Template when the match was found and the amount by which the Template was rotated.  
When defining the Template, keep in mind the following guidelines. 

ose the target object and should contain no other 
. 
de some of the background on all sides of the target 

 of the full height of the camera image.  
• If the background varies considerably (i.e. it is dirty or has blotches), the part 

should be trained on a uniform neutral background. 
• The target object should be oriented in the camera image in what you want to 

define as ‘Zero’ degrees.  That is, when the Finder later locates a part is in the 

mplate from other objects or background clutter.  When defining this rectangle, keep in 
mind the following guidelines. 

• The Template should fully encl
objects or parts of objects

• The Template should inclu
object, typically at least 16 camera pixels (too many is better than too few).  This 
allows the system to distinguish the boundary of the object from the background, 
which is especially important for parts with few internal features.  For a 640x480 
camera, 16 pixels is 1/30th

trained orientation, it will return an orientation angle of 0 degrees. 

The yellow outline defines the "Training rectangle".  This rectangle is used to teach the system how to 
distinguish the Te
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•  rectangle must be larger than the T ust fully enclose the 
plate. 

• This rectang
object.  It's o  

as eac
ng

encountered
the target ob

• This rectang

strategy. 

It's now time to create the Fi

This
Tem

emplate and m

le should include one and only one complete copy of the target 
kay if this region includes other partial copies of the target object so

h partial copy is less than 50% of the target object.  
le should include any other objects or clutter that are expected to be 
 during runtime to aid the system in learning to distinguish between 
ject and its surroundings. 

long 
• This recta

le should be as large as possible without violating the rules above.  
on permits the system to test more positions and orientations for the 
ring the training phase and assists in optimizing the runtime search 

A larger regi
Template du

nder and add it to the Vision Process. 

»   Double click on the "Finder" in the Vision Toolbox. 
 
»   In the Name pop The -up, enter "my_finder" as the name of this new tool and press "Ok".  
new tool will be created and will appear in the Vision Tool Definition Window. 
 
»   Follow the step-b t is y-step instructions within the "Finder training" Application Wizard tha
displayed to setup the Finder keeping in mind the hints above. 
 
»   Click on "my_finder" in the Vision Tool Definition Window and drag it to the Process 
Manager and drop it on "my_process".  This will evaluate the Finder after the camera 
acquisition is executed. 
 
»   To test the new t then ool, in the Process Manager, click on "my_process" to select it and 
click on the circular green "Test Selected Process" button in the window's toolbar. 

Congratul  just cre s!  You 
can con n the 

ations, you
tinue to click o

ated your first Vision Process that identifies and locates randomly part
test button or execute your process in a continuous loop. 

»   If you wish to retrain the Template at anytime, click on "my_finder" in the Vision Tool 
Definition Window to ode"  select it.  Then click on the arrow to the right of "Finder Operation M
icon on the window ining toolbar and select "Train Mode".  You can also restart the Finder Tra
Wizard in this same pull-down if you wish. 
 
»   If you wish to sav ject e your changes to the Sample Project, select "File > Save Vision Pro
As..." and assign a new file name to your project so the original Sample is preserved. 
 
»   At this time, we highly recommend that you execute each of the distributed Sample Vision 
Projects, review the d edit the Tool Properties to get an understanding of ir Vision Processes an
more of the vision tools. 

This co rial ompletes the tuto n creating a Vision Process and applying the Finder Tool. 
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Tutorial 4:  Developing a Robot Vision Application 
This tutorial illustrates how t  It 
present  PreciseVis Guidance 
Control utorial requ ced to 
the PC executing PreciseVis

Prior to executing this tutoria

• The procedu

o develop a simple, but complete, robot vision guidance application. 
ion Project and the GPL software that must be executed on a 
ires that your robot and Guidance controller be operational and interfa
ion. 

s both the
ler.  This t

l, the following steps must first be performed: 

re for "Installing PreciseVision on a PC" must be completed. 
A camera m
robot. 

 interface must be installed and interfaced to PreciseVision using one 
e procedures in the "Hardware Installation

• ust be rigidly mounted over a region that can be reached by the 

• The camera
of th " section of this manual. 

e robot m  
edu  in "Configuring Communication Between the PC and the 

• Th ust be fully operational and interfaced to the PC via Ethernet.
res outlined• The proc

Controller" that permit the two systems to exchange data must have been 
d.  

bot 
performe

• The "Ro Vision Area Camera Calibration" must have been executed to define
s pixel-to-millimeter conversion and the transformation from the 
me of reference to the robot's frame of reference. 

 
era'

ra's fra
• The Guidan ld 

have a mod

the cam
came

ce Development Suite must be installed on the PC and you shou
est ability to develop and execute GPL programs. 

»   If PreciseVision i k on "Start > Programs > Precise Automation > PV xxx s not running, clic
> PreciseVision". 
 
»   If PreciseVision is already running, select "File > Quick Start". 
 
»   In the Quick Start window, click on the "New n. Project" butto

You sh Cr mbles 
the following. 

ould now see the " eate New Project From Application Template" pop-up window that rese
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The "Cr Project From Application Template" is a wizard that builds a complete Vision Project for 
a numb  ct 
that use  parts 
can be ut hittin sion Project 
(after c ect should be saved), creates a new Project, and automatically creates the 
Vision T gh the steps to 
position onal templates 
to addr n templates 
to simplify the use of the sy orkers or customers.  Of course, you can always create 
your own Vision Projects, Pr torials.  
The Ap  a 
starting point for those alrea . 

or this exercise, we will be selecting the "FinderLocatingSinglePart" template. This takes a single picture 
and then employs a single Finder Tool to locate your part. 

eate New 
er of common tasks.

ol to lo
 For example, the "FinderLocatingPartWithClearGrip" constructs a Proje
cate an object and then executes two ClearGrip Tools to verify that the
g an obstruction.  In particular, this wizard deletes the current Vi

s a Finder To
grasped witho
onfirmation if the Proj
ools and Vision Processes for the selected task.  The wizard then walks you throu

 of the tools for your parts.  Over time, we will be adding additi, size and train each
ess even more comm

s
on tasks and we will be adding the ability for you to add your ow
tem by your co-w
ocesses and Tools using the basic methods described in the other tu
t a convenience for people learning about the system or it can serve as

dy familiar with the system
plication Wizard is jus

F

»   Click on the "FinderLocatingS  all of inglePart.pvt" file, click on "Create" and then follow
the instructions of the wizard to cr , the eate your Vision Project.  At the conclusion of the wizard
Proje t, hould  c Process and Tools s  all be created and the Finder should be trained on your
object. 
 
»   Save your Project by selecting r "File > Save Vision Project As..." and assigning a file fo
your Project. 
 
»   To te lace you st your Project, p r object in the camera's field-of-view, click on "Main" in the 
Process Manager and then click o  the n the circular green "Test Selected Process" button in
window's toolbar. 
 
»   To va o ing lidate that the Vision Pr ject and the camera calibration are working properly, us
the s m  d he a e robot pointer you used uring the camera calibration process, manually move t
robot to the X/Y position indicated in the Results Window "RobX" and "RobY" values and 
verify that the tool is at the center of your part's Finder Template. 

PreciseVision is now dy to r sion in 
a special mod  t ot, it is o, there 
is no further d v one in Pr

The next step is to develop a GPL project that will execute the Vision Process "Main", retrieve the "part1" 
Finder Results and move the robot to the ired program 
is presented  th n section 
and is repeated below. 

setup and rea
o work with the rob
elopment to be d

eceive commands.  It is not necessary to place PreciseVi
 always listening for commands from a GPL system.  S
eciseVision. 

e
e

specified position.  A simplified version of the requ
g Language, Introduction to GPL" manual in the Visio in e "Guidance Programmin

»   Within GDE, the Guidance Dev  a new elopment Environment, in the Project Manager, create
GPL Project named "Robot_vision". 
 
»   In the new "Robot_vision" Pr  oject, double click on the "Main.gpl" file to begin editing.
 
»   In he ow the  of  t  editor window, bel  "Public Sub Main" statement, insert the following lines
text.  If you are readi lp file), ng this exercise in the Precise Documentation Library (the online he
this can be accomplished by copy ing. ing and pasting if you wish to save yourself some typ

 
        Dim vis As New Vision
        w VisRDim vResult As Ne esult
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        Robot.Attached = 1  
        ilMove.Loc(safe, vsProf e)  
         
        vis.Process("Main") ' Run vision process "Main"  
        If vis.ResultCount("part1") = 0 Then  
            Console.Writeline("Vision object not found")  
            Goto done 
        End If 
        vResult = vis.Result("part1", 1) ' Get results  
         
        eference fr' Create a r ame object and set it  
        ' equal to the returned vision location  
        Dim vsRefFrame As New RefFrame 
        vsRefFrame.Loc.PosWrtRef = vResult.Loc  
         
        ' Pickup point is relative to new frame  
        vsRelPoint.RefFrame = vsRefFrame  
         
        Move.Approach(vsRelPoint, vsProfile)  
        Move.Loc(vsRelPoint, vsProfile)  
        Move.Approach(vsRelPoint, vsProfile)  
         
        ' Move back to safe location  
        Move.Loc(safe, vsProfile)  
         
    done:  

»   In the the "Robot_vision" Project, double click on the "GModule.gpo" file to access the 
global Motion Objects panel. 

»   Create and teach a Location named "safe" that positions the robot so it is not obstructing 
the camera's view of the part.  Also, create a Motion Profile named "vsProfile" that will be 
used to slowly move the robot to the part. 
 
»   Create a Location named "vsRelPoint".   This will define the robot's pickup position relative 
to the Location returned from PreciseVision.  Normally, it would be best to manually define this 
Location relative to the actual value returned m the vision system.  But for demonstration fro
purposes, set its properties to the following where the Z value is a safe world coordinate value 
above the part. 

X = 0 
Y = 0 
Z = Z_safe  
Yaw = 0 
Pitch = 180 
Roll = 0 

» Press the ent" icon on the main tool ges. "Save Docum bar to save your chan
 
» To load your application, in t e he Project Manager, drag the "Robot_vision" Project from th
PC to the top "Loaded Projects" panel and drop it. 

You have now completed the developm ete 
vision guided robot application.  

ent of the GPL Project and we are ready to execute the compl
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DANGER: Before
robot has been p n 
installed and test
PrecisePlace rob
2300/2400 Robo

 

 proceeding with this procedure, please ensure that the 
roperly mounted, all required safety interlocks have bee
ed, and power has been connected.  For the 
ots, this information is provided in the “PrecisePlace 
t, Hardware Introduction and Reference Manual”. 

»   In the GDE Robot Control Window, set the "Robot Speed" to approximately 5%.  This will 
force your Project to move the robot at 1/20th of its normal speed. 
 
»   This next action will move the robot automatically to a position computed by 
PreciseVision, so be prepar blem ed to hit the E-Stop button or disable power if any pro
occurs! 
 
»   With your part placed in the camera's field-of-view, execute the GPL Project.  When you run 
a GPL program for the first time, it is advisable to start the project in debug mode. This can be 
done by selecting "Debug > S gh the tart with break" or pressing "Shift-F5". Single step throu
program one lin  at a time by e pressing "F10".  

Congratulations, you just created your first full vision guided robot application! 

 please read the Vision Guidance chapter of the 
n to GPL" manual.  This contains an overview of the built-

.  For more detailed information, please see the "Guidance 

For more information on the GPL vision interface,
"Guidance Programming Language, Introductio
in GPL vision classes, methods and properties
Programming Language, GPL Dictionary Pages".



 

Graphical User Interface 

PreciseVision User Interface 

 

ents 

The PreciseVision Graphical User Interface (GUI) consists of a title bar that displays the name of the 
opened project, a top menu bar, a main toolbar, and a variety of dockable windows. Each of the dockable
windows can be displayed or hidden, resized and repositioned into the arrangement that is most efficient 
for your use.  

When PreciseVision is started for the first time, the following default arrangement of the various elem
of the GUI is presented. 

 

 its title bar and drag it to its new location.  If you drag a
lit the space or share the space using tab controls.  If y
indow's title bar, you can 

To reposition  w in  
window on to another window, they can sp ou click 
on the close i on (x right of a w nu to 
redisplay the in ck on the " ill either 
"pin" a window and fix its location or "un-pin" a window so it can share its space with another window. 

Windows can be resized by grabbing a border and stretching or shrinking it to the desired dimension. 

 a indow, you simply click 

c
 w

) in the top 
dow.  If you cli

use the "View" top-level me
push pin" in the top right of a window's title bar, you w
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In the following sections, the functions sup n GUI 
(i.e. main menu bar, tool bars, and window

ported by each of the major elements of the PreciseVisio
s) will be described.  In addition, the Preferences Panel for 

specifying system configu atio nted 
in order of im r alphabe bel in the 
picture above or on a window. 

Main Menu and Toolbar 
The Main Menu and the Main Toolbar provide access to general functions such as displaying the 

ration inform
tance rather than 

n is also described.  The graphical components are prese
tically.  To jump to a specific description, click on a lapo

dockable windows, saving and loading Vision Projects and launching the camera calibration operations.  
This menu and toolbar appear as follows. 

 

The following tables describe the operation of each of the selections within the Main Menu and are 
organized by the name of the top-level menu.  These tables are followed by a description of each of the 
Toolbar buttons. 

File Description
Displays the pop-up Quick Start windo
PreciseVision is started.  

Quick Start  be constructed by a step-by-step wizard that supports many common 
procedures.  The latter two options are very instructive for individuals 
who wish to learn about machine vision or PreciseVision.  

w that is shown each time 
This window allows an existing Project to 

be loaded, sample canned Projects to be loaded, or a new Project to 

Displays a sub-menu with selections that create either an empty un-

New Vision Project wizard that supports many common proc
menu selection permits the last executed wi

named Vision Project or a new Project constructed by a step-by-step 
edures.  An additional sub-

zard to be re-executed to 
allow editing of the previously generated Vision Process. 

Open Vision Project 

Opens a new Vision Project from the disk and loads it into memory 
replacing the current Vision Project. The standard file pop-up window 
is displayed to allow browsing to the desired folder.  PreciseVision 
project files have a ".PVP" file extension. 

Import Vision 
Project 

Loads in the Vision Project contained in a file and merges its 
contents with the currently loaded project. If the new project contains 
any processes or tools whose names conflict with items that are 
already loaded, "_r" is appended to the name of the new item. Also, 
any camera calibration information that is contained in the new 
project is ignored. 

Save Vision Project  
Save Vision Project 
As ...  

Either saves the loaded Vision Project to its associated disk file or 
displays a pop-up file window to allow the operator to browse to the 
desired disk folder and assign a disk file name. 

Close Project  

Closes the loaded Vision Project after prompting if any changes 
should be saved to the Project's disk file.  The close operation 
deletes all defined tools and Vision Processes resulting in an empty 
un-titled Project.  

Preferences Displays the PreciseVision Preferences panel.  This panel contains a 
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number of application setup parameters that customize the operation 
and appearance of PreciseVision, e.g. enable/disable the display of 
the Main Toolbar or tool graphics.  

Acquire New Image  loads the image into the Camera Display window.  
Takes a single snap shot from the currently selected camera and 

Reinitiali
Con ct

Reinitializes Dalsa cameras that have stopped operating after being 
disconnected and reconnected or due to network connectivity 

al times to reconnect 

. This function forces the system to perform additional retries. 

ze Camera 
ne ions  disruptions. PreciseVision normally tries sever

to cameras that are no longer operating, but will eventually stop 
retrying

Image L
 disk 

mera Display window or saves the currently displayed oad / Save  
Diagnostic and debugging aid that loads a camera image from a
file into the Ca
image to a disk file.  

Lock / Unlock 
Ap

project. This is useful for avoiding situations where a user might 
inadvertently change a parameter or tool and cause a vision project 
to no longer operate correctly. Locking dims out all menu items, plication  

Locking an application prohibits users from modifying the loaded 

removes most toolbar items, and inhibits closing PreciseVision. 
Unlocking requires a password if a password has been defined in the 
Preferences panel.  

Exit Terminates execution of PreciseVision  

 

View Description

Layouts 

r 

Layout", "Load Edit Layout" and "Load Calibration Layout" for putting 
 layouts into effect.  These outs can also be 

accessed fro

Provides "Load Default", "Load Layout" and "Save Layout" selections 
for permitting custom desktop layouts to be preserved, reloaded o
set back to the normal default.  Also provides "Load Runtime 

standard  standard lay
m the main toolbar. 

Select Camera 
elects the c

Display windo e 
lib

S amera whose image is to be presented in the Camera 
w.  This also specifies the camera that is utilized in th
ration methods and other functions.  Camera Ca

Debug Provides access to a sub-menu that launches a number of diagnostic 
functions.  

Proc s es Manager  
Vision Tool 
Definition  
Visio Ton olbox  
Property Display  
Results Display  

Permits any dockable window that has been closed to be re-
displayed.  

Guid c
Panels  

s up to 
ce' tab e 

Guidance Co

an e Web Open
Interfa

three web panels specified in the 'Preferences -> Web 
. This provides convenient access to the Precis
ntroller web interface. 

Refresh 

Redraws any ision tools in the Camera 
Display window.  This is convenient because the graphics can 
sometimes be lost when PreciseVision is minimized or if you click on 
certain panels.  

 graphics generated by v
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Tool Description

Calibrate Vision  procedure determines the pixel-to-millimeter conversion for the 
selected camera and also the conversion from the camera's frame of 
reference to that of the robot.  

Initiates the execution of the camera calibration wizard.  This 

Camera Calibration 
Configuration  

Displays a pop-up window that associates a camera calibration file 
with a specific camera in the current Vision Project.  The information 
in this pop-up is saved and reloaded with the Vision Project.  

Show Camera Displays a pop-up window that shows which camera is selected and 
Information the camera calibration data that is in effect.  

Camera Video 
Displays a pop-up window that permits the brightness range and 
offset for the cu

Properties  
rrently selected camera to be set.  This is helpful 

during the setup procedures for the Camera Calibration methods and 
other functions. 

Show Vision Tool 
Cross Reference 
Information  

and vision tools that reference each defined tool or (2) lists the 
defined vision tools that are not referenced by any vision process or 
any vision tool.  This function is useful for understanding the 
relationship between vision tools in complex applications.  

Displays a pop-up window that either: (1) lists the vision processes 

 

Help Description
Contents 
PreciseVision GUI  
Vision Tools 
Overview  
GPL Programming  

Opens the Precise Documentation Library in a separate window and 
jumps to the specified section that is relevant to PreciseVision. 

Product Activation Displays the pop-up window used for activating this product. 

Camera Driver Info  Presents the version and identification information for installed 
camera drivers. 

About PreciseVision 
Generates a popup window that displays the PreciseVision version 
and ID information along with build information for key components of 
this application package. 

 

Icon Tool Tip Title Description

Create new Vision 
Project  

A new empty un-named Vision Project is created by 
deleting all of the tools and existing Vision Processes.  
If the current Project has been changed and needs to 
be saved to the disk, a pop-up is first presented that 

 

permits the operator to save the modifications. 

Save current Vision 
Project to disk  file pop-up window is displayed to allow the operator to 

Saves the loaded Vision Project back into its disk file. If 
the current project has never been saved to the disk, a 

 
browse to the desired disk folder and assign a disk file 
name. 

 Open a Vision Project  
Opens a new Vision Project from the disk and loads it 
into memory, replacing the currently loaded Project. 
The standard file pop-up window is displayed to allow 
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browsing to the desired folder.  PreciseVision project 
files have a ".PVP" file extension. 

 camera imag
Display live video 

e  

lected camera into "Live Video" 
mode.  Pictures will be taken continuously and 
displayed in the C y window.  This mode is 
very convenient fo e focus, f-stop, gain, 

 in live 

Places the currently se

amera Displa
r setting up th

and offset of a camera.  If the camera is already
video mode, pressing this button will terminate this 
mode.  

 Take a single snap shot 
Takes a single snap shot (i.e. picture) using the 
currently selected camera and displays the results in 
the Camera Display window. 

Toggle Color Displ
Mode  

y ay window display between color and grayscale mode.  
Set to color display mode by default.  

For color cameras only, toggles the Camera Displa
 

Zoom the Camera 
Display window  

n-
omed state.  If "Zoom Auto" is selected, the active 

Zooms the Camera Display window view in or out.  
Pressing the button zooms in.  A pulldown menu tied to 
this button zooms out or resets the window to its u
zo
vision window is automatically scaled so as to best fit 
within the display window.  The zoom factors range 
from 0.1 to 5 in steps of 0.1. 

 

Refresh Camera Di
ics  

d by vision tools in the 
cause 

ision 
splay Camera Display window.  This is convenient be

the graphics can sometimes be lost when PreciseV
is minimized or if you click on certain panels.  

window graph

Redraws any graphics generate

 

Switch display layo
ts: 

ation. This icon makes changing ut  
Switches between three predefined display layou
Edit, Run and Calibr
the display layout very easy.  

 

Lock / Unlock 
Application  

s 

 vision project to no longer operate 

n 

Locking an application prohibits users from modifying 
the loaded project. This is useful for avoiding situation
where a user might inadvertently change a parameter 
or tool and cause a
correctly. Locking dims out all menu items, removes 
most toolbar items, and inhibits closing PreciseVision. 
Unlocking requires a password if a password has bee
defined in the Preferences panel.  

 

Vision Camera Display 
The Camera Display window shows the captured image from a selected camera with graphics to illustrate 

f 

The following picture is a typical camera image with overlaid tool graphics.  For all cameras, the X-axis of 
lay 

age.  If the camera is calibration, X/Y positions are 
typically in units of millimeters relative to the origin. 

applicable vision tools.   The camera image can be a "live video" display, which means that the captured 
image is continuously updated, or a single snap shot.  The vision tool graphics illustrate the placement o
tools and their computed results.  When a tool is selected for editing, the graphics also include handles 
that permit the tool to be easily re-positioned, re-oriented and re-sized using a mouse. 

the camera coordinate system points from left to right and the Y-axis points from the bottom of the disp
to the top.  The origin (0,0) of the camera coordinate system is in the lower-left corner of the camera 
image.  If the camera is not calibrated, X/Y positions in the camera image are returned in units of raw 
pixels relative to the lower-left corner of the camera im
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To acco te large or small ima e with many or few pixels), the camera display can be 
zoomed out or zoomed in.  The con ith icons 
for man  placing a camera into l tains 
other commands for changing the s justing their gain and offset. 

The foll mages describe how ision tool 
and optio ntrolling how the r . 

mmoda ges (thos
trol for this operation is provided on the Main Toolbar along w
ive video mode and taking a snapshot.  The Main Menu con
elected camera and ad

ually

owing i to utilize the graphical handles to place and size a typical v
esults of a tool are illustrated in the Camera Display Windowns for co

Graphical Display  Description

 

To position the tool, click anywhere in the search region 
and drag the rectangle.  To resize the tool, click one of the
four blue squares and drag.  To rotate the search region
click the blue circle and drag

This is a snap shot of a Line Fitter Tool placed over one 
edge of a part. The green and blue perimeter lines ind
the tool's search are

icate 
a.  The blue edge marks the side of 

 
, 

the search region that should be positioned on the dark 
side of the edge.  The red line illustrates the results of the 
tool and marks the best fit line. 
 

. 
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If the output of a tool is to be utilized as an input (X, Y) 

places a yellow "X" at the origin of the output of the Line 
Fitter.  Note, setting ShowResults only affects the 
graphical display and does not alter the results computed 
by the tool. 

point for another tool, it is informative to display the result 
as a single position.  In this picture, the ShowResults 
property for the Line Fitter has been set to "POINT".  This 

 

 

I
i
L

n this example, if the output of the Line Fitter is to be 
nterpreted as a line, the ShowResults property for the 
ine Fitter can be set to "LINE". 

 

I
i
p

n this final example, the output of the Line Fitter is to be 
nterpreted as a reference frame, so the ShowResults 
roperty for the Line Fitter has been set to "FRAME". 

Process Manager Wind
The Process Manager Window displays the list of all of the Vision Processes that are contained in the 

f a Vision Process is expanded, all of the Vision Tools for the Process 
h they are evaluated.  This window is the primary means for managing 

n, renaming, deletion, modification and test execution. Any 
 

w. 

ow 

currently loaded Vision Project.  I
are displayed in the order in whic
Vision Processes including their creatio
Process that is displayed in this window is eligible for execution by a GPL procedure running on a Precise
Guidance Controller. 

A typical Process Manager Window is shown belo
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In this example, a single Vision Process "LocateMultipleParts" is contained in the currently loaded Vision 
Project.  This Vision Process has three tools.  The Process begins with the standard Acquisition Tool that 
takes a picture.  After the picture is captured, the system evaluates a Finder Tool named "part".  The final 
operation is an Edge Locator "el_test_part". 

It should be noted that if the Edge Locator is defined relative to the Results of the Finder Tool, the 
Process could have been written without the explicit execution of the Finder.  When the syste  
encounters the Edge Locator, it would automatically execute the Finder if the Finder had not 

 

e new 
ssigned a unique name, it will appear as a top-level (i.e. left-most) item in the window.  To 

specify the sequence of tools to be executed in the process, simply drag Vision Tools from the Vision 
Tool Definition W nd drop them on the Process.  N automatically added to the end of 
the Process and can be re-or
appear e tools is im . 

After a Vision Process has be
Process Manager window an

Once a Vision Process has b sted using 
an icon on the toolbar.  The manual te ss can be executed 
continuously.  The continuou xecution of 
the Process will not be synch actical 
use. 

The foll s provide additional information on each of the window toolbar options. 

m
been 

evaluated.  The decision of whether to include the Finder in the Vision Process is entirely a matter of 
personal preference.  Whether or not the Finder is included, the Results of the Process would be identical
as well as the execution time. 

To add a new Vision Process to a Project, click the toolbar icon to "Add a new process". Once th
Process is a

indow a ew tools are 
dered by using the up and down arrows in the toolbar.  The order of 
portant since the tools are evaluated top to bottom in the displayed listance of th

en created, it can be renamed by right-clicking on its name within the 
d selecting "Rename Process." 

een created, it can be triggered from GPL or can be manually te
st can be executed a single time or the proce

s test mode is intended for demonstration purposes since the e
ronized with the GPL robot program and therefore not of very much pr

owing table

Icon Tool Tip Title Description

Add new pro

Creates a new Vision Process and adds it to the 
Process Manager Window after it has been assigned a 

L 
cess unique name via a pop-up window.  The Process 

names are very important since they are used by GP
procedures to initiate the execution of a Process. 

 

Test selecte d process Test executes the selected Process once or 
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continuously.  This is useful for debugging a Process 
 a and examining its computed results.  However, in

robot guidance application, Processes are always 
initiated from a GPL procedure to ensure that the 
picture taking and evaluation are coordinated with the 
robot motions. 

Stop test loo hile p 
If a process is running in a continuous test mode, this 
button will stop the Process. This is only used w
manually test executing a Process. 

 

Remove sel
 not 

st use the Vision 
ected item 

Removes a Process from a Project or a tool from a 
Process.  In both cases, any referenced tools are
deleted from the Project, only the reference to the tool 
is removed.  To delete a tool, you mu
Tool Definition Window. 

 

 Move tool up 

Move tool d

 
If a Vision Process is selected, 

sses 
e and 

ow Vision Processes are executed. 

own these button will change the order of the Proce
within this window.  This is a convenience featur
does not alter h

Moves a vision tool up or down one line in a Vision 
Process list.  The order in which the tools are listed in a 
Process is important because this is the order in which
the tools are evaluated. 

 

Vision Toolbox W
The Vision Toolbox Window d to construct 
a Vision Process.  The top of rrently looks as shown below. 

indow 
displays a list of all of the vision tool types that can be employe
 this list cu

 

ication, double click on a tool type in th

tool will appear in the Vision Tool Definition Window.  Once there, the
 the Process Manager to add the execution of the tool to a specific V

To add a new tool to an appl is list or right-click and select "Create 
Tool".  A pop-up will be displayed for assigning a unique name to the new copy of the tool.  Once a name 
has been assigned, the new  tool 
can be edited gged into ision 
Proces

 or dra
s. 
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Vision Tool Defin
The Vision Tool Definition W rently loaded 
Vision Project, even those th e 
primary means for adding too
convenience, this window gra er tools.  

A typica efinitio

ition Window 
indow displays all of the tools that have been created in the cur
at are not referenced in any Vision Process.  This window provides th
ls to a Vision Process and for selecting tools to be edited.  As a 
phically indicates when tools are dependent upon the results of oth

l Vision Tool D n Window will appear as shown below. 

 

To simplify accessing tools, all of the defined tools are grouped according to their tool type and only tool 
types that have one or more tools defined are visible.  In the example above, there is one Acquisition Tool 
named "picture_1", two Edge Locators named "edge_2" and "el_test_part" and one Finder Tool named 
"part".  The second Edge Locator has been defined with respect to the results of the Finder, so the Finder 
"part" appears below "el_test_part" to indicate this relationship. 

There are a number of ways that a new tool can be added to the Vision Project and the Vision Tool 
Definition Window: 

• Double click on a tool type in the Vision Toolbox Window. 
• Right-click a tool or tool type in the Vision Tool Definition Window and select 

"New Vision Tool". 
• Drag a tool type from the Vision Tool Definition Window and drop it into the 

Camera Display Window. 
• Right-click in the Camera Display Window and select "New Vision Tool". 

To copy an existing tool while maintaining its dependencies to other tools, highlight the tool in this window 
and click the "Copy" icon in the toolbar or drag the existing tool and drop it into the Camera Display 
Window. 

To edit a tool, simply click on the name of the tool.  This will automatically display the properties of the 
tool in the Property Display Window and will highlight the editing graphics and the handles for the tool 
within the Camera Display Window. 

To test the operation of a tool without executing a Vision Process, click on the tool and click the "Play" 
button in the toolbar.  This only executes the selected tool and any tools on which it is dependent.  If the 
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tool on which it is dependent returns multiple results, e.g. a Finder, only the first set of results is 
processed by the tool being executed.  This is done to permit you to easily reposition the executed tool. 

The following tables provid s. e additional information on each of the window toolbar option

Icon Tool Tip Title Description

Create copy Copies the selected tool along with its relationships to 
s.  other tool

 Remove selected tool Delet
not effec

es the selected tool after confirmation but does 
t any tools that it references. 

 Execute selected tool 
Executes the selected tool and all of the tools on which 
it is dependent without executing a Vision Process.  
See above for further information. 

 Finder operation mode mode. Can also launch the Training Wizard to assi
teaching a Finder Tool and can display a trained Find
template at various resolutions as a diagnostic aid. 

For Finder Tools, switches between "Find" and "Train" 
st in 

er 

Perform training 

For tools that require training, executes the training 
process. In the case of the Finder Tool, this records the 
Finder Template and perfo operation rms the analysis to 
determine distinctive features and the maximum levels 
of the search pyramid. 

Prop
In PreciseVision, each Vision Tool is internally represented as a software "Object". The parameters for 
each tool are  its "Prope  The properties include es that specify how a tool 
operates (e.g. its tool type, tool name, position, si
that indicate the results of executing the tool (e.g cated, 
etc.). F ision T t of p vary from 
one type of tool to the next. 

Some V ide speci at a erty 
grid.  These buttons provide access to tool spec s (e.g. 
automatically snapping a tool into positio

The Property List Display provides a very conve
values of a tool.  As an example, the Property Li n below. 

erty List Display 

referred to as rties".  both the valu
ze, operating characteristics, etc.) as well as the values 
. number of objects found, number of edges lo
roperties is always the same, but the list will or a given type of V ool, the lis

ision Tools prov al buttons th re displayed between the tool name and the prop
ific operations during the editing proces

n). 

nient means for both viewing and editing the property 
st Display for a typical Fixed Frame Tool is show
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The pull-down list at the top of the window selec ill also be 
automatically changed whenever a new tool is c ition 
Window

Once a tool has been selected, any of its writabl and 
entering a new value.  When a property is select splayed at the 
bottom of the window.  Properties that are reado

To assist in accessing these parameters, the pro iption of 
each of d i ng r each 
of the tool types please see the chapter on the "

ts the tool to be displayed.  The displayed tool w
reated or a tool is selected in the Vision Tool Defin

e values can be modified by clicking on a cell 
ed, a short description of the property is di

. 

nly are indicated by dimmed text. 

perties are group according to their use.  A descr
table.  For detailed information on the properties fo
Vision ToolKit". 

 the groups is presente n the followi

Property Group Description
1. Identity Properties eSpecifies th  name of the tool and its basic tool type. 

2. Placement / Size 

 e 
nate s  is 

defined rela
n c

graphically p
Properties 

Defines the
coordi

position, orientation and size of the tool in th
ystem of the camera.  In addition, if the tool
tive to another tool, the relative position and 
an also be specified.  Normally, it is easiest to 
osition and size each tool by dragging on

orientatio
 the 

s displayed in the Camera Display Window. tool's handle

3. Operation Properties 

Defines para  
le, a t
 if it s

gray scale le e 

meters that control the execution of the tool.  For
examp
defines

ool might have an Operation Property that 
hould screen out black-to-white edges or the 
vels above which pixels are processed. Only th
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commonly u  
group. 

sed Operation Properties are placed in this

3A. Advanced Operati
Prope

on
rties 

Contains Op ied 
neral

these prope ngs will yield good tool 
nce

 and ge
eration Properties that are not normally modif
ly require a bit more experience to utilize.  For 
rties, their default setti

performa  for typical applications. 

4. Inspection Settings 
Properties 

 si ol to be 
icall
Pa roperty is set accordingly and a Pass / 

Fail label ca
ra Dis

Permits a ngle scalar result of the vision to
automat
limits.  A 

y tested (inspected) to verify that it is within 
ss / Fail p
n be optionally displayed on the tool in the 
play Window. Came

5. Results Settings 
Properties 

ls the
le, if m

tool, these p of sets of data 
computed a  

ts

Contro
examp

 results that are computed by the vision tool.  For 
ultiple sets of results can be computed by the 

roperties can limit the number 
nd can select the set of data that is displayed in
 Properties. the Resul

6. Results Properties 

ays a si  
the results returned varies from tool to tool. Many tools return 
a vision refe n 

al re
the ans

Displ ngle set of results for the vision tool.  In general,

rence frame.  However, some tools retur
sults items such as statistical information on how 
wer fits the actual data. 

addition
well 

Vision Results Display 
The Vis viously 
execute  vision 
coordina le camera calibration data.  The 
information contained in this display is automatically updated each time a Vision Process completes 
executio

A typica
Locator  Finder 
or Conn corresponding object will be highlighted 

ion Results Window displays the "Results" properties for all of the tools evaluated in the pre
d Vision Process.  For position and orientation data, the results are displayed in both the
te system and the robot coordinate system utilizing the applicab

n. 

l display that illustrates the results of a Vision Process that contains both a Finder and a Edge 
 Tool is shown in the following picture. For tools that return multiple sets of results (e.g. the
ectivity), if you click on a line in the Results display, the 

with a blue coordinate frame in the Camera Display. 

 

The following tables provide additional information on t ided in 
each column of the results table. 

he window toolbar options and the data prov
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Icon Tool Tip Title Description

 Save 

Stores the re
(*.CSV) that can be re
for further pr
displayed to y path 
to be specified. 

sults data in a comma delimited file 
ad into a spreadsheet application 

ocessing.  A standard popup file window is 
allow the file name and disk director

 Copy to clipboard 
Copies the contents of the results table to the system 
clipboard in a comma delimited (*.CSV) format.  This 
information can then be pasted into another application.

 Timer 

Displays the execution time for each tool in the 
previously executed vision process instead of the tool 
results. The incremental time for each tool is displayed 
as well as the cumulative execution time for all tools in 
the process, in milliseconds. 

 

Data Column Description

Name Sp e
re

ecifies the nam
sults. 

 of the vision tool that generated the 

Idx 
For tools that return  
for the set of result
va 1-

 multiple sets of results, this is the index
s that is displayed on a line.  The index 
n. lue goes from 

Vis X 
Vis Y 

Vis Angle 

For tool urn  
Y position in millim
values are in the co era's field-of-
vie

s that ret  a position and orientation, this is the X &
eters and the angle in degrees.  These 
ordinate system of the cam

w. 
Rob X 
Rob Y 

Rob Angle 

For tools that return
Y position in millim
va ro
val an
guidance applicatio

 a position and orientation, this is the X & 
eters and the angle in degrees.  These 
bot's world coordinate system and are the 
sferred to a GPL program in a vision 
n. 

lues are in the 
ues that are tr

Passed Pa  o
val e

ss / Fail results
ue as the 

f the tool Inspection.  This is the same 
ctPassedInsp  property. 

Ins Ac al
This is the same vap Val tual property v ue that was tested by the tool Inspection.  

lue as the InspectActual property. 

Special Results 
Ea a
to h
special results per 

ch vision tool m
the tool type. T

y have additional results that are unique 
is column provides a place for up to 20 
vision tool. 

Errors and Warnings tool was executed.  This is the same value as the 
Specifies if an error or warning condition occurred when the 

ResultErrorCode property. 

Appl
The bottom ciseV pplicatio w contains the Status Bar.  This area continuously 
displays stat mation  execution of the application.  The Status Bar typically resembles the 
following

ication Status Bar 
 of the Pre
us infor

ision a
on the

n windo

. 
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The information contained in each of the columns of the ing table.  Status Bar is described in the follow

Col # Data Description

1  Server status 
Indicates Ether
Guidance Cont message is received, 
the icon will flicker. 

net traffic between PreciseVision and a 
roller.  Each time a 

2  Image status 
Indicates if the selected camera is in "live video" mode 
(bright light bulb) or a single still image has been 
captured. 

3  Camera calibration file Displays the name of the camera calibration file for the 
camera. currently selected 

4  Came
type 

ra ca n f camera calibration that is in effect for 
th cted camera,  Only, Robot 
Vision, etc. 

libratio Displays the type o
e currently sele  e.g. Camera

5  Process execution Indicates the total time required to execute the last Vision 
time Process in seconds. 

7  Camera coordinates 
and intensity reading 

Shows the X/Y position of the mouse cursor in calibrated 
camera coordinates and the gray-level intensity value of 
the associated camera image pixel.  This is useful for 
setting threshold and edge level values. 

8  Project modified flag 
Indicates if the curre
modified in any

ntly loaded Vision Project has been 
 way and must be saved to the disk in 

order to preserve the changes. 

Prefe an
The Preferences Panel contains a number of application s  operation 
and appearance of PreciseVision.  Once saved, these pre  put 
into effect each time the application is restarted. 

The Preference Panels appears as shown

rences P el 
etup parameters that customize the
ferences are automatically reloaded and

 below. 
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 "Update" button must be pressed b

ted on each tab of this panel is briefly

When any data in the Preferences has been modified, the efore the 
change t and be pre

In the following table, the configuration information presen  
described. 

will take effec served. 

Tab Description

Acquire 
Defines the default disk file  
Acquisition Tool is executed
convenience for logging ima

path for storing camera images when an
.  This is a debugging and diagnostics 
ges. 

Auto Start 

Spe Vision ct th e 
PreciseVision is restarted.  O
Processes are immediately 
procedure executing on a G
 
This tab also contains the 'S
specified layout will be autom sion 
is started. For production sy e 
'Run Mode' layout. 
 
Options are also provided to
r  m re  
he oce o s

Access tab. 
 
A parameter is provided tha
execution for a specified num
PreciseVision is automatica
PC requires time to initialize

cifies a  Proje at will be automatically loaded each tim
nce a Project is loaded, its Vision 

available for execution by a GPL 
uidance Controller. 

tartup Layout' specification.  The 
atically loaded each time PreciseVi

stems this would normally be set to th

 start up PreciseVision minimized and / 
vents operators from making changes to
et the lock password, see the User 

t will delay PreciseVision from starting 
ber of seconds. This is beneficial if 

lly started when the PC boots up, but the 
d its network cards and camera 

o
t

in a locked
 loaded pr

ode that p
sses.  T
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interfaces. 

Camera Hardware 

Specifies the type of camera
images, e.g. Ethernet or US fines each camera's logical 
number.  Some of the data s
panels are specific to the typ , 
thes eters fine
inst roces  mo e 
the Camera Installation

 hardware to be used to capture 
B, and de
pecified on this panel and its sub-
e of camera being employed.  Normally
d during the software and camera 

re information on this panel, please se
e param

allation p
 are de
s. For

 sect
information on configuring e

ions of this manual for detailed 
ach type of supported camera. 

Client Settings 

Defines the Ethernet IP add
accessed during the camera
operations, the controller IP
the commands that GPL sen

ress for the Guidance Controller that is 
 calibration process.  For normal 

 address is automatically deduced from 
ds to PreciseVision. 

Data Logging 

Enables the log io
diagn  purpo  t  
time stamped an n t 
format (*.csv).  This file can 
spreadsheet application for 

ging of Vis
ses. Each
d stored i

n Tool Results to a disk log file for 
ime a tool is executed, its Results are
a specified file in a comma delimited tex
be easily imported to Excel or another 
analysis. 

ostic

Environment 
In addition, a checkbox is provided to permit PreciseVision to be 
minimized to an icon in the System Tray as opposed to an item o
the Windows Start Bar. 
 
An "Auto Zoom" feature is also provided that automatically scales 
the active camera

Controls whether the Main T
displayed.  Also permits adju
demonstration parameters. 
 

n 

 image to best fit within the camera display 
window. 

oolbar and the Status Bar are 
stment of some diagnostic and 

Layouts 

De
layouts provide an ea

fines three user-interface layouts of the dockable panels. These 
sy way to quickly switch between several 

di rmats that are appropriate for di ing needs: 
pr on systems, editing sessions and ocesses. 
 
If the "Layout Filename" is  
use a predefined default lay
installation directory. If the 
override these defaults. 
 
Click the "Current" button in
window (width and height) 

splay fo
oducti

fferent operat
 calibration pr

left blank, PreciseVision will automatically
out stored in the "Layout" folder of the 

field contains a valid layout file, it will 

 each selection to record the size of the 
automatically. 

Live Video 

Controls the rate a which t
Video mode. This permits t
balanced when using Preci
 
The update rate ranges fro  
default setting of 10.  For c thernet, a 
rate of 1 to 15 fps is typical ed at 1000Mb 
E  the  c
 
T NOT available for USB cameras. The frame rate is set 
to the maximum defined by the camera. Some USB cameras do not 
operate properly if the live frame rate is set to certain values. 

t he camera image is updated in Live 
he Ethernet network traffic to be 
seVision. 

m 1 to 30 frames per second (fps) with a
ameras interfaced at 100Mb E
.  For cameras interfac

thernet,  refresh rate an be as high as 30 fps. 

his mode is 

Tool Operation Enables and disables the ResultOnNotFound property for all 
required tools.  This is typically set if an Inspect List Tool is defined 
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that analyzes the output of 
such as a Finder, and the I n 
operations.  Enabling this p
results even if their inspect
generating complete, consi t List 
to his pro  is nor  
processes prefer to ignore st  
This property is disabled by

a tool that generates multiple results, 
nspect List includes multiple inspectio
roperty forces all tools to generate 
ion tests fail.  This is important for 
stent sets of results for the Inspec
mally disabled since most vision
any object that fails an inspection te
 default. 

 test.  T perty

User Access Defines the password used to unlock access to PreciseVision. 

Vision Graphics 

Enables and disables the d and their Results in 
the Camera Display Windo phics has relatively 
little impact on the performance of the system, so the graphics are 
normally displayed. 

isplay of Vision Tools 
w.  Drawing these gra

Web Interface 

Enables up to 3 web panels to be configured into the PV user 
interface as dockable controls.  These panels can be utilized to 
integrate web pages of the Guidance Controller into the PV 
environment. 
 
Either the complete path for each web must be specified, e.g. 
"http://192.168.0.1/ROMDISK/web/Opr/master/masterfs.html" or just 
the path with the Client Guidance Controller without the Client's IP 
address, e.g. 'ROMDISK/web/Opr/master/masterfs.html'.   In the 
latter case, the IP address of the Client Guidance Controller will be 
automatically assumed when displaying the panel. 
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Vision Toolkit Description 

Vision Toolkit Introduction 
r provides detailed information on each of the tools in the PreciseVision vision 

  These tools perform all of the runtime operations that are needed to acquire and 
process an image captured from a camera. 

Each instance of a tool is a vision object with a graphical front-end, a property list for 
configuring the tool for your desired operation, and a read-only list of results properties 

ed by other vision obje ate more complex ma nd 
logical operations.  The graphical front-ends allow the vision tools to be easily positioned 

captured image and greatly simplifies their training. 

olKit Summa

ing table briefly summarizes the primary function of each of the vision tools.  
"Type" broa ch t to whether " an 

res, "Inspects" a region, "Com
s" image o data or serves as a "Motion S

tions on the followi

This chapte
toolkit.

that can be us cts to cre chine vision a

over a 

To ry

The follow
The dly categories ea ool as  it "Acquires" an image, "Finds
object, "Measure
"Filter

s" featu
r object 

putes" additional information, 
ensor".  Please see the detailed 
hich these tools can be utilized. descrip ng pages for more ways in w

Vision Tool Type Description

Acquisition Tool Acquires 
Captures an image from a camera or loads it 
from a disk file
frame buffer.  

, and stores the image into a 

Arc Fitter Tool Measures 
Searches a sp
returns the arc
both the arc c

ecified region for arc edges and 
 that best fits the edges.  Returns 

enter point and radius.  

Barcode Reader Tool Inspects 
a varie

barcodes and e 
value of the ba

Reads ty of standard 1-D and 2-D 
 returns the barcode type and th
rcode. 

Clear Grip Tool Inspects 

Verifies that th
bounds of a d
confirm that g
collision. 

ere is no obstruction within the 
efined window.  Typically used to 
ripping a part will not result in a 

Connectivity Tool Finds 

Searches a re
the centroid a

, this t  
er of a

gion for binary blobs and returns 
nd other features of each blob. In 
ool can return data that defines the
ny located blob. 

addition
perimet

Edge Locator Tool Measures 

Detects edge 
along a linear 
their positions
array of the in

gram of t

points with sub-pixel accuracy 
path in a vision image and returns 
. Alternately, this tool can return an 
tensities along the linear path or a 
heir values. histo
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Find Centerline Tool Measures 
Searches a sp
returns the ce
bounding lines

ecified region for edge points and 
nterline between two located 
. 

Find Point Tool Measures 

s the ed
that defines th gion.  
The XY positio
pixel accuracy
perpendicular

Locate ge point that is closest to the line 
e start of the tool's search re
n of the point is returned with sub-
 along (and pixel accuracy 

 to) the search direction. 

Finder Tool Finds 

Most powerful
placed parts in
position, orientation and n sub-
pixel accuracy

 vision tool that identifies randomly 
 a camera image and returns their 

scaling to withi
.  

Fixed Frame Tool Computes 

Places a refer
coordinate or 
another vision
frame in an X rn to repeatedly 
execute any linked tools.  

ence frame at a fixed image 
at a constant offset relative to 
 object.  Can optionally index the 
and/or Y grid patte

Image Process Tool Enhances 
image  

Performs imag
thresholding a  
specified area

e filtering, edge extraction, 
nd morphological operations on a
 in the camera image. 

Inspect Frame Tool Computes 

 throug
Results of a re
rotates and sh
inspection.  Th
arithmetic com
other tools.  S
for performing
on the results 

Passes h the XPos, YPos and Angle 
ferenced tool and optionally 
ifts the Results based upon an 
e inspection can consist of the 
bination of the Results of two 

o, this tool also provides a means 
 simple mathematical operations 
of two tools. 

Inspect List Tool Computes 

Passes throug
Results of a re
different Resu
if the object is  
convenient wa
located object
location with a

h the XPos, YPos and Angle 
ferenced tool and tests up to 12 
lts from multiple tools to determine 
 good or bad.  This tool provides a
y to perform complex testing of a 
 and generating an equivalent 
 single Pass/Fail indicator. 

Inspect Region Tool Computes 

Inspects the p
opaque object to determine if there are any flaws 
in the object's
This tool was e 
slight changes
the wafer are  chips in the 
perimeter or interior holes or cracks are 

e.

erimeter and the interior of an 

 outline or holes in the interior.  
designed to inspect wafers, wher
 in the overall size and shape of 

permitted, but

  unacceptabl

Light Recorder Tool Det
patt

s for a 
o

f e the 
adings. 

ects light 
ern  

Acquires a se
specified peri
brightness o
brightness re

quence of camera image
d of time, determines the 
ach image, and returns 

Line Fitter Tool Me s a spasures Searche
returns the lin

ecified region for edge points and 
e that best fits the edges. 

Line-Line Frame Tool Computes Determines th
by vision obje

e intersection of two lines defined 
cts and returns a reference frame. 

Pixel Window Tool Inspects 
Counts edges collects gray-
scale statistics
circular region

 or binary pixels or 
 within a rotated rectangular or 
. Used for quickly detecting the 
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presence of fe
intensity inform

atures or collecting general 
ation about a region.  

Pixel Color Window 
Tool Inspects 

Tests if the ge
circular region
specified toler

neral color of a rectangular or 
 matches a trained color within a 
ance.  

Point-Line Frame Tool Computes Takes a point 
and returns a 

and a line from two vision objects 
reference frame. 

Point-Point Line Tool Computes Computes a li
objects. 

ne given two points from vision 

Sensor Window Tool Detects 
motion  

Detects motio
scene is stabl
until motion is
physical senso
parts can take  

n in a window region. Ensures the 
e prior to other operations or waits 
 detected. Can be used in place of 
rs in flexible parts feeding where 
 time to settle. 

Text Label Tool Labels 

Displays string
results data fr
shown relative
tool. 

 constants plus inspection and 
om a referenced tool.  Text is 
 to the position of the referenced 

Tool Filter Tool Filters 

Takes the out
generates mu
subset of the r
criteria.  

put from another tool that 
ltiple sets of results, and returns a 
esults based upon specified 

 
Standard Tool Properties

To simplify their application, as much as practical, the 
group of property names and associated operations.  T
standard tool properties that are common to many of th

In these tables and the detailed tool descriptions, prop
e and data type dimmed.  In addition, propert

property or method within the Guidance Programming 
member name underlined and in italics bounded by sq  
and the class name, e.g. "[GPL: Vision.ResultCount]

vision tools make use of a common 
he following tables describe the 
e tools. 

erties that are "read-only" have 
ies that have a counterpart 
Language include the GPL 
uare brackets preceded by "GPL:"

their nam

".  

The Identity Properties specify the name of the tool and its basic tool type. 

1. Standard Identity Properties

Property 
Name

Data 
Type Range  Description

Name String n/a 

This is 
assigne
genera
the GP
That is,
(upper 
when re  by other tools, the 
names 

).  

underscore "_" and can be followed by up 

the unique name that must be 
d to each instance (copy) of a 

l tool type.  The name must follow 
L variable naming conventions.  
 a name can be mixed case 
and lower case characters) but 
ferenced
are not considered case sensitive 
c and aBc refer to the same tool
 must start with either a letter or an 

(i.e. Ab
Names
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to 127 a
undersc

dditional letters, numbers and 
ores.  In GPL, this is the name by 

which a tool is referenced.

Type String n/a This rea
type for

d-only property displays the basic 
 the tool, e.g. VsLineFitter. 

The Placement / Size Properties define the position, 
the coordinate system of the camera.  In addition, if the
tool, the relative position and orientation can also be specified.  Normally, it is easiest to 
graphically position and size each tool by dragging on  
Camera Display Window.  In the range specifications, 
of Interest" and refers to the size of the portion of the c
analyzed.  

orientation and size of the tool in 
 tool is defined relative to another 

the tool's handles displayed in the
"AOI" is an abbreviation for "Area 
amera image that is being 

2. Standard Placement/Size Properties

Property 
Name

Data 
Type Range  Description

Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 

YPos Single 0 - AOI (mm) 

These v
degree
units, m
in the c
These v
when th
and re-
vision t d relative to another 
vision t

alues specify the orientation (in 
s) and the position (in calibrated 
m) of the center of the vision tool 
oordinates of the vision image.  
alues are automatically updated 
e tool is graphically re-positioned 

oriented during training and if the 
ool is place
ool during runtime. 

Height e 0 - AOI (mm) Singl

Width Single 0 - AOI (mm) 

These v
of the v
These v updated 
when th e mouse 
or can b
precise

alues define the height and width 
ision tool in calibrated units (mm).  
alues are automatically 
e tool is adjusted with th
e manually entered for more 

 adjustments. 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 

RelYPos Single 0 - AOI (mm) 

These v
degree
units, m
relative
Relativ
not rela
values 

alues specify the orientation (in 
s) and the position (in calibrated 
m) of the center of the vision tool 
 to the vision object specified by 
eToolName.  If the vision tool is 
tive to another vision object, these 
are zero. 

The Operation Properties define parameters that con
example, a tool might have an Operation Property that

ite edg  the gray ve wh
Prope  in this

trol the execution of the tool.  For 
 defines if it should screen out 
ich pixels are processed.  Only the 
 group.  

black-to-wh
commonly used Ope

es or
ration 

 scale levels abo
rties are placed

3. Standard Operation Properties

Property 
Name

Data 
Type Range  Description

Camera Integer 1 Defines
its asso- 6  the number of the camera (and 

ciated frame buffer) on which the 
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tool operates. 

Relative-
ToolName List n/a 

If a tool
another the 
referenced tool.  Tools can be relative to 
any vis
coordin
not rela
propert

 is to be positioned relative to 
 tool, this is the name of 

ion tool that returns a vision 
ate position.  By default tools are 
tive to another tool and this 
y is blank. 

The Advanced Operation Properties contain Operati  
modified and generally require a bit more experience t
default settings will yield good tool performance for typ

on Properties that are not normally
o utilize.  For these properties, their 
ical applications.  

3A. Standard A  Operatio iesdvanced n Propert

Property 
Name

Data 
Type Range  Description

The Inspection Settings Properties permits a single 
automatically tested (inspected) to verify that it is within limits.  A Pass / Fail property is 

ly and a Pass / Fail label can be optionally displayed on the tool in the 
isplay Window.  

scalar result of the vision tool to be 

set according
Camera D

4. Standard Ins  Settings Prop rtiespection e

Property 
Name

Data 
Type Range  Description

InspectType   

Spec
to be
vary
"Non le inspecting a result. 

List
ifies the single scalar result that is 
 inspected.  The items in the list 

 from one tool to the next.  Select 
e" to disab

InspectLabel List

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER  

Indic
num
tool 
based up
inspe
indic
displ
Fail 
a real o
Pass
and 
selec
only 
the insp

ates if a Pass / Fail label or a 
eric value is to be displayed on the 
in the Camera Display Window 

on the results of the 
ction.  The items in the list 

ate if no label should be 
ayed, only a Pass label, only a 
label, either a Pass or Fail label, or 

r integer numeric value. The 
 indicator is displayed in green 

the Fail is written in red.  This 
tion is used for display purposes 
and has no effect on the results of 

ection. 
InspectMax Single   

InspectMin Single   
InspectType to "Pass" the inspec
Values outside of this range are 
marked as "Failed". 

Maximum and minimum values 
permitted for the item specified in 

tion.  

InspectActual Single  This is a read-only property that 
indicates the value of the result 
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specified by InspectType that was 
tested during the inspection. [GPL: 
VisResult.InspectActual]
Indicates if the inspection criteria was 

InspectPassed List Pass / Fail

satisfied (Pass) or was not (Fail).  Set 
to 'Pass' if no inspection is selected.  If 
the inspection fails, any tool that 
references this tool, for example via 
the RelativeToolName property, will 
also have a failed InspectPassed 
although that tool will still be evaluated. 
[GPL: VisResult.InspectPassed]

The Results Settings Properties control the results that are computed by the vision 
tool.  For example, if multiple sets of results can be computed by the tool, these 

data properties can limit the number of sets of data computed and can select the set of 
that is displayed in the Results Properties.  

5. Standard Results Settings Properties

Property Name Data 
Type Range  Description

MaxResults Integer -1 or 1 to n 

For tools that provide multiple sets of 
results, this property can limit the 
maximum number of sets of resu
that are computed and returned.  A 
negative 1 (-1) indic
possible results should be collected

lts 

ates that all 
. 

OffsetAngle Single degrees 
OffsetX Single mm 

OffsetY Single mm 

a tool to a position and orientation that 
is more meaningful to you.  The 
orientation change is in degrees and 
the shift is in calibrated units (mm).  
See the 

These Offset values permit the result
of a vision tool to be shifted and rotated
from their standard location.  This 
allows you to re-position the r

s 
 

esults of 

 
Fixed Frame Tool for an 

alternate method for implementing this
offset. 
If TRUE, indicates that the "Return 
results if not found" Preferences 
property is asserted.  Normally, this 
property is FALSE and only tools that 
are successful will generate results and 

ResultOnNotFound Boolean TRUE / 
FALSE

the
pro

continue processing an object.  This is 
 correct behavior if you only wish to 
cess objects that pass all inspection 

tests.  However, if a tool is referenced 
in an Inspect List, it is important that 
both successful and failed results be 

ctions in 
d are with respect 

if an 

returned so that all of the inspe
the list are aligned an
to the same located object.  So, 
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Inspect List is being utilized, th
Preference property s

is 
hould be set to 

TRUE.  

ResultSelect Integer 1 - n 

For tools that return more than one set 
of results, this property selects the set 
of results that is displayed in the 
Results Properties.   This does not 
affect the actual results of the tool. 

ShowResults List
NONE / 
POINT / 

ision tool 
 method for display, e.g. a 

line or a frame.   This property allows 
the graphical display to be changed.  
For example, a Fixed Frame Tool is 

 

be changed to a line or a point for 
visual clarity.  This property does not 

s of the tool. 

LINE / 
FRAME  

normally displayed as a reference
frame.  However, if it is being used as 
a datum line or a point, its display can 

Alters how the results of a tool is 
graphically displayed.  Each v
has a default

affect the actual result

The Results Properties display a single set of results for the vision tool.  In general, the
results returned varies from tool to tool.  Many tools return a vision referen

 
ce frame.  

However, some tools return additional results items such as statistical information on how 
ll the answer fits the actual data. If the tool computes more than one set of results and 

MaxResults is set to greater than 1, the displayed set of results will correspond to the 
erty.  

we

setting of the ResultSelect prop

6. Results Properties

Property Name Data 
Type Range  Description

ResultCount Integer 0 - n Number of sets of results the vision tool 
has returned. [GPL: Vision.ResultCount]

ResultErrorCode Integer   

Standard error code that indicates if the 
tool executed without an error.  This is 
different from the InspectPassed, 
which indicates if the result was 
computed properly but its value was 
inside or outside of a specified limit.  If 
ResultErrorCode is non-zero, any tool 
that references this tool, for example via 
the RelativeToolName property, will 
also fail with this same error code and 
will not be evaluated. [GPL: 
VisResult.ErrorCode]

ResultAngle Single -360 to 360
ResultXPos Single mm

Orientation (in degrees) and position (in 
calibrated units, mm) of the center of 
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Single mm

the results computed by the vision tool 
in the coordinates of the vision image 
taking into consideration the value of 
the Offset's in the Results Settings 
Properties.  For robot guidance 
applications, these values are 
transformed by the vision-to-robot 
calibration conversion routines and then 
presented as [GPL: VisResult.Loc.X, 

ResultYPos

VisResult.Loc.Y and 
VisResult.Loc.Roll]. 
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Acquisition Tool 
Vision tool that captures an image from a camera or loads it from
stores the image into a frame buffer. 

Prerequisites 

None 

Properties 

 a disk file, and   

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation
Camera Integ rd er 1 - 6 Standa Operation property
GainBlue Single
GainGreen Single

GainRed Single

0-12 (set to -1 if not a color 
camera)  

e pro
values for
layers as they are read from the 
camera.  T
intensities

Thes perties scale the intensity 
 each of the three color 

his permits the color 
 to be balanced. 

3A. Advanced Operation

AcquireBuffer-
Image Boolean True / False  

If True, a c
into a seco
image is a
True if the be 
restored b
tool that h  
"RESTOR
resolution
setting this , if not 
needed, c
of executio t. 

opy of the image is stored 
ndary buffer when the 

cquired. This must be set 
 original image is to 
y a subsequent Acquisition 
as its AcquireMode set to
E_ORIGINAL". For 
s greater than 640x480, 
 value to False

an save a few milliseconds 
n time. Set False by defaul

Acquire-
Extension List

If the cam
 a
d,
ho
se
se rmat 

(PNG). Th
but require . 

BMP / PNG  

saved in
execute
image s
compres
compres

era image is automatically 
 disk file when this tool is 
 this property specifies if the 
uld be saved as a non-
d bitmap (BMP) or as a 
d image in a lossless fo
e PNG file format is smaller, 
s more CPU time to create

AcquireFill- er 0 - 255  If the Acq
"CLEAR_BUFFER", all of the pixels in GrayLevel Integ uireMode is defined as 
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the image  
value spec

 buffer are set to the intensity
ified by this property. 

AcquireMax-
CurrentCount Integer 0 - 99999  

AcquireMax-
SaveImages Integer -1 - 99999  

When the 
ACQUIRE
SAVE_ON

reM
 th
ed

generate t
the image
 
If Acquire e 
next highe  
assigned u aximum value of 
99999.  So t 
be over-w
 
If Acquire 0, 
AcquireM
indicate th
specified b s 
is reached t
is automa its 
the last Ac s 
to be save
and more ace (but existing 
image files In this 
mode of o
AcquireM
manually c
altered by
reset the n
value.  Th
AcquireM t 
stored with
reset to 0 
is loaded. 

AcquireMode is set to 
_AND_SAVE or 
LY, the 
axSaveImagesAcqui

defines
append

 property 
e largest index that is 
 to the AcquirePrefix to 
he name of the file in which 
 is stored.   

MaxSaveImages is -1, th
st unused index values is
p to the m
, existing image files will no

ritten.  

MaxSaveImages is set >
axCurrentCount will 
e next index. When the limit 
y AcquireMaxSaveImage
, AcquireMaxCurrentCoun

tically reset to 0. This perm
quireMaxSaveImages file
d without consuming more 
disk sp
 will be over-written).  

peration, 
axCurrentCount can be 
hanged or automatically 

 a robot control program to 
ext index to a specific 

e value of 
axCurrentCount is no
 the vision project and is 

each time the vision project 

AcquireMode List

NORMAL_ACQUIRE / 
ACQUIRE_AND_SAVE / 

CLEAR_BUF
PLAY_FROM_DISK /  

LIVE_VIDEO / 
SAVE_ONLY / 

RESTORE_ORIGINAL  

"NORMAL UIRE" - acquires a 
single ima
camera an
buffer. 
 
"ACQUIRE
the same 
"NORMAL ves 
the image
 
"CLEAR_B
pixels in a
specified b
This is use
performed. 
 
"PLAY_FR
image from s 

FER / 

_ACQ
ge from the specified 
d places it into a frame 

_AND_SAVE" - performs 
operation as 
_ACQUIRE" and then sa
 to a disk file. 

UFFER" - Sets all of the 
 buffer to the intensity value 
y AcquireFillGrayLevel.  
ful before an AOI copy is 

OM_DISK" - restores an 
 a disk file.  The disk file i
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specified b
AcquireP
are multipl ith 
the same 
Process is  of 
the next s
the image
 
"LIVE_VIDEO" - continuously updates 
the vision display with the latest image 
from the camera. This is a system 

ode that facilitates setting the 
-stop, focus, VideoGain, and 

eoOffset. 

VE_O ents of 
en isk file.  

s a GPL program to 
te a vision process that saves 

selected frame buffers for later access. 
 
"RESTORE_ORIGINAL" - restores the 
contents of the current frame buffer to 
its original value at the time that the 
image was first captured. Requires that 
AcquireBufferImage is set to True 
when the image is first captured.  

y the AcquirePath and 
refix (see below).  If there 
e numbered image files w
prefix, each time the Vision 
 executed, the contents

equential file will be copied to 
 buffer. 

setup m
camera f
Vid
 
"SA
the curr
This enable
execu

NLY" - stores the cont
t frame buffer to a d

AcquirePath String n/a 

String that  
A de is set to 

RE_AND_SAVE" or 
AY_FROM_DISK'".  If blank (""), 

he Preferences will 
be used. If the path does not contain a 
':' (i.e. C:\...), AcquirePath will be 
appended to the path where the 
PreciseVis
e.g. "C:\Pr
Automation\PreciseVision #.#\" 

 defines the path to the disk
cquireMofile when 

"ACQUI
"PL
the path defined in t

ion application is stored, 
ogram Files\Precise 

AcquirePrefix Str n/a 

String that de
(excluding
extension) de is set 
to "'ACQUI or 
"PLAY_FR ), 
the file na
Preferenc his string is 
combined a 
numerical 
extension 
name for s ision 
images. 

ing

fines the disk file name 
 the required .BMP 
 when AcquireMo
RE_AND_SAVE" 
OM_DISK".   If blank (""

me defined in the 
es will be used.  T
with AcquirePath, 
index, and the ".BMP" file 
to generate the disk file 
aving or loading v

ActiveLayer List Monochrome / RedLayer / 
GreenLayer / BlueLayer  

Specifies 
into the im
processing by subsequent vision tools.
 

the type of data to be loaded 
age frame buffer for 
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For grayscale cameras, only 
"Monochrome" image buffers are 
available and each pixel in the fra
buffer has a value 

me 
from 0 to 255 that 

defines its grayscale intensity. 

buffer 
es of 

ochrome, red, green or 
blue.  The monochrome mode 

nd 
or 

s that 
f only 

mera. Tools 
that are applied to this image will only 

r of 
s the 
 this 

 
r 

 
For color cameras, the frame 
can be loaded with one of four typ
data:  mon

produces the same results as a 
grayscale camera. The red, green a
blue modes load the intensity data f
a single color.  For example, if 
"RedLayer" is selected, the image 
frame buffer will contain value
indicate the intensity (response) o
the red receptors of the ca

be operating on the red color laye
the camera.  The one exception i
"Pixel Color Window" Tool.  When
tool is executed, it automatically 
accesses all three of the RGB color 
layers of an image and is unaffected
by the setting of the ActiveLaye
property. 

Ima

e 
e file.  

This value is only displayed when the 
AcquireMode is set to 

geFile String n/a 

Read-only string that displays th
currently selected vision imag

"PLAY_FROM_DISK". 

Loa

or 
 of 

ISK" mode.  That is, 
, the 

th and 
AcquirePrefix and has the lowest 

 

dFirstImage Boolean True / False 

This is a convenience feature f
setting the display of a sequence
images back to the first image and is 
only valid during the 
"PLAY_FROM_D
when this property is set to TRUE
disk file that satisfies AcquirePa

index values will be loaded into the
image buffer. 

3B. Trigger
If TriggerEnable

TriggerActive List Low_to_High / 
High_to_Low   

 is True, this property 
defines if the picture is to be when the 
digital input signal transitions from low 
to high or high to low.  

TriggerEnab
If this property is True, the image 

digital input 
 received le Boolean True / False  capture is delayed until a 

signal of the correct state is
by the camera.  

TriggerTim  is True, this property 
specifies the time in seconds that the eout Integer 1 - 30  If TriggerEnable
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system will wait for the trigger to occur 
before an error is generated (-4019 
Vision Process Failed). 

4A. Dalsa Genie Camera

Exp

Time, in milliseconds, that the camera 
will integrate light on its imaging 
sensor.  The longer the time, the more 
light is collected and the brighter the 

eter 
rdware 

configurations. 

osureTime Single   image.  However, this will also 
lengthen the time required for the 
image acquisition.  This param
may not be supported on all ha

VideoGain Integer 0.5 - 2.0 

VideoOffset Integer -127 - 127 

The VideoGain and VideoOffset 
scale and shift the grayscale value of 
each pixel as it is read in from the 
camera.  This allows a narrow range of 
brightness values to be expanded to 
span the entire 256 grayscale value 
range. 

4B. DirectShow
DsBackLight 
Compensation Integer    

DsBrightness Integer   
DsColorEnable Integer    
DsContrast Integer   
DsExposure Integer   
DsGain Integer   
DsGamma Integer   
DsHue Integer   
DsPixelClock Integer   
DsSaturation Integer    
DsSharpness Integer   

DsWhiteBalance Integer    

These properties change the operation 
of a DirectShow (USB) camera.  The 
properties that a camera supports and 
the range of values for each property 
will vary from one camera model to the 
next.  When a camera is attached by 
PreciseVision, its supported properties, 
the range of allowed values and the 
default values are automatically 
sampled. 
 
The range for each supported property 
is displayed by the "Adjust Video 
Properties" Special Features Pop-up. 
 
Special attention should be paid to the 
DSExposure and DSPixelClock 
properties since these affect the time it 
takes to acquire an image.  
 
Please see the documentation 
provided with the camera for specific 
information on the setup of its 
supported properties.  

Remarks 

This tool performs the basic image capture operation from a color or monochrome 
camera and stores the image in a frame buffer.  Consequently, this tool is normally the 
first tool in each Vision Process.  
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Multiple cameras can be accessed by this tool and their gains and offsets can be 
controlled to optimize the brightness range for the field of view.  To facilitate setting up a 
camera's gain, offset, focus, and f-stop, the camera image can also be continuously 
acquired and displayed in the Camera Display Window. 

cuted, a camera image is immediately captured. However, 
if TriggerEnable is True, executing this tool primes an image capture, but the picture is 
not immediately taken. The image capture is delayed until a digital signal, which is 
directly connected to the camera, is asserted. For applications where the timing of the 

significantly 
ess is manually 

ns an Acquisition that has 
triggering enabled, a pop-up is display to confirm if the camera should wait for an external 
trigger or if the picture should be taken immediately.  This pop-up is not displayed if the 
Vision Process is remotely initiated from a Guidance Controller.  

gering is not supported on all cameras. Please consult your camera's 
are documentation for specific information on whether it supports external 

nd how this is implemented. For example, with Dalsa cameras, hardware 
signal #1 is a sinking input that must be pulled low to the camera's ground to trigger a 

e capture.  

Most vision tools analy  data that is stored in a frame buffer by an Acquisition tool, 
, and l e frame modified. However, rocess" 

tool is executed (e.g. a low pass filter), the data stored in the frame buffer is altered so 
 subsequent tools operate on the modified image data. In these cases, it is 

metimes convenien ore the or l contents of the frame buffer. This can be 
ne by executing an tion Tool he Acq
ESTORE_ORIGINA  operatio tores the original image data from an in-

 and is therefore much faster than storing an image to a file and then 
oading. In order for de ly, the original Acquisition tool must 
ve its AcquireBuff  pr . When this property is true, a copy of 
 camera image is g d in the

s both a demonstrat re a  re
n be used to easily ptur  dis
e disk.  To store ima  Ac st 

_ONLY".  To lo  the mode st be se
des, the disk file n is y co rePath with the 

irePrefix and an l nu llowed by the .BMP file extension.  
 time that an Acq  To RE_AND_SAVE" or 

NLY" set, the system automatically increments the numerical index to create a 
ewise, each time that the Acquisition is executed with 

Y_FROM_DISK", the system auto ally sea ith 
umeric ex.  This a atic inde to be 

rated o d. 

Sp ttons (loca  the pro ditor) 

Adjust Video Properties 

sing this plays a pop-up wind
values for the monochrome image (VideoGain, VideoOffset, 
ExposureTime) and the color image (GainRed, GainGreen, GainBlue) 

Normally, when this tool is exe

image capture relative to an external event is critical, trigger mode can 
reduce latency and jitter. As a debugging convenience, if a Vision Proc
executed using the PreciseVision GUI and the process contai

Camera trig
hardw
triggering a

fram

ze the
eave thgenerate results  buffer un  if an "Image P

that all
so
do

t to rest
 Acquisi

igina
with t uireMode set to 

"R L". This n res
memory buffer,
rel
ha

 this mo
erImage

to operate proper
operty set to True

the enerate memory when  acquisition is performed.  

motely diagnosing problems, this tool 
k file and to reload images stored to 

be set to "ACQUIRE_AND_SAVE" or 
t to "PLAY_FROM_DISK".  For any of 
mbining the 

A
ca

ion featu
store ca

nd as an aid in
ed images to a

th ges, the quireMode mu
"SAVE ad files,  mu
these mo ame 

 optiona
constructed b

merical index fo
Acqui

Acqu
Each uisition ol is executed with "ACQUI
"SAVE_O
new disk file.  Lik
"PLA matic rches the file folder for the file w

xing allows a series of images the next larger n
conveniently gene

al ind
r replaye

utom

ecial Feature Bu ted above perty e

Pres button dis ow that permits the property 
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to be manually adjusted while dynamically v
settings.  In addition, histograms of the vario
simultaneously displayed.  

iewing the effect of the new 
us values can be 

 

Select Acquire Path  

ing this pl d
e the P ucture to select t  A

where image disk files are to be stored and 

Exa

ireMode A ,
rojects", a u  

the PreciseVision application contains a folder "Exa
files: 

part2_ mp, part2_0002.bm

 that the Acquisition Tool is executed, it will load the next successive 
ve a start unters the end of the list. 

Se

Vis

Press
brows

 button dis
C's file str

ays a pop-up win
he

ow that permits you to 
cquirePath that specifies 

retrieved. 

mples 

If the Acqu is set to "PL Y_FROM_DISK"  and the AcquirePath is set to 
"part2", and the folder that contains 
mpleProjects" that has the following 

p, part2_0003.bmp 

"ExampleP nd the Acq irePrefix is set to

0001.b

Then, each time
 list abofile in the nd will re when it enco

e Also 

ion Toolkit | Sensor Windo ol w To
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Arc Fitter Tool 

l that search ecif  e
e circle or ar est fits th es. 

Vision too es a sp ied region for arc dge points and 
returns th c that b e edg

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelY

e Standard Placement / Siz
properties.  The X and Y 
values define the center of 
the tool and the center of 
the search region. 

Pos Single 0 - AOI (mm) 

Rad

inal radius 
of the arc or circle to be 

the 
mid-range value for the 
radius search. 

Specifies the nom

ius Single mm located.  This defines 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation 
properties

AngularSiz

Specifies the angular size in 
 
 

indicates that a complete 
circle is to be located.  

0 specify 

e Integer 0-360 

degrees of the arc to be
located.   A value of 360

Values less than 36
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that a partial circle (arc) 
be located. 

is to 

DarkOutside Boolean True / False 

s 
outside of the arc or circle 
are darker than the interior 
pixels.  For example, to 
locate a circle with light 
interior pixels surrounded by 
darker pixels, this parameter 

rue. 

Defines whether the pixel

must be set to T

EdgeThresh

threshold 
weak (low 

es are 
wer this 
he more 

sensitive the system is in 
locating edges.  Please see 
the description of the Edge 

old Integer 0 - 254 

Specifies the 
below which 
contrast) gradient edg
ignored.  The lo
property is set, t

Locator for more information 
radients.  The 
lue is 30. 

on edge g
default va

FindWhat ARC_FIND_RADIUS / 
FITARC_FIND_BOTH 

dius should 
ly the center 
 to find the 

best match or if the center is 
to be fixed and the radius 
varied or if both should be 

List
FITARC_FIND_CENTER / 
FIT

Defines if the ra
be fixed and on
of the arc varied

varied. 

SearchRadiusRange Single mm

efines the 
 point and 
ns.  The 

s centered 
Pos and 

ius values.  So, if the 
 is set to a 

d the 
ge is set 

 can vary 
/2 to N+M/2 and 

t can vary by 

 

about the 

This property d
limits of the center
radius search regio
search region i

XPos, Y
Rad
Radius property
value of N an
SearchRadiusRan
to M, the radius
from N-M
the center poin
M in X and Y. 

UseWhichEdge List
FITARC_MIDD
FITARC_INNE
FITARC_OUTE
FITARC_MAX_

 within 
ion, this 

s which 
e returned.  The 

 the one 
 nominal 

radius, the arc closest to the 
m 
 arc that 

ntrast 
ts). 

LE_EDGES / 
R_EDGES / 
R_EDGES / 

GRADIENTS 

If multiple arcs exist
the search reg
parameter specifie
arc should b
selected arc can be
that is closest to the

minimum or maximu
search radius or the
has the greatest co
(maximum gradien

3A. Advanced Operation
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DrawEd List
..._ E
..._A E
..._USED_EDG

ow dots to 
 points 

ted after the 
EdgeMode is applied or 

 that are 
r the 
d and 

 
ry helpful for 

 effect of 
s property 

 is 
TS by 

gePoints
NO_EDG
LL_EDG

_POINTS / 
_POINTS / 
E_POINTS 

only those edges
USED to fit arcs afte
EdgeMode is applie
all outliers are eliminated. 
This is ve

If set, draws yell
indicate ALL edge
that are selec

understanding the
changing variou
settings. This value
NO_EDGE_POIN
default.  

MaxEdgePoints Integer 3 - n

 of edge 
perform.   

duce 
he 

ution 
m value 
 3 and 

ically 
mber of 

idth of 
ult value 

 speed.  The minimu
of this parameter is
this value is automat
limited to the nu
pixels across the w
the tool.  The defa
is 30. 

Maximum number
point searches to 
Higher numbers pro
greater accuracy at t
expense of exec

MaxIterations Integer 0 - n

Maximum number of 
ing.  The 

eatedly 
removes outlier points, 

rc each time, 
oints need to 

 
 of 

occurred.  A 
value of zero disables 

ult value 

 

refitting the a
until no more p
be removed or the
maximum number
iterations have 

iterations for filter
filtering algorithm rep

filtering.  The defa
is 5. 

MinFilte Sing .

lter 
  No edge 

 the fitted arc 
 this are discarded 

ve process.  
 is 
 
f 

ted arc 
 pixel with 

a good image of a clean 
edge.  The default value is 
1.5. 

rDistance le 0 - n nn 

during the iterati
A minimum distance
needed because the
standard deviation o
distances to the fit
can be less than a

Absolute minimum fi
distance in pixels.
points closer to
than

Sigm his aFilter Single 0 - n.nn 
Filter width in units of 
standard deviations.  T
value is multiplied by the 
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standard deviation of the 
edge points’ distances to the 
fitted arc to compute the 
distance threshold beyond 
which edge points are 
removed during the iterative 
fitting process.  The default 
value is 2.5. 

4. Inspection Settings
InspectActual Single  

InspectLabel List
NONE / PASS_AND_FAIL / 

PASS / FAIL / VALUE_REAL / 
VALUE_INTEGER 

InspectType List
NONE / ..._RMS / 

..._RADIUS / 
..._NUM_EDGES_FOUND / 

...NUM_EDGES_USED 
InspectMax Single   
InspectMin Single   
InspectPassed List Pass / Fail

Standard Inspection 
Settings properties

5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings 
properties

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultNum-
EdgesFound Integer   

Number of edge points 
found. [GPL: 
VisResult.Info(1)]

ResultNum-
EdgesUsed Integer   

Number of edge points 
remaining after the filtering 
process. [GPL: 
VisResult.Info(2)]

ResultRadiusFound Single   
Radius of the located arc in 
mm.  [GPL: 
VisResult.Info(4)]

ResultRMS Single   Root mean square of the arc 
fit. [GPL: VisResult.Info(0)]

Remarks 
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The Arc Fitter searches the region defined by its green and blue outlined arc for edge 
points and fits an arc to the edge points using a least squares technique.  By computing 
the edge positions to a sub-pixel accuracy and by employing multiple such edges in its 
computation, this tool is able to generate very accurate sub-pixel results. 

ful for accurately locating holes or curved edges of objects or 
fiducials.  Once found, these fit arcs can be used to compute center points between 

ate an object 

In order to make this tool more discriminating, the Arc Fitter only utilizes edges whose 
nd light sides have roughly the same orientation as the dark (blue) and light (green) 

sides of the search area.  So, when positioning this tool, you should place the center 
al) arc of the search region at approximately the position and orientation that you 

 the arc with the blue side on the anticipated dark side of the object. To aid 
is operation, there is an 'Auto Size / Position' feature button above the property 
or. This button will analyze the coarse position of the tool and snap it to the nearest 

arc/circle. The radius search range is automatically adjusted as well. 

sically pe med in two steps.  First ges are 
ed in the search region.  Secondly, an arc is fit to the edges.  Of the two 
ions, the tool spends most of its time extracting the edges.  So, the speed and the 

curacy of the A  can be tra ff by adj s property 
etermines how d he tool sca o detect e et to at 

 to he minimum umber of edges to define an arc.  At most, one 
performed for each pixel along the width of the Fitter.  Execution time 

reases roughly ortion to the value of MaxEdgePoints.  On the other hand, the 
uracy of the to ases  as the square root of MaxEdgePoints.  
t is, if you incr axEdg factor of 4, the tool execution time will 

adruple but the  will

nce the edges are found, the ptio
 increase the ro s of th ing e

t from the a rs) are This filters out edges that are not a part of 
rc and whos on wo offset the result.  MaxIterations specifies 

 numbe rc fit, edges that are beyond 
aFilter stan iation  unless the edge is within 

Distance pixels of the fit arc.  The iterative process stops if (1) MaxIterations 
erformed, (2 er edges scarded, or (3) only two edge points remain. 

 o  tool, the cen ion and radius of the best fit arc is returned 
along with statistical data on the number of edges
of the arc fit, which indicates the quality of the fina
via the "Inspect Settings" to yield a pass/fail indica

Special Feature Buttons (located above the property edito

Adjust Edge Threshold

ssing on displays a pop-up win
the Edge Threshold property to be manually adjusted while dynamically 
viewing the effect of the new setting in the Camera Display.  The display 
indicates the edges that satisfy the threshold criterion in white. 

This tool is very use

important features, for generating reference frames that can accurately loc
or features in an object or for measuring the diameters of holes. 

dark a

(nomin
expect to find
in th
edit

The operation of this tool is ba rfor , all of the ed
extract
operat
ac rc Fitter ded-o usting MaxEdgePoints.   Thi

dges.  This parameter must be sd
le

ensely t
 detect t

ns t
 nast 3 in order

edge search is 
inc  in prop
acc
Tha

ols incre
ease 

 approximately
ePoints by a M

qu  accuracy  only double. 

O
to

Arc Fitter will o
e results.  Dur

nally perform an iterative fitting process 
ach pass, edge points that are too bustnes

distan rc (outlie  discarded.  
the a e inclusi uld incorrectly 
the maximum r of fits to perfo

dard dev
rm.  After each a

s are rejected,Sigm
MinFilter
are p ) no furth  are di

At the conclusion f this ter posit
 finally used and the root mean square 
l fit.  This statistical data can be tested 
tion for the operation. 

r) 

Pre this butt dow that permits the value of 
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Auto Size / Position 

rovides a y way ool. This button will compute the 
currently found arc/cir ally snap the tool to the exact 
coordinates of the fo us search range is 
adjusted proportionally to the arc/circle size. 

Exa

llowing ex an Arc Fitte  utilized to accurately determine the position of a 
n object. The best fi e hole is computed and the resultant is 

 ac e range of values to generate a pass/fail inspection result. 

P n eas to position the t
cle and automatic

und arc/circle. In addition the radi

mples 

In the fo ample, r is
hole within a t radius of th
compared to the ceptabl

 

See Also 

olkiVision To t | Edge Locator | Line Fitter
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Barc

Vision tool that reads a variety of standard 1-D and 2-D barcodes and 
returns the barcode type and the value of the barcode. 

ode Reader Tool 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single 0 (non-rotating) 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single 0 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size properties.  
The X and Y values define the center of 
the region to be analyzed.  The Height 
and Width define the dimensions of the 
region.  The AOI cannot be rotated, but 
rotated barcodes can be identified (see 
SkewTolerance). 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

ProcessLevel Integer  0 - 5  

Controls the speed with which regions 
are processed verses accuracy.  A lower 
value will process images more quickly 
but will result in a lower successful read-
rate.  The default value is 2. 

SkewLineJump Integer  1 - 9  In order to recognize barcodes that are 
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SkewTolerance Integer 0 - 5 

not aligned along the horizontal or vertical 
axes of the camera, the SkewTolerance 
and SkewLineJump must be adjusted.  
The approximate permitted angular 
deviations of a barcode from a horizontal 
or vertical orientation for various settings 
of the  are as follows: 

es 
  "   "  13   " 

   2 -  "   "  21    " 
   3 -  "   "  29   " 
   4 -  "   "  37   " 
   5 -  "   "  45   " 
 
The SkewLineJump determines how 
many lines are skipped during the portion 
of the scanning process that is 
specifically for locating skewed 

odes.  1 means that every line in the 
region is tested.  Lower values for this 
parameter will increase the processing 

e but may b
s. 

If the barcode is aligned along the X or Y 
e SkewTolerance should be set 
 the Ske  

 to mini ng 

SkewTolerance
 
   0 - up to 5 degre
   1 -

barc

tim e useful for poor quality 
image
 

axes, th
to 0 and wLineJump should be

mize the tool's processiset to 9
time. 

3A. Advanced Operation

AllowDuplicates Boolean  TRUE / FA

code is ame 
e maybe

age.  I  
te resul a 
ime.  If TRUE, the same value can 
rned multiple times in the same 

image. 

LSE  duplica

If a bar badly damaged, the s
 reported twice within the 

f this parameter is FALSE,
ts are only reported 

barcod
same im

single t
be retu

Bottom_To_Top Bool RUE / FALSEean  T   
Left_To_Right Boolea TRUE / FALSE  n  
Right_To_Left Boolean  TRUE / FALSE  

Top_To_Bottom Boolean  TRUE / FALSE  

ese parame ons 
 which the so can looking for 

es.  If the barco r 
in the same ori
unneeded scan

ecution time
SkewToleranc
barcodes that a
or horizontally. 

Th ters specify the directi
ftware will sin

barcod des always appea
entation, turning off the 
ning directions will reduce 

.  Also, see 
e for the ability to identify 
re not oriented vertically 

ex

5. Results Settings
MaxResults Integer -1 or 1 to n 
ResultOnNotFound Bool RUE / FALSEean T

ShowResults List NONE / FRAME /
LINE / POINT 

Standard Results Settings properties
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ShowResultType Boolean TRUE / FALSE 

ShowResultValue Boolean TRUE / FALSE 

esult
identified barco isplayed 
on top of the ba
window.  In add  
is TRUE, the d ype 
of the barcode 

If ShowR Value is TRUE, the 
de value will be d
rcode in the camera 
ition, if ShowResultType

isplay will include the t
that was found. 

6. Results
ResultErrorCode Integer   
ResultAngle Single 0 (non-rotating)
ResultXPos Single mm

Sing mm

Standard Results properties 
n represent the centroid o

ResultYPos le

X and Y positio f 
the located barcode. 

ResultCode String    The type of the
[GPL: VisResu

 barcode, e.g. UPCA.  
lt.InfoString]

ResultCodeDirection Integer    

Indicates the s
locate the barc

canning direction used to 
ode  [GPL: 

VisResult.Info(1)] 

ht 
 
   1 - Left to rig
   2 - Bottom to top 
   4 - Right to le
   8 - Bottom to

ft 
 top 

ResultCodeValue String    The value of the barcode.  [GPL: 
VisResult.InfoString]

Remarks 

This tool reads a variety of popular types of 1-D and 2-D barcodes.
barcode can be located within a single AOI and the barcodes can b
(although searching for multiple types of barcodes increases executi
of the barcode as well as its type are returned by this tool and can o
in the camera window on top of the identified barcode. 

This tool can locate barcodes that are oriented in any direction (alth
ximately horizon tical are processed most quickly

operate on grayscale or color images, with grayscale images being
rapidly and more reliably due to the single image plane and higher q

In order to reliably detect barcodes and to determine their correct v

 a general rule-o , the thinnest ba d be at le
Likewise, the smallest gap between ba be at least

de is not ho ntal or v ewed), the minimum bar 
d gap width shou  inc  diagonal lines look 

like stair steps and alternately are
• Even if the barcode's position is w ace should be included in 

the AOI around the barcode so th detect the start and end of 
e bars or squares

e Reader Tool nd can correctly 
even when the ba at any orientatio or the image is somewhat degraded 

  More than one 
e of different types 
on time).  The value 
ptionally be displayed 

ough barcodes that 
).  This tool will 
 processed more 
uality edges. 

alues, the following 

are appro tal or ver

should be kept in mind: 

• As f-thumb r shoul ast 3 pixels wide.  
 3 pixels wide. rs should 

ertical but is tilted (sk
reased to at least 5 pixels since

 thick and thin.  

• If a barco
an

rizo
ld be

ell known, white sp
at the software can 

number of different codes a

th .  

The Barcod
operate 

can detect a 
rcode is n 
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or the barcode is slightly defective.  However, the e n speed of this tool can be 
cing the gene ch as reducing the size of 

e searched, dis  unneeded b s, reducing the skew tolerance, 

Special F (located a perty editor) 

ct Codes 

Pressing this button displays a po n res
of barcodes that are detecte

eded types will reduce
variations of the following typ

xecutio
optimized by redu
the AOI to b

rality of the pro
abling

perty settings, su
arcode type

etc. 

eature Buttons bove the pro

Sele

p-up window that ca
d during the scanning process. 

 the execution time of the tool.  C
es of 1-D and 2-D barcodes c

trict the types 
 Disabling 
urrently, 

an be 
unne

detected:  Code 39, Co 3de 9 , Code 128, Code 25 (interleaved and non-
interleaved), Cod -8, EAN C-E, PDabar, EAN -13, UPC-A, UP F-417, Data 
Matrix, Databar, and Patch Codes. 

s 

Pressing this button displays a pop-up window that presents more 
dvanced propert  barcode tool  default valu

lly acceptab nience, this pop-up also co
ates for some of the common properties that are contained on the 

tandard Property Display.  The follow es the ope
e Advanced 

Advanced Setting

a ies of the  whose es are 
ntains 

ration of the 

norma
duplic

le.  For conve

s ing describ
uniqu Settings.  

Property Name Data 
Type Range  Description

Convert UPC-E to 
EAN-13 Boolean TRUE / 

FALSE 

If TRUE, UPC-E b
automatically conv

s FALSE

arcodes are 
erted into EAN-
 by default.  13. This i

GammaCorrection Integer 1 - n  

 value is not 
Correction equal t
GammaCorrectio
applied to adjust t
illumination of the
this value is 100, w
don't apply a corre

If this 100, a Gamma 
o 
n/100 will be 

he overall 
 AOI. By default, 

hich means 
ction. 

Line Jump Integer 1 - 9 

roperty dete
re ski

initial scan for a b
that every line in t
tested.  Lower val
parameter will inc
processing time b
for poor quality im
is 1 by default.  

This p
many lines a

rmines how 
pped during the 
arcode.  1 means 
he region is 
ues for this 
rease the 
ut may be useful 
ages.  This value 

Median Filter Boolean TRUE / 
FALSE 

If TRUE a median
th AOI before sc
barcode.  This can
flaws in high resol
should not be app

 filter is applied to 
anning for the 
 eliminate small 

ution images.  It 
lied to low 

e 
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resolution images
blur the transitions
and gaps.  This is
default.  

 since this will 
 between bars 

 FALSE by 

Max Length Integer 1 - 999

Specifies the large
rs in the b ing 

any checksum cha
999 by default.  

  characte
st number of 
arcode includ
racters.  Set to 

Min Length Integer 1 - 999  
Defines the minim
number of charac
barcode value.  S

um acceptable 
ters in a valid 
et to 4 by default 

Min Space Width Integer 0 - n 

es the minim
 of spaces be

Spaces that are s
size are ignored.  
value is 0, which i
system will autom
the minimum acce

Defin
width

um acceptable 
tween bars.  

maller than this 
By default, this 
mplies that the 
atically determine 
ptable width. 

Noise Reduction Integer 0 - n 

r than 0, the AOI is filtered 
eing scan

marks that are unlikely to be part of 
the barcode.  Larg
reduce larger mar
helpful in poor qua
typical value is 10

t to 0.  

If greate
before b ned to eliminate 

er values will 
ks.  This can be 
lity images.  A 

.  By default, this 
is se

Numeric Barcode Boolean TRUE / 
FALSE 

If TRUE, only num
are identified. By 
is FALSE.  

eric barcodes 
default, this value 

Quite Zone Integer 0 - n  

When a line in the
scanned, regions 
preceded by this n

e ignored
default.  

 image is 
that are not 
umber of white 

pixels ar .  Set to 0 by 

Show Check 
Digits Boolean TRUE / 

FALSE 

If TRUE, the barco
will be included in
value. This prope
barcode types wit
digits, such as Co
FALSE by default

de check digit 
 the barcode 
rty only applies to 
h built-in check 
de 128.  Set 
.  

Use 
Oversampling Boolean TRUE / 

FALSE 

UE, 3 sequen
time are scanned 
pixel value is used
barcode.  This is u
that contain both w
speckles.  Set FA

If TR tial lines at a 
and their average 
 to determine the 
seful for images 
hite and black 

LSE by default.  

Examples 

The following two examples demonstrate the Barcode Reader Tool identifying the same 
character pattern presented as both a 1-D Code 39 and a 2-D Data Matrix pattern.  In 
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each picture, the darker blue boxes display the barcode type and va
this tool.  

lue as determined by 

 

 

o See Als

Vision Toolkit
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Clear Grip Tool 

Vision tool that verifies that there is no obstruction within the bounds of a 
defined window. This tool is typically used to confirm that gripping a part 
will not result in a collision. 

Prerequ

Properties 

isites 

None 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPo e 0 - AOI (mm) s Singl
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos

andard Placement / Size properties.St   The 
e the center of the 

verification window.  The Height and Width 
define the dimensions of the window. 

X and Y values defin

Single 0 - AOI (mm) 
3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

EdgeThresh

Specifies the threshold below which weak 
re ignored.  

ore sensitive 
s.  Please see 

the description of the Edge Locator
old Integer 0 - 254 

(low contrast) gradients edges a
The smaller the number, the m
the system is in locating edge

 for 
more information on edge gradients.  The 
default value is 30. 

4. Inspection Settings
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InspectActual Single  

InspectLabe

VALUE_INTEGER 

l List

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

InspectType List NONE / 
EDGE_COUNT 

InspectMax Single   
InspectMin Single   
Insp

Standard Inspection Settings properties

ectPassed List Pass / Fail
5. Results Settings

ShowResults List NONE / FRAME / 
LINE / POINT Standard Results Settings properties

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultEdgeCount Integer   Number of edge pixels found. [GPL: 
VisResult.Info(0)]  

ResultTotalArea Integer   Total number of pixels in the tested 
rectangular region. [GPL: VisResult.Info(1)] 

Remarks 

This tool specifies a rectangular region of an image and tests it to ensure that it is free of 
obstacles.  This tool is typically used to verify that the fingers of a robot's gripper can 
reach in and pick up a part without hitting another part.  This visual tool verifies that the 
region is clear by extracting edges within the region and counting he number of edge 
pixels.  If an excessive number of edge pixels exist, this indicates that a part or 

ype to 
EdgeCount, if the number of edges falls outside of the InspectMax and InspectMin 
limits, this tool will signal a failure. 

re Buttons (located above the property editor) 

reshold

Pressing this button displays a pop-up window that permits the value of 
the Edge Threshold property to be manually adjusted while dynamically 
viewing the effect of the new setting in the Camera Display.  The display 
indicates the edges that satisfy the threshold criterion in white.  

 t

obstruction is in the region. 

The Clear Grip region is normally defined relative to another vision tool, e.g. a Finder, 
that is used to locate the part.  In fact, it is common for two or more clearance regions to 
be defined for a part, one for each of the gripper's fingers.  When the Clear Grip tool is 
processed, all of the pixels within the region whose gray-scale gradient value exceeds 
the Edge Threshold are counted as edge pixels.  By setting the InspectT

Special Featu

Adjust Edge Th
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Examples 

In the following example, the Clear Grip tool is used to test if randomly oriented and 
positioned parts can be safely grasped.  As each part is located by a Finder, two Clear 

e on each side of the part.  If the grip zone does not contain a 
e zone is marked as passed.  However, in the sample picture, 

one zone in the center of the image is partially occluded by another part and that zone is 
marked as failed.  This would prevent the robot from attempting to pick up the part in the 

Grips tools are tested, on
portion of another part, th

center and potentially damaging the adjacent part or the gripper. 

 

See Also 

Vision Toolkit | Finder Tool
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Connectivity (Blob) Tool 

Vision tool that searches a specified region for binary bl
the centroid and other features of each blob. In addition, this tool can 
return data that defines the perimeter of a located blob. 

obs and returns 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity 
properties

2. Placement/Size
Angle Si tatingle 0 (non-ro ng) 
Height Si  (mmngle 0 - AOI ) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single 0 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm

 

) 

Standard Placement /
Size properties.  The X 
and Y values define the 
center of the tool and the 
center of the search 
region.  The Height and 
Width specify the size of 
the search region. 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation 
properties

MaxArea Integer 0 - n valid blob can contain.  
Any blob that consists of a 
greater number of pixels 
will be ignored. 

Specifies the maximum 
number of pixels that a 

MinArea Integer 0 - n 
Specifies the minimum 
number of pixels that a 
valid blob must contain.  
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Any blob that consists of a
smaller numbe

 
r of pixels 

will be ignored. 

ObjectColor Lis OBJECT / 
_OBJECT 

After the image area is 
converted to binary, 
defines whether 
connected groups of black 
or white pixels should be 
considered as blobs. 

t DARK_
LIGHT

Threshold Integer 0 - 254 

Specifies the threshold 
below which gray-scale 
pixels will be set to black 
and above which pixels 
will be set to white. 
 
When this tool is created, 
the system will 
automatically set this 
property to a reasonable 
value for the full vision 
window.  This value can 

described below. 

also be updated using the 
special feature button 

3A. Advanced Operation

MinHoleArea Integer 0 - n 

Minimum number of pixels 
required before a hole in a 

t to 1 (default), all holes 
are included in blobs 

blob is retained and not 
filled in.  If this property is 
se

regardless of their size.  If 
this value is set to the total 
area of the image, holes 
will always be deleted. 

SampleRate In  r 

turned. 

teger 0 - n

When the tool is set to 
return PERIMETER 
information, this properly 
specifies how many pixels 
to skip along the perimete
between each returned 
"result" position.  A value 
of '0' will not skip any 
pixels and every perimeter 
point is re

4. Inspection Settings
InspectActual Single  

InspectLabel List
NONE / 

PASS_AND_F
PASS / FAIL / VALU

VALUE_INTE

AIL / 
E_REAL / 

GER 

Standard Inspection 
Settings properties
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InspectType List
NONE / ..._R

..._ANGLE / 
..._NUM_EDGES_FOUND /

UM_EDGES_USED 

MS / 

..._N
InspectMax Single   
InspectMin Single   
InspectPassed List Pass / Fail

 

5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 

Res
ETER 

ultMode List
BLOB_CENTER / 

MIN_RADIUS / MAX_RADIUS 
/ MAJOR_AXIS / 

MINOR_AXIS / PERIM
Res Boolean TRUE / FALSEultOnNotFound

Sho

Standard Results Settings 
properties.  
 

 the 

o find 
 tool is 

, this 
property is set to -1, find 
all possible blobs or 
perimeter points. 
 

MaxResults defines
number of blobs or 
perimeter points t
each time this
executed. By default

See below for a 
description of 
ResultMode. 

wResults List NONE / FRAME / LINE / 
POINT 

6. Results
ResultCount Integer  0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm

Res

Standard Results 
properties 

n 
ER mode, this is 

sum of all perimeter points 
found for all blobs. 

 
ResultCount indicates 
the number of blobs 
located in non-
PERIMETER mode.  I
PERIMETultYPos Single mm

Res
Total area of the blob in 

oles 
L: ultBlobArea Integer pixels pixels excluding any h

within the blob. [GP
VisResult.Info(3)]

ResultNumPerBlobs Integer 0 - n 

de, 
this is the total number of 
blobs located and 
ResultCount indicates 
the sum of all perimeter 
points available.  For non-
PERIMETER mode, this 
value is undefined and 
ResultCount indicates 
the total number of blobs 
located. [GPL: 

For PERIMETER mo

VisResult.Info(2)]
ResultObjectIdx Integer   Each blob in a region is 
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assigned an index.  In 
PERIMETER mode, each 
returned VisResult 
represents a single 
perimeter point.  If multiple 
blobs are located, this 
property can be monitored 
to determine when the 
perimeter points pertain to 
the next blob. [GPL: 
VisResult.Info(0)]

ResultMajorAxisAngle Single -360 to 360

ResultMajorAxisLength Single mm

Angle [GPL: 
VisResult.Info(8)] and 
Length [GPL: 
VisResult.Info(9)] of the 
major axis of the best fit 
ellipse for the blob.  This 
axis provides  means for 
characterizing the 

itrary 
sly 
s. By 

definition, this ellipse has 
the same 2nd moments of 

a

orientation of an arb
shape unambiguou
within +-90 degree

inertia as the blob. 
Res Single -360 to 360ultMinorAxisAngle

ResultMinorAxisLength Single mm

Angle [GPL: 
VisResult.Info(10)] and 
Length [GPL: 
VisResult.Info(11)] of the 

st fit 
is 

axis provides a means for 
characterizing the 
orientation of an arbitrary 
shape unambiguously 

 
s 
 of 

minor axis of the be
ellipse for the blob.  Th

within +-90 degrees. By
definition, this ellipse ha
the same 2nd moments
inertia as the blob. 

ResultMaxRadiusAngle Single -360 to 360 Angle [GPL: 
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VisResult.Info(6)] and 
Length [GPL: 
VisResult.Info(7)] of the 
maximum radius for the 

b 
 

the perimeter that is 
furthest from the centroid.  

 for 
 

orientation of an arbitrary 
shape.  However, the 
uniqueness of this radial 
line is a function of the 
shape. 

blob.  This radius is 
measured from the blo
centroid to the point on

Res mmultMaxRadiusLength Single
This provides a means
characterizing the

ResultMinRadiusAngle Single -360 to 360

ResultMinRadiusLength Single mm

Angle [GPL: 
VisResult.Info(4)] and 
Length [GPL: 
VisResult.Info(5)] of the 

ius for the 
dius is 
m the blob 

centroid to the point on 
the perimeter that is 
closest to the centroid.  

s a means for 
ng the 

an arbitrary 
ver, the 

eness of this radial 
nction of the 

shape. 

minimum rad
blob.  This ra
measured fro

This provide
characterizi
orientation of 
shape.  Howe
uniqu
line is a fu

Remarks 

The Connectivity tool converts the region defined by its green outlined rectangle to a 
binary im olor into 
blobs.  A interior blobs 
(i.e. blob ir centroid 
and oth

This too  that multiple objects can be identified and 
located.  However, this is a less discriminating and less powerful tool than the Finder, but 
it is nonetheless very useful.  In particular, Connectivity should be used for locating 
objects that do not have a fixed boundary and in applications that have high contrast with 
visually simple images.  Parts that vary in size and shape are easily located using this 
tool.  In addition, this tool has the ability to return the perimeter of any blob as a series of 
individual results points. This perimeter retrieval feature allows an application to easily 
trace an object, which is useful in the textile or automated cutting industries. 

If the vision system must differentiate between objects that differ by subtle features, 
locate objects that touch other objects, locate objects that are not clearly differentiated 

age and groups adjacent ("connected") pixels with the correct ObjectC
ny blobs that do not satisfy the specified size limits as well as any 
s within blobs) are not returned.  For all valid blobs, the position of the

er key features are computed and returned as the results of this tool. 

l is similar to the Finder Tool in
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from the background, or operate when thresholding may not be appropriate or robust, the 
Finder Tool should be utilized in place of Connectivity. 

With regard to the performance of the Connectivity tool, even though this tool operates on 
binary images, the X & Y position of the centroid of blobs is normally accurate to within a 
fraction of a pixel.  This is due to the fact that the centroid is computed by taking into 
consideration the positions of all of the perimeter pixels.  In general, the larger the blob, 
the more accurate the centroid position.  Consequently, the centroid position is a very 
good measure of where the blob is located. 

In addition to the blob centroid, each blob has several other features computed as 
indicated in the following drawing. 

 

These additional features can be used to determine the orientation of the blob.  
Depending upon the exact shape of the objec of these features will be more 

eful than others.  For example, if the blob is a rectangle, all four corners will be at the 
me maximum radius from the centroid, so the ResultMaxRadiusAngle can return any 

 many cases, the orientation of the major 
ngle) can provide a very good orientation 

estimation.  But, it should be kept in mind that this parameter always has a 180 degree 
ambiguity due to the symmetry of an ellipse. 

The ResultMode property selects which of the properties is utilized to compute the 
orientation of each blob or if the orientation is to be fixed (BLOB_CENTER). 

If the ResultMode property is set to PERIMETER, this tool returns a series of results, 
one for each desired point on the perimeter of each located blob.  Each VisResult 
contains the X & Y position of a point on the perimeter with the orientation angle set to be 
perpendicular to the perimeter of the blob.  In this mode, the SampleRate specifies if 
some pixels on the perimeter are to be skipped.  For example, if the SampleRate is set 
to 3 and two blobs are located, the coordinates of every 3rd pixel on the perimeter of the 
first blob will be returned in the VisResult and ResultObjectIdx will be set to 1.  After the 
last perimeter position of the first blob is transmitted, every 3rd pixel of the perimeter of 
the second blob will be returned with the ResultObjectIdx set to a value of 2. 

Special Feature Buttons (located above the property editor) 

Automatic Threshold

The Connectivity tool operates on a thresholded binary image. This 
requires a specific gray level to be entered in the Threshold property to 
define which pixels are to be converted to black (below the Threshold) 

t, some 
us
sa
one of four values, all of which are correct.   In
axis of the best-fit ellipse (ResultMajorAxisA
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and white (above the Threshold). To help set this value, there is an 
"Automatic Threshold" button available above the property editor.  When 
this button is pressed, the Threshold property is automatically set to the 
system's best estimate for the tool's search region. 

roperly set, a thin red boundary should will be drawn 
along the perimeter of each located object.   If required, manually adjust 
the Threshold value to ensure the displayed red boundary is properly 
aligned with the object boundary. 

Pressing this button displays a pop-up window that permits the value of 
the Threshold property to be manually adjusted while dynamically 
viewing the effect of the new setting in the Camera Display.  The 
displayed image shows all pixels converted to black or white, where the 
white pixels are the ones that are above the threshold. 

Exampl

g example, a single part is located using a Connectivity (blob) tool. The 
maximum radius is used to determine the orientation of the part (ResultMode set to 

.  The tline illustrates eter of the object as computed by 
terse f the X and Y ax tes the computed cen

The X-axis is aligned with the radial line to the perimeter point that is furthest away 
e centroid.  For this part, the maximum radius point yields a unique orientation 

gle for the object. 

If the Threshold is p

Adjust Threshold

es 

In the followin

MAX_RADIUS)
the tool.  The in

 red ou
ction o

the perim
es deno troid of the 

blob.   
from th
an

 

In the following example, the ResultMode is set to PERIMETER and the Connectivity 
returns the loca he points along rimeter of the le, 

 has be a yellow "X" is drawn ev e 
entin s. 

tool tions of t
set to 20, so 

 the pe object.  In this examp
ery 20 pixels along ththe SampleRate

perimeter repres
en 

g each of the returned value
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 the vision process.  The 
onnectivity tool.  The 
e the orientation of each 
ob, the F

In this following example, a Fixed Frame tool has been added to
Fixed Frame has its RelativeToolName set to the name of the C
Connectivity tool is once again set into PERIMETER mode.  Sinc
of the perimeter results is perpendicular to the perimeter of the bl ixed Frame can 
be used to create a series of points that are a fixed distance insid  
blob.  In the picture below, the display of the blob perimeter poin
and the position of each Fixed Frame is being displayed as a yel

e of the boundary of the
ts has been turned off 
low "X". 

 

See Also 

Vision Toolkit | Finder
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Edge Locator Tool 

at dete  points with sub-pixel accuracy along
path in a vision image and returns their positions.  Alternately, th
can return an array of the intensities along the linear path or a hi
of their values. 

Vision tool th cts edge  a linear 
is tool 
stogram 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 
YPo Sing 0 - AOI (s le mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard rties. Placement / Size prope   
The X an  center of 
the tool. 

d Y values define the
 

Length Single 0 - AOI (mm) Defines ear path that is 
tested fo

the length of the lin
r edges.  

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

EdgeThreshold Integer 0 - 254 

Specifies  
used to d of 
gradient rate 
of chang e 
smaller t
the syste
default v 0.  

 the gray scale threshold value
etect edges or (in the case 

 values) the threshold for the 
e of the gray scale values.  Th
he number, the more sensitive 
m is in locating edges.  The 
alue is 3

3A. Advanced Operation
Des Lis EDGE_BINAR / EDGE_BiredAlg t Y INARY: identifies edge 
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EDG

EDG
PRECIS

ion ge.  

DGE_G  edge 
n  value 

sses  

_SUBPIX: computes the positions 
ges to a sub-pixel accuracy based 

n the rate of change (gradient) of the 
gray scale values.  This is the default 
setting.  
 
EDGE_HIGH_PRECISION_SUBPIX: 
similar to the sub-pixel mode except that a 
more precise interpolation technique is 
employed that provides more accurate 
sub-pixe of a 
small inc rare 
cases w ne features (e.g. 2 or 3 
pixel bumps) are contained in the edge 

d to accurately accounted for, 
EDGE_SUBPIX may produce more 
accurate results since that method uses a 
smaller pixel region to compute its results. 

E_GRAYTHRES / 
EDGE_SUBPIX / 

E_HIGH_-

transit
 
E

ION_SUBPIX positio
cro
 
EDGE
of ed
upo

s in a binary ima

RAYTHRESH: identifies an
whenever the gray scale
a specified threshold value.

l edge locations at the cost 
rease in execution time.  In 
here very fi

and nee

Desire List
EDGE_ALLGRADS / 
EDGE_POSGRADS / 
EDGE_NEGGRADS 

This par
edges are to be dete
(EDGE_ALLGRADS) or only edges that 
occur when the gray scale value goes 
from dar S) or 
only edg value 
goes fro
(EDGE_ etecting only 
negative helps 
disambig r 
can elimi
when thin dark or light feat
encount
square re
round ro

dGrads

ameter specifies whether all 
cted 

k-to-light (EDGE_POSGRAD
es when the gray scale 
m light-to-dark 
NEGGRADS).  D
 or positive edges 
uate the edge being detected o
nate double edges that occur 

ures are 
ered.  Processing starts at the 

sizing handle and ends at the 
tation handle. 

Max Inte 1 - n Maximum
return. EdgePoints ger  number of edge points to 

4. Inspection Settings
InspectActual Single  

InspectLabel List
ONE / PASS_AND_FAIL / 

PASS / FAIL / VALUE_REAL 
/ VALUE_INTEGER 

Standard rties.
N

 Inspection Settings prope   
All of the be self 
explanat s the 
"GRAY_...", which test the average or 

 inspected results should 
ory except perhap
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InspectT

FIRST_POINT / 

FIRST_TO_LAST / 

ype List
DISTANCE_TO_-

LAST_POINT / 
DISTANCE_TO_-

MID_POINT / 
DISTANCE_FROM_-

NONE / 
NUMBER_OF_POINTS / 

DISTANCE_TO_-

GRAY_AVERAGE / 
GRAY_MIN / GRAY_MAX  

InspectMax Single   
InspectMin Single   
InspectP

the min/max grayscale values along 
length of the entire tool.  

assed List Pass / Fail
5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE
ResultSelect Integer 1 - n 

ShowRe st NONE / FRAME / LINE / 
POINT 

Standard Results Settings properties

sults Li

ResultMode List

NTS / 
RESULT_FIRST_POINT / 
RESULT_LAST_POINT / 
RESULT_MID_POINT / 

RESULT_PASS_-
THRU_SOURCE / 

_HISTOGRAM / 

 points or 
o be returned in 

ULT_PASS_THRU_SOURCE" 
is a special mode where this tool returns 
the "Results" of its parent tool pointed to 
by RelativeToolName.   This permits a 

Locators after it has computed the 
position of a part and use the Locators to 
perform additional visual verification tests, 
but still have the process return the 
"Results" location of the parent tool.  
Please see the "PassFailEdgeCount" 
demonstration program that was shipped 
with PreciseVision for an example of the 
use of this feature.  
 
The "RESULT_GRAYLEVEL" and 
"RESULT_HISTOGRAM" are special 
modes that return an array containing 
either the intensity (grayscale) value for 
each pixel along the length of the tool or 
the computed histogram of the distribution 
of intensity values.  If either of these 
modes are selected, edge points are not 

RESULT_EDGE_POI

process to add one or more Edge 

RESULT
RESULT_GRAYLEVEL  

Defines whether all edge
selected edge points are t
the results.   
 
The "RES

105 



PreciseVision 

detected. 
6. Results
ResultCount Integer 0 - n 
R ger   esultErrorCode Inte
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultY

Standard Results properties

Pos Single mm

Remark

This tool finds object boundaries, i.e. edges, along a linear path in an image.  The edge 
positions can be used to measure the dimensions of objects or detect if key features are 

r absent.  The edges can be detected in a number of different modes (e.g. 
old, sub-pixel, etc).  Alternately, the raw pixel values or a histogram of the 

grayscale values of the pixels along the path can be returned.  In other vision systems, 
e of tool is sometimes called a "caliper" or "ruler".  

ating Edge Points 

s 

present o
thresh

this typ

Loc

When locating edge this tool operates by analyzing pixels along the specified 
g star e square handle and ends at th

handle.  In cases where you wish to compute the position of a single straight or smoothly 
 edge, the Line Fitter and Arc Fitter tools will yield more accurate results because 

y compute an edg ion utilizing y more pixel values.  

he primary mode o ion for this  is specified by the Desired Alg property.  If 
RAYTHRESH", an edge is detected whenever the gray 

ale value crosses shold s hreshold.  The graph below shows 
mple of how t  appear along the length of an Edge 

ator.  In this case hresh 0, tw
 and #2) where th cale v  sp

points, 
ts at thline.  Processin resizing e round rotation 

curved
the e posit  man

T f operat  tool
this parameter is set to "EDGE_G
sc  the thre pecified by EdgeT
a typical exa
Loc

he gray scal
, if the t

e values might
old is set to 10 o edges will be detected (Crossing 

ecified threshold value.  #1 e gray s alues cross the

 

", edge positions are computed to a 
nge (

If the Desired Alg property is set to "EDGE_SUBPIX
sub-pixel accuracy by first computing the rate of cha "gradients") of the gray scale 

h of the Edge Locator.  For each region where the gradients values along the lengt
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exceed the Edge Threshold value, the pea  the g
eturne he loca .  

k of
tion of the edge

radient is computed with sub-pixel 
accuracy and r d as t

 

If Desired Alg is set to "EDGE_HIGH_ CISION_
om n th PIX" method by employing an even 

more accurate (and costly) sub  method.  This method analyzes a 
dient neigh od a  Edge Locator. 

 if Desired Alg is set to "EDGE_BINARY", 0-to-1 or 1-to-0 transitions are detected 

f the edges een determ , this too s 
cted edge b ResultMode property.   Also, the 
 "Inspection s" can be  to yield Pass / Fail results based upon the 

number of edges detected, various distance relationships or the average grayscale value 
ng the entire length of the tool.  

PRE SUBPIX", a higher-resolution sub-
pixel position is c puted tha e ""EDGE_SUB

-pixel determination
long the path of thelonger gra borho

Finally,
in a binary image.  

After all o
or a sele

 have b
ased upon the setting of the 

ined l can return all of the located edge

standard  Setting used

alo

Computing Intensity Histogram

If the ResultMode is set to "RESULT_HISTOGRAM", rather than computing edge points,
this tool counts the number of pixels along the specified line that has each of the possible 
256 grayscale value
distribution of pixels is call

 

s and returns the pixel counts.  This count of the grayscale 
ed an intensity "Histogram".   It is useful for determining the 

255[white] ) can be fetched using the VisResults Info property.  This array of results is 

r propagate the vision tree. 

prevalent grayscale values and the intensity differences between the peak values.  

If you are executing GPL version 2.0 or later, an array of 256 counts ( 0[black] - 

also displayed in the Vision Results panel of the PV user interface in the "Special 
Results" section and can be recorded if "logging" is enabled.  

Whenever this mode is selected, the ResultXPos and ResultYPos properties represent 
the center of the specified line and can be used to furthe

Returning Grayscale Values 
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If the ResultMode is set to "RESULT_GRAYLEVEL", rather than computing edge points, 
this tool returns the grayscale (intensity) value for each pixel along the length of the 
specifie

If you ar e 
fetched  displayed in the 
Vision Results panel of the PV user interface in the "Special Results" section and can be 

orded if "logging" is enabled.  

Special  (located above the property editor) 

Adjust Threshold

Pressing this button displays a pop-up window that permits the value of 
the Edge Threshold property to be manually adjusted while dynamically 

ct of the new setting in the Camera Display.  If the 
, the display illustrates the pixels 

above the threshold as white.  Otherwise, for the grayscale modes, the 
display indicates the edges that satisfy the threshold criterion in white.  

Show Histogram

If "RESULT_HISTOGRAM" mode is selected, this button will pop-up a 
window that displays the histogram for the specified line in the current 
image.  A sample graph is shown below.  This graph corresponds to the 
tool placement described in the Example below.  You will note the large 
number of white pixels with grayscale values around 238 and a 
distribution of dark pixels with grayscale values between 34 and 68. 

d line.  Each grayscale value can range from 0 (black) to 255 (white).  

e executing GPL version 2.0 or later, an array of up to 1500 pixel values can b
using the VisResults Info property.  This array of results is also

rec

Whenever this mode is selected, the ResultXPos and ResultYPos properties represent 
the center of the specified line and can be used to further propagate the vision tree. 

Feature Buttons

viewing the effe
DesiredAlg mode is "EDGE_BINARY"

 

Show Gray Level

If "RESULT_GRAYLEVEL" mode is selected, this button will pop-up a 
window that displays the grayscale levels for each pixel along the 
specified line in the current image.  A sample graph is shown below.  
This graph corresponds to the tool placement described in the Example 
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below.  Note the low intensity values for the pixels that correspond to the 
black sections of the object.  

 

Examples 

In the following example, an edge locator starts on the left of the image (at the square 
resizing handle) and processes moving to the right (towards the round rotation handle). 
In this case, four edges are detected and can be utilized to measure the diameter of th
center hole and the thickness of the two sides. (Note, an Arc Fitter could have been u
to determine the diameter of the center hole and would have resulted in a more accurate
measurement.) 

 
e 

sed 
 

 

Se

Vision Toolkit

e Also 

 | Arc Fitter | Find Point | Line Fitter 
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Find Centerline Tool 

Vision tool that searches a specified region for edg
the centerline between two located bounding lines

e points and returns 
. 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y 
values define the center of 
the tool and the center of the 
search region.  The Height 
and Width specify the size of 
the search region. 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation 
properties

EdgeMode List

..._NEAREST_DARK / 
..._NEAREST_NOMINAL / 

..._NEAREST_LIGHT / 
..._MAX_GRADIENTS / 

..._MAX_CONCENTRATION 

If several possible lines exist 
within the search region, this 
parameter helps to 
distinguish which two are 
selected as the bounding 
lines.  In addition to selecting 
the lines closest to the dark 
sides, light sides, nominal 
(center line), or greatest 
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concentration of edges, you 
can also select the lines with 
the highest contrast. 
 
The concentration mode
particularly useful if there ar
two or more distinct non-
colinear groups of edges pe
possible boundary line 
boundary line is attempting 
to span multiple groups. If 
concentration mode is

line, this tool will select the
largest cohesive group of 
edges as the basis for fitting
the line. 

 is 
e 

r 
and a 

 
specified, for each bounding 

 

 

EdgeThreshold Integer 0 - 254 
 

Specifies the threshold 
below which weak (low 
contrast) gradients edges 
are ignored.  The smaller the 
number, the more sensitive
the system is in locating 
edges.  Please see the 
description of the Edge 
Locator for more information

default value is 30. 

 
on edge gradients.  The 

3A. Advanced Operation

BiasFilter List
..._BIAS_NO

..._BIAS_TO_L
..._BIAS_TO_

 
 

at 

ints 

NE / 
IGHT / 
DARK 

For boundary lines with an 
irregular or jagged edge, this
parameter can be set to
provide extra weight 
(importance) to edges th
are closest to the light or 
dark side of the search 
region.  For example, for a 
saw toothed pattern, this 
property could be set to fit 
each boundary line to the 
tips of the high or low po
of the pattern. 

DrawEdgePoints List
..._NO_EDGE_P
..._ALL_EDGE_
..._USED_EDGE

ints that 

 
is 

nding the effect of 

settings. This value is 

OINTS / 
POINTS / 
_POINTS 

If set, draws yellow dots to 
indicate ALL edge po
are selected after the 
EdgeMode is applied or only 
those edges that are USED 
to fit boundary lines after the 
EdgeMode is applied and all
outliers are eliminated.  Th
is very helpful for 
understa
changing various property 
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NO_EDGE_POINTS by 
default.  

MaxEdgePoints Integer

.   
ce 

greater accuracy at the 

ng 
 

2 - n 

Maximum number of edge 
point searches to perform 
across the width of this tool
Higher numbers produ

expense of execution 
speed.  The minimum value 
of this parameter is 2.  This 
value is automatically limited 
to the number of pixels alo
the height of the tool.  The
default value is 30. 

MaxIterations Integer 0 - n 

r 
ering 

epeatedly 
er points, 

refitting a boundary line each 

Maximum number of 
iterations for filtering pe
boundary line.  The filt
algorithm r
removes outli

time, until no more points 
need to be removed or the 
maximum number of 
iterations have occurred.  A 
value of zero disables 
filtering.  The default value is 
5. 

MinFilterDistance Single 0 - n.nn 

 
ss.  

A minimum distance is 
needed because the 
standard deviation of 
distances to a fit line can be 
less than a pixel with a good 
image of a clean edge.  The 
default value is 1. 

Absolute minimum filter 
distance in pixels.  No edge 
points closer to a boundary 
line than this are discarded
during the iterative proce

SigmaFilter Single 0 - n.nn 

Filter width in units of 
standard deviations.  This 
value is multiplied by the 
standard deviation of the 
edge points’ distances to a 
boundary line to compute the 
distance threshold beyond 
which edge points are 
removed during the iterative 
boundary line fitting 
process.  The default value 
is 1.5. 

4. Inspection Settings
InspectActual Single  Standard Inspection Settings 
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InspectLabel List
NONE / PASS_A

PASS / FAIL / VAL
VALUE_INTE

ND_FAIL / 
UE_REAL / 
GER 

InspectType List

NONE / ..._R
..._ANGL

..._NUM_EDGES
..._NUM_EDGES

..._LINE_THICKNESS 

MS / 
E / 
_FOUND / 
_USED / 

InspectMax Single   
InspectMin Single   
InspectPassed List Pass / Fail

properties  The 
LINE_THICKNESS is the 
average distance between 
the two bounding lines 
measured at the center o
the tool. 

f 

5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE
ShowResults List NONE / FRAME / LINE / POINT 

Standard Results Settings 
properties

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultLine-
Thickness Single   

 Average distance between
the two bounding lines 
measured at the center of 
the tool. [GPL: 
VisResult.Info(3)]

ResultNum-
EdgesFound Integer   

und 
during the boundary line 
fitting. [GPL: 

Number of edge points fo

VisResult.Info(1)]

ResultNum-
EdgesUsed Integer   

Number of edge points 
remaining after the filtering 
process for the boundary 
lines. [GPL: 
VisResult.Info(2)]

ResultRMS Single   
Root mean square of the 
boundary line fits. [GPL: 
VisResult.Info(0)]

Remarks 

This tool searches the region defined by its gray and blue outlined rectangle for edge 
points, computes the best fit for two bounding lines, and returns the centerline between 
the bounding lines.  This is a convenience routine that internally executes two Line Fitter 
tools to accurately locate the bounding lines using least squares fitting and sub-pixel 
edge extraction techniques.  The search area for each Line Fitter is identical to the 
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region specified for the Find Centerline tool.  The
differs by 180 degrees.  After the Line Fitters hav
between the fit boundary lines is returned by this to

This tool is very useful for accurately locating a ce
object.  Once found, the center line can be used to
features or for generating reference frames that ca ely locate an object or 
features in an object.  This tool also returns the average thickness between the two 
boundary lines measured at the center of the tool. 

When positioning this tool, you should place the ce
ated by the green double h row) a on and 
on that you expect to find the center line. 

For a detailed explanation of the operation of the b
effect of this tool's various properties on the fitting 
section of the Line Fitter tool. 

At the conclusion of this tool, the center position a
line are returned.  In addition, statistical data on th
fitting operations and the root mean square of the 
data indicates the quality of the final fits and can b
yield a pass/fail indication for the tool's operation. 

Sp e Buttons ( above t  editor

Adjust Threshold

Pressing on disp p win
the Edge Threshold property to be manu
viewing the effect of the new setting in the
that satisfy the threshold criterion are disp

Exampl

ple, a single Find Centerline tool is utilized to accurately determine 
the orientation of the primary axis of an object.  

 orientation of the two Line Fitters 
e completed execution, the center line 
ol. 

nter line between two outer edges of an 
 compute distances between important 
n accurat

nter (nominal) line of the search region 
t approximately the positi

oundary line fitting operation and the 
process, please refer to the Remarks 

nd orientation of the computed center 
e number of edges used in the line 
line fits are returned.  This statistical 
e tested via the "Inspect Settings" to 

(as indic
orientati

eaded ar

ecial Featur located he property ) 

dow that permits the value of 
ally adjusted while dynamically 
 Camera Display.  The edges 
layed in white. 

this butt lays a pop-u

es 

In the following exam

 

See Also 
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Vision Toolkit | Line Fitter | ocatorEdge L
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Fi

l that locates n o the line that 
art of the tool's search sition of the point 

is returned with sub-pixel accuracy
perpendicular to) the search di

nd Point Tool 

Vision too
defines the st

 the edge poi t that is closest t
 region.  The XY po

 along (and pixel accuracy 
rection. 

Prere

Pro

quisites 

None 

perties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Stand s.ard Placement / Size propertie   
The X r of 
the to
regio
that is
point. f 
the re

 and Y values define the cente
ol and the center of the search 

n.  The Width defines the distance 
 searched looking for the first edge 
  The Height defines the length o
ference search line. 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

Threshold Integer 0 - 254 

Spec
weak  
ignor e 
more  is in locating 
edge
of the

ifies the threshold below which 
 (low contrast) gradients edges are
ed.  The smaller the number, th
sensitive the system

 points. Please see the description 
 Edge Locator for more information 
ge gradients.  The default value is on ed

30. 
3A. Advanced Operation

116 



Vision Toolkit Description 

ToolDisplayMode List NoDisplay / 
DisplaySearch 

Displ s 
that w
regio

aySearch illustrates all of the edge
ere located within the search 

n. 
4. Inspection Settings
InspectActual Single  

InspectLabel List

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 

InspectType List NONE (reserved for 
future use) 

InspectMax Single   
InspectMin Single   
InspectPassed Pass /

Standard Inspectio s.

List  Fail

n Settings propertie

5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE

ShowResults List NONE / FRAME / 
LINE / P

Stand ies

OINT 

ard Results Settings propert

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Re

earches a f interest for the edge point th
defines the start of the rectangular search region.  The dis
and the line is measured along the perpendicular to the sta

The direction of search is indicated by two arrow
 region. 

This tool is useful for locating the closest position between nd a 
reference line.  This tool is very convenient if the boundary
points of interest such as corners or cusps. 

Candidate edge points are located using the same method
r.

marks 

This tool s region o at is closest to the line that 
tance between the edge point 
rting line that passes through 
s that mark the boundary of 

 a part's boundary a

the point.  
the search

 is not a smooth curve or has 

 as the sub-pixel mode of the 
Edge Locato   So, th sition of the d edge poi

ng the dire rch and to within a pixe
of the search.  The position of the returned point can be us
tools to establish the position or thickness of an object. 

Special Feature Buttons (located above the property editor) 

e XY po
ction of sea

locate nt is computed with sub-pixel 
l perpendicular to the direction 
ed in combination with other 

accuracy alo
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Adjust Threshold

Exampl

 is closest 
ch is 
e is 

Pressing this button displays a pop-up window that permits the value of 
the Threshold property to be manually adjusted while dynamically 
viewing the effect of the new setting in the Camera Display.  The display 
indicates the edges that satisfy the threshold criterion in white. 

es 

In the following example, this tool locates the edge point of the black object that
to the reference line that defines the start of the rectangular search region.  The sear
performed in the direction indicated by the tool's arrows.  In this case, the closest edg
a corner point. 

 

See Als

Vision T

o 

oolkit | Edge Locator
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Finder      Tool 

Most powerful vision tool that identifies 
randomly placed parts in a camera image 
and returns their position, orientation and 
scaling to within sub-pixel accuracy.  

Prerequi

None 

Properti

 generation of the template and its properties.  The "Runtime 
" Property List defines how the template is applied to an image to locate 

ng 
.  

sites 

es 

This tool employs a trained object model ("template") to recognize objects.  To simplify 
the use of this tool, it has two Property Lists.  The "Template Settings" Property List 
controls the automatic
Settings
objects.  Special Feature buttons above the Property Lists switch between the two lists. 

The following describes the "Template Settings" Property List.  When a property is 
modified that invalidates the template, the system automatically indicates that Re-traini
is required

Property Name Data 
Type Range  Description

1. Identity
Type String n/a Standard Identity properties
2. Placement/Size
Height Single 0 - AOI (mm) 
Wid 0 - AOI (mm) th Single
XPos Single 0 - AOI (mm) 
YPo

ies.Standard Placement / Size propert   The 
X and Y values define the center of the 
rectangular template and the Height and 
Width define its dimensions. 

s Single 0 - AOI (mm) 
3. Operation
Camera Integer 1 - 6 Standard Operation property

Min le Integer 0 - 180  

um 
ed to 
ormally, 

this property is set to 180 degrees to detect 

 to 

MaxAng

This parameter defines the maxim
amount that the template is permitt
rotate when it is locating objects.  N

parts in any orientation.  However, if a part 
can only rotate a limited amount relative to 
its taught orientation, reducing this value
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the smaller range of orientations will 
up processing. 
 

speed 

In addition, if the part has some type of 
orientation symmetry (e.g. a circle or a 

estrict 

 
ntation 

 

   Circle:  0 deg 
   Square: 45 deg 

   Hexagon: 30 deg 
 
By default, this property is set to 180 
degrees (any orientation). 

square), this value should be set to r
the range of orientations.  This speeds 
processing and prevents a robot from
making unnecessary changes in orie
to grasp a part.  This property should be
set as follows for common types of 
symmetries: 
 

   Rectangle: 90 deg 
   Equilateral triangle: 60 deg 

Sco THIS_TIME_ONLY reAutoSetMin List NO / YES / 

ScoreHiResMin Single 0 - 1 

st a 
region in a camera image, the "re nition 
score" indicates how well the two match.  A 

When a template is compared again
cog
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ScoreLoResMin Single 0 - 1 

ch and 
a value of 1 represents a perfect match.  
The ScoreHiResMin and ScoreLoResMin 
properties specify the minimum scores for 
a match to be considered good.  The 
ScoreLoResMin is utilized at the lowest 
image resolution to determine if a possible 
match is a good enough candidate to be 
further analyzed at higher resolution 
levels.  The ScoreHiResMin specifies if a 
match at the full camera resolution is 
acceptable as a final, good match. 
 
If ScoreAutoSetMin is set to YES, the 
ScoreHiResMin and ScoreLoResMin 
values are automatically set to computed 
conservative values when the template is 
trained.  If ScoreAutoSetMin is set to 
THIS_TIME_ONLY, the ScoreHiResMin 

plate 
is trained.  If ScoreAutoSetMin is set to 

es 
in 

g is 
completed. 
 
In general, the ScoreLoResMin is set 

reHiResMin.  In 
 be set very low 

s all of 
est 

resolution and pursues the best candidates 
first, setting ScoreLoResMin low just 
results in more candidates being pursued 
to the full resolution level.  If a specific 

ing 

d 
 if 

t too 
e.

rms 
nly 

returned by this tool.  Setting this property 
higher results in higher quality matches 
being returned at the risk of rejecting 
acceptable matches. 

value of 0 represents a total mismat

and ScoreLoResMin values are only 
automatically set the next time the tem

NO, these two properties are not 
automatically set.  In all cases, the valu
of ScoreHiResMin and ScoreLoResM
can be manually adjusted after trainin

equal to or lower than Sco
fact, ScoreLoResMin can
or even to 0.  Since the Finder sort
the candidate matches at the low

number of parts is being located, hav
additional candidates is not a problem 
since the finder will stop when the desire
number of parts are located.  However,
an unknown number of parts is being 
searched for, having this property se
low can result in excessive execution tim
 
On the other hand, the setting for 
ScoreHiResMin is very important in te
of the quality of the Finders results.  O
matches that exceed this value are 

Speed Integer 1 to 99  The Speed property controls how quickly 
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SpeedAutoSet List THIS_TIME_ONLY 

w 
meticulously it attempts to find matches.  If 

es 
est reliability.  

est 

If SpeedAutoSet is set to YES, the Speed 
is automatically set to a conservative value 
that achieves a good balance of speed and 
reliability.  If SpeedAutoSet is set to 

lue is 
e 

t is 
lly 

 can be 

the tool executes at runtime versus ho

NO / YES / 

this value is set to 1, the Finder execut
more slowly but with the high
If it is set to 99, it executes at the fast
speed but may fail under non-ideal 
conditions.  
 

THIS_TIME_ONLY, the Speed va
only automatically set the next time th
template is trained.  If SpeedAutoSe
set to NO, the Speed is not automatica
set.  In all cases, the Speed
manually adjusted but will typically 
invalidate the template. 

3A. Advanced Operation

Accuracy

This property controls the amount of effort 
and time that is spent on performing the 

late.  Smaller 
aster 

ution times.  Values above 10 provide 
ense 

nts will 
be automatically added to the template. By 

fault, this property is set to 10. 

Integer 1 - 100  

final refinement of the location and 
orientation of a matched temp
values result in less accuracy but f
exec
higher sub-pixel accuracy at the exp
of execution time.  As this value is 
increased, additional key match poi

de
Depth Integer 1 - n As a significant speed optimization, at 
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DepthAutoSet List NO / YES / 
THIS_TIME_ONLY 

hes for 
odel in images 

n resolution.  
 level of reduced resolution is a factor 

of 2 smaller in width and height.  This 
 the maximum pyramid search 

level to use. 

During training, PreciseVision automatically 
computes the maximum number of levels 
to use based upon the loss of distinctive 
features and other criterion and sets this 

Depth 
 number of 

reduced resolution levels considered.  This 
is beneficial if the system is too aggressive 
and selects too many levels.  The number 
of levels does not affect the accuracy of the 

 last 
age 

t in much 
 some 

If DepthAutoSet is set to YES, the Depth 
is automatically set to the highest value 
that is appropriate for the template.  If 
DepthAutoSet is set to 
THIS_TIME_ONLY, the Depth value is 
only automatically set the next time the 
template is trained.  If DepthAutoSet is set 
to NO, the Depth can be manually set to a 
lower value. 

runtime the Finder initially searc
matches to the template m
that have been reduced i
Each

parameter is

 

property value.  After training, the 
can be lowered to limit the

final results of the Finder since the
match is always performed at the full im
resolution.  Higher levels will resul
fast execution times but may miss
possible matches.  
 

GainLimit Single   To enhance robustness, each time the 
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Offs  0 -  n 

template is compared to a region of a 
camera image by the Finder Tool, the 
comparison is automatically normalized to 
eliminate differences due to the overall 
brightness of the image.  In particular, each 
pixel value is effectively adjusted as 
follows: 
 

ain*image_pixel + Offset

cess is controlled by 
rties: 

 
GainLimit restricts the range of the Gain 
value.  If non-zero, the "Gain" will be 
restricted to fall between 1/GainLimit and 
GainLimit.   By default, this property is set 
to 4. 
 
OffsetLimit restricts the amount by which 
the overall brightness is adjusted up or 
down, i.e. this property specifies the 
maximum absolute value of the "Offset".  
By default, this pro  64. 

etLimit Integer

   New_value = G
 
This normalization pro
the following prope

perty is set to
MaxScale Sing 0.8 to 1.2 le

MinScale Single 0.8 to 1.2 

These properties can be set to locate parts 
that have a variable scaling (size).  This 
can occur if the part can be at different 
distanc l in 
acceptable focus.  Allowing scaling 
variations can be very useful, but it does 

re additional execution time.  By 
 values are set to 1.0, which 

dicate

es from the camera while stil

requi
default, these
in s no scaling is permitted. 

The following list is dis when the Runtim
ssed.  The rties co time e

ing operation. 

played  "Switch to e Settings" Special Features 
xecution of the template Button is pre

match
se prope ntrol the run

Property Name Data 
Type Ra   nge Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle S -360 to 360 ingle
Height Single 0 - AOI (mm) 
Width S 0 - AOI (mm) ingle
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 

Standard Placement / Size 
properties.  The X and Y values
define the center of the rectangu
search region and the Height 
Width define its dimensions. 

 
lar 

and 
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RelXPos Single 0 - AOI (mm) 
RelYPos Si 0 - AOI (mm) ngle

 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName

Standard Operation properties
List n/a 

Prec

This property allows parts to be 
recognized even if the matching 
template area is partially outside of 
the search region.  Normally, this 
property is set to 0 and the Finder 

plate 
e 

h 
ll not 

center of the template is closer 
 width or 

earch 
d is 

a will 
ty 

ased, the recognition 
match score that is compared to 
ScoreHiResMin and 
ScoreLoResMin will be reduced 

on to 
lso, 

 
nd does 

e to 
 allow for 

ScoreHiResMin and 
ScoreLoResMin should be 
reduced.   By default, this property 
is set to 0. 

only searches for X/Y tem
center positions that have th
template fully within the searc
area.  In this case, this tool wi
return a match position where the 

entClipped Integer 0 - 50 

set to 50%, all template center 
positions within the search are
be considered.  As this proper
value is incre

than 1/2 the template's
height to a boundary of the s
region.  If the PercentClippe

somewhat, but not in proporti
the value of this property.   A
this property only applies to 
template matches that protrude
beyond the search space a
not deal with occlusion du
overlapping parts.  To
overlapping parts, the 

3A. Advanced Operation

MaxRecognition 
Time Single   

Limits the total time the tool will 
  This can 

be helpful if the Finder is looking 
for a specific number of objects 
(such as 1) but the expected 
objects may or may not be 
present.  In this case, this property 
will stop the Finder before it 
exhaustively tests all possibilities. 
 
However, if this value is set too 
low, it can generate incorrect 
results due to the Finder not 
completing its full analysis and 

execute, in milliseconds.
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verification process. 
 
Normally, this parameter is set to 
its default value of 10000 (10 sec). 

4. Inspection Settings
InspectActual Single  

InspectLabel List
NONE / PASS_AND_FAIL 

/ PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 

InspectType List
NONE / RESULT_ANGLE 

/ RESULT_SCORE / 
RESULT_ID 

InspectMax Single   
InspectMin Single   
Insp sed List Pass / Fail

n Settings Standard Inspectio

ectPas

properties

5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
O leffsetX Sing mm 
OffsetY Single mm 
ResultOnNotFound n TRUE / FALSEBoolea
ResultSelect Integer 1 - n 

ShowResults NONE / FRAME / LINE / 

Standard Results Settings 

List POINT 

properties.  MaxResults defines 
the number of matches to find each 
time that this tool is executed.   
This tool will execute more quickly 
if a known number of matches are 
located and this property is set 

that execution terminates as soon 
as the expected number of 
successful matches is found.  Until 
all expected matches are found, 

accordingly.  This is due to the fact 

this tool will continue to 
exhaustively test all possible 
matches.  By default, this property 
is set to -1, exhaustive matching.  

ShowResult-
TemplateGraphics n TRUE / FALSE 

 

cate the position of the 
key features of the Finder 
Template that are utilized for the 
object finding process.  This 
permits the alignment of a matched 

te.  
The yellow dots indicate the 

 match 

Boolea

If TRUE, each matched part in the
Camera Display is overlaid with 
dots that indi

part to be visually compared with 
the key features of the Templa

primary pixels that should
prominent features of the full 
resolution image.  

ShowResult-
TemplateScore Boolean TRUE / FALSE 

 

ore" that 

 

If TRUE, each matched part in the
Camera Display is overlaid with its 
numerical "recognition sc
indicates how well the template 
matched the located part.  A value
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of 0 represents a total mismatch 
and a value of 1 represents a 
perfect match.  Accepted scores 

o 
e 

ly valid parts.  

will all be greater than or equal t
the ScoreHiResMin property valu
for the associated template. 
Especially for scenes with multiple 
instances of the same type of part, 
this feature is very useful for tuning 
the ScoreHiResMin value to 
correctly locate on

6. Results
ResultCount Integer 0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultObjectID Integer 1 - n  

e 

n a 

 around in a 
pattern.  In this case, this property 
indicates the step in which each 

If a single Finder is executed 
multiple times within a Vision 
Process, this property identifies th
instance of the Finder that 
produced each result.   
 
This is particularly useful whe
Fixed Frame Tool has an index 
that steps a Finder

result was generated. 
[GPL:VisResult.Info(4)]  

ResultRecognition-
Time Single  msec

Total time required for the last 
execution of this tool in 
milliseconds. [GPL: 
VisResult.Info(3)]  

ResultScaleX Single   

ResultScaleY e

These values indicate the X and Y 
scale factors that were computed 
when matching the template to the 

as not 
hese values will be equal 

to 1. [GPL: VisResult.Info(1), 
Singl   

camera image.  If scaling w
enabled, t

VisResult.Info(2)]  

ResultScore Single  

This is the "recognition score" that 
indicates how well the template 

 value 
ts a total mismatch 

s 
will all be greater than or equal to 
the ScoreHiResMin property value 
for the associated template. [GPL: 

0 - 1

matched the located part.  A
of 0 represen
and a value of 1 represents a 
perfect match.  Accepted score

VisResult.Info(0)]  
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Remark

cale images.  It can locate randomly placed parts 
with both simple and complex shapes and will return their part type, position, orientation 

 the Finder can handle the widest range of parts and situations, has a 
very simple one-shot teaching method, and returns accurate sub-pixel results. 

 object, the 
Finder can be placed relative to the results of any other tool including another Finder.  

ion).  

Typical uses for this tool include: finding fiducial marks on a printe
parts randomly placed and oriented on a conveyor belt and refinin ion and 
orientation of sample tr

Finder Templates and Training Mode

s 

The Finder is the most powerful tool in the toolkit and provides the most general method 
for identifying and locating parts in grays

and scale.  There are other tools in the toolkit that are appropriate for specialized 
situations such as binary images or non-rotated parts.  Also, for some simplified or 
constrained cases, it is relatively easy to combine Line Fitters and other tools to locate 
parts.  However,

To address applications like locating a secondary object within a primary

The one restriction is that the Finder search window is always orthogonal with the 
camera frame of reference (although the matched objects can be in any orientat

d circuit board, locating 
g the posit

ays. 

 

The Finder operates in g" or "Finding".  Training mode 
teaches the system the  a part and stores the info
"Template" object mod ode searches the camera ima ons of the 
image that a  a suitab plate. 

When a Finder tool is atically placed into T  
"Template Settings" Property List is prese ted.  This list displays the size and the 
position of the Template a roperties that are specific to the type of part being 
taught, e.g. parameters for part symmetries, expected scale variat ed 
above this property list ttons that aid in teac sting the 
template. 

To create a Template, e part must be trained.  
consists of bounding th us some of the adjacent backgroun te 

 one of two modes:  "Trainin
 visual features of
el.  Finding m
le match for the Tem

first created, it is autom
n

nd other p

rmation in a 
ge for regi

raining mode and the

re

ions, etc.  Present
hing and adju

The training process 
d with a red "Templa

 are Special Feature bu

a single image of th
e part pl

rectangle".  This red rectangle defines the size and contents of the
PreciseVision subsequently searches an image and reports the po ion 
of a matched part, it is  position of the center of hen the 
match was found and t which the Template was rota

During the tr ning process, a yellow "Training rectangle"

 Template.  When 
sition and orientat
 the Template w
ted. 

actually stating the
he amount by 

ai  must als d 
the Template.  This yel e system h he 
Template from other ob ckground clutter that might be e . 
If different types of parts or clutter are expected to be present, the  will work best if 
one and only one full c part plus any diffe tter 
are enclosed by the ye general, the larger the ye  

o be positioned aroun
ow to distinguish t
ncountered at runtime
 system

low rectangle is used to teach th
jects or ba

opy of the desired target 
llow rectangle.  In 

rent objects and clu
llow rectangle, the

better the Finder will operate since this allows the Finder to try more positions and 
orientations for the tem es its search parameters.plate as it optimiz   Please note tha

) of the same part tha

 be positioned to tea
nd stable 

t since 
PreciseVisio is a 2D v t poses (stable states t 
produce different 2D im different parts. 

The following picture ill ing rectangles should ch 
the Finder how to locate o e ignoring a seco state. 

n ision system, differen
ages are considered 

ustrates how the train
ne orientation of a part whil
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If two or more types of ntified and located in the le 
Finders and their Tem d and included in the V

After the Template and have been properly po der 
can be taught by press equired" special feature button located above 
the Template Propertie o simplify the training and setup process, when you create 
a new Finder, a wizard is automatically displayed that walks you through the training 
steps.  Using this wizar aining and setting up th rties 
is extremely simple.  

If any of the Template bsequently modified that in
the system will automa  Template must be tr
simplify retraining, the ays stores the image that was u g the prior 
training.  This previous image can be easily recalled using one of the Special Feature 
buttons.  

The Finder Search Algorithm

parts are to be ide
plates should be traine

 Training rectangles 
ing the "Training R
s list.  T

 same image, multip
ision Process.  

sitioned, the Fin

d, performing the tr

properties are su
tically indicate that the
system alw

e key Finder prope

validate the Template, 
ained again.  To 
tilized durin

After a Template has been trained, the tool can be executed in Find mode and the 
alternat ttons.  
The Run

e "Runtime Properties" list can be displayed using the Special Feature bu
time Properties list presents the size and position of a green "Search rectangle".  

This rec matches to 
the Tem  
search,   In the 
Camera y Window, the green Search rectangle and the blue "taught Template 

tangle defines the camera image area that the Finder will search for 
plate.  The Runtime property list also contains parameters that control the
e.g. the number of parts to find, the amount of clipping permitted, etc.
 Displa

rectangle" will be displayed. 

The heart of the Finder Tool is a patented algorithm that combines an intelligent search 
ss of normalized correlation to match the Template with 

regions in the search region.  This intelligent search technique avoids the computational 
requirements of applying correlation to a multi-dimensional search that accommodates 
concurrent changes in position, orientation and scale.  Also, this technique does not 
introduce the problems encountered with correlation optimization methods such as 
skipping pixels, while still retaining the important benefits of a normalized correlation 
match. 

Like most search methods, this tool employs reduced resolution images for the initial 
search steps in order to quickly identify candidate positions.  This method is often called 
a pyramid search since each successive search level has half as many pixels in each row 

technique with the robustne
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and column.  During the training process, this tool automatically computes the 
recommended number of levels that can be utilized while still retaining sufficient 
distinctive features to differentiate the target object from the background and other 
objects. 

 template (or a reduced resolution template) is compared to 
the image (or a reduced resolution image), a normalized comparison operation produces 

atch, to 1, 
ns whose 

  
 locations also 

full camera resolution.  When the 
system finds the requested number of successful results or all of the candidate locations 

een exhausted, execution is terminated.  

d, each of the successful results 
 tagged as to whether it "Passes" 

Fails". 

Optimizing The Finder And Templates

At each position where the

a "recognition match score".  This score ranges from 0, which indicates no m
which indicates a perfect match.  At the reduced resolutions, all of the locatio
score exceeds a minimum value are retained and ordered according to their score valu
The tool then pursues these candidate locations and validates whether the
satisfies a minimum match score when tested at the 

e.

have b

As a final step, if the Inspection Setting has been define
will be tested against the Inspection criteria and will be
or "

The following are a n es for optimizing the performance of the 
nder Templates.  

Template (Red) Rectangle Guideline

he Template should fully enclose the target object and should contain no other 
objects or parts of objects.  

• In general, the Template rectangle sho  larger than the

umber of guidelin Finder 
and Fi

s 

• T

uld be  target object.  It is 
best to have a boundary of at least 16 camera pixels all around the target object 
(more pixels are better than fewer pixels).  For a 640x480 ca
1/30th of the full height of the camera image.  This permits th
the edges between the object and the background.  This is e
the object does not have many internal features. 

mera, 16 pixels is 
e system to capture 
specially important if 

 

• If the background varies significantly (e.g., there is dirt and p
conveyor belt), then the part should be placed on a uniform, 

teach the Template. 
• The target object should be oriented in the camera image in 

define as ‘Zero’ degrees.  That is, when the Finder later loca
trained orientation, it will return an orientation angle of 0 deg

aint blotches on a 
neutral background 

what you want to 
tes a part is in the 
rees. 

to 
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Training (Yellow) Rectangle Guidelines 

• The Training rectangle must be larger than the Template and
e Template
e Training ngle should include nd only one full i

object.  Since the Finder uses the contents of the Training re
distinguishing features of the Template, a second complete c  
will confuse the system and will generate an error.  It is acce ave 

ial images of the target object in the Training rectangle so long as 
ect (see picture above in th

discussion for an example).  

 must fully enclose 

mage of the target 
ctangle to determine 
opy of the Template
ptable to h

th
• Th

. 
recta one a

additional part
each is less than 50% of the target obj e Template 

 

• This rectangle should include any other objects or clutter tha ed to be 
d during runtime to aid the system in learning to distinguish between 

the target object and its surrounding
• This rectangle should be as s above.  

A larger region permits the s ns and orientations for the 
Template during the training izing
strategy. 

Finder Properties 

 your part is etric, e. ngle,
inMaxAngl perty to l s.  

• If any portion of the part mi h win
PrecentClipped property a

System and Camera Setu

• Prior to training or execu 's
relationship.  Failure to d  lo

t are expect
encountere

s.  
large as possible without violating the rule
ystem to test more positio
 phase and assists in optim

g. a circle, a square, a recta
imit the rotation of the result
ght extend beyond the searc
ppropriately. 

p 

ting this tool, calibrate the camera
o so may result in parts not being

 the runtime search 

 set the 

dow, set the 

 pixel to millimeter 
cated.

• If  symm
e M pro

  This is due to 
eir X and Y scaling 
nted for properly, as 
will be incorrect.  

the fact that some cameras do not have sq th
tors are different.  If this difference in aling is not accou

parts are rotated, their shape will be dist ted and their size 
rger targe nd therefore larg r templates) generally perform better 
n small t s for various reasons: finding a very small template in a large 
rch space mparable to find aystack; larger templates 

usually have more image features; larger templates usually can be found with 

uare pixels, i.e. 
fac sc

or
• La

tha
t objects (a

emplate
e

sea  is co ing a needle in a h
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higher accuracy particularly in orientation; and larger templa
big features can be searched using taller search pyramids th
the search. 

Optimal Target Objects 

• Target objects that contain corners that form a 90-degree an re 
reliable recognitions and higher accuracy. 

• Sharp features in focus provide more accurate results than s
tures. 

he templa any edges in one tion but only a fe
direction, matched locations will have greater accuracy in the
perpendicular to the majority of the edges.   In the figures be s "A" 

contain many vertical edges so both can be located with high accuracy in 
ontal direction.  But template "A" has very few horizontal edges 

ared to "B", so along the verti  "B" will be fo
uracy than template "A". 

tes containing some 
ereby accelerating 

gle result in mo

mooth or blurred 

w in the orthogonal 
 direction 

low, template

fea
• If t te has m  direc

and "B" 
the horiz
comp cal direction, und with higher 
acc

 

 more accurate 
saturation.  Image 
 the brightness 

 position 
.  Large features 

• A wide dynamic ran
n image with 

ge of brightness in emplate provides
results than a a narrow ran   However, avoid 
information is lost when pixels are clipped at the two ends of

e.  
s nhance the ll accuracy of the

calculations, but large features enhance the speed of search
enable use of taller search pyramids. 

Template Mask 

k in 

Special

the t
ge.

rang
• Fine detail  in the image e overa

• If the part contains features that are known to be variable from one image to the 
next, the unwanted features can be ignored by masking them out of the 
template.  The masking operation is similar to using a simple painting tool to 
indicate regions to be ignored in the template.  

• To define a Template mask, force the system into Training mode, right clic
the camera display window or in the Vision Tool Definition window and select 
Finder > Edit Template.  

 Feature Buttons (located above the property editor) 

Execute

Executes the Finder search algorithm once in the current camera image 
buffer.  

132 



Vision Toolkit Description 

Load Original Image 

Each time a Template is trained, the image used for the training is 
automatically stored by the system.  This button reloads the previous 
training image into the camera button.  This greatly simplifies retraining 
the template if you wish to see the affect of altering various Template 

 
 the property values.  

Show Template 

Pops up a window that displays the Template that has been trained.  The 
pixels in the Template that represent key features to be located are 
highlighted in yellow.  If the Template includes a mask for ignoring 
unwanted areas, the mask is displayed in red.  

Switch to Template Settings / Switch to Runtime Settings 

Switches between the Template Settings and the Runtime Settings 
Property lists.  

uired 

Indicates that the Template for the Finder is not valid.  Pressing this 
n the Template.  

Examples 

In the following example, a Finder Template is trained on one of six identical parts.  
Since the parts are all the same, the yellow Training rectangle is only placed around one 
complete part although other partial parts (each less than 50% of the full object) are 
included in order to enlarge the Training rectangle.  Also, for a reasonable template 
boundary and for an intuitive orientation angle, the horizontal part is trained rather than 
the parts at a skewed angle.  After the Training and the Template rectangles are 
positioned, the Train icon can be pressed. 

properties.  

Reset Template Defaults / Undo Changes 

Either resets the Template Property values to their default values, which 
were established when the Template was trained, or undoes any recently
changes to

Training Req

button will trai
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For this mple part, training completes in approximately one second after which the tool 
is automatically placed into Find mode and the search operation is executed once.  At the 
conclusion of the search, all six parts will be identified and each of the part's position and 
orientation will be indicated by yellow coordinate axes as illustrated in the following 

si

picture.  

 

See Also 

Vision Toolkit | Connectivity 
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Fixed Frame Tool 

onal tool that places
coordinate or at a constant offse t
optionally index the frame in an X and/or Y grid p
execute any linked tools.  

Computati  a reference frame
t relative to ano

 at a fixed image 
her vision object.  Can 
attern to repeatedly 

Pre

Pro

requisites 

None 

perties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y valu
define the origin of the reference 
frame and the Angle specifies 
rotation. 

es 

its 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

3A. Advanced Operation
Fram 1 - n  ePatternXIndex Integer
FramePatternYIndex Integer 1 - n  
FramePatternXPitch Single mm 

Fram

If the X and/or Y index values are 
greater than 1, the position of the 

rid 
Y 

 
s any linked 

repeatedly executed in a grid 
pattern.  

ePatternYPitch Single mm 

Fixed Frame is indexed in a g
pattern the number of X and/or 
steps by the appropriate Pitch
values.  This permit
tools to be automatically and 

5. Results Settings
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ShowResults List NONE / FRAME / LINE / The frame can be graphically 
represented as a coordinate frame, POINT line or a point. 

6. Results
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

opertiesStandard Results pr

Remarks 

A Fixed o 
another  to 
directly as the advantage of 
allowing e vision 
window

Alternat aced in an image at a specified position and 
orientation and can then serve as a datum from which other measurements are made. 

Lastly, i dexed 
about a y tools 
linked to (i.e. defined Relative-to) the Fixed Frame in a grid pattern.  

Examples 

Below is f the part.  A 
Fixed Frame is placed relative to the finder and used to effectively re-define the part's 

e of reference.  Additional vision tools can now be placed relative to the Fixed 
Frame.  The advantage of doing this is that if the Finder template is re-trained it may not 

 Frame can be used in several different ways.  It can be defined relative t
 vision object with a fixed position and angular offset.  This is an alternative
setting an offset in the Results Settings of most tools and h
 the offset to be graphically specified by dragging the Fixed Frame in th
. 

ely, a Fixed Frame can be pl

f the Pattern properties are utilized, a Fixed Frame can be automatically in
n X and/or Y grid pattern.  This has the benefit of repeatedly executing an

 an example of a Finder that returns a frame that is at the center o

fram

be placed in exactly the same position and orientation relative to the part.  The Fixed 
Frame can then be adjusted to account for any difference in the Finder position and 
orientation.  By using this relative reference frame, we can easily ensure that all 
subsequent tools will maintain their positional relationship with respect to key features of 
the part. 

 

See Also 

Vision Toolkit | Line-Line Frame Tool | Point-Line Frame Tool | Point-Point Line Tool 
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Image Process Tool 

Vision tool that performs image filtering, edge extraction, thresholding 
and morphological operations on a specified area in the camera image. 

Prerequisites 

Properti

None 

es 

Property Name Data 
Type Ran   ge Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single 0 (non-rotating) 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single 0 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 
define the center of the region to be 
processed.  The Height and Width 
define the dimensions of the 
region.  

3. Operation
Camera Integer 1 - 6 
Relative-
ToolName List n/a 

Standard Operation properties

InvertBinary Boolean  TRUE / FALSE  

(BINARY) For BINARY_* 
ProcessModes, if this parameter is 
True, after the binary pixels values 
are extracted, their values will be 
inverted before the remainder of the 
processing is performed. 

Iteration Integer 1 - n Specifies the number of times that 
the ProcessMode should be 
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applied to the area of interest.   This 
is often used to repeatedly execute 
the morphological operations. 

Proc

Specifies the image processing 
operation to be performed on the 
selected area-of-interest.  These 

s that alter 
 buffer so 

operate on 

See the Remarks for an illustration 
of each of the supported operations.

essMode LIST  CONV_* / BINARY_*  

are destructive operation
the contents of the camera
that all subsequent tools 
the modified data. 
 

Threshold Int 0 - 254 

(BINARY_*) This is the value used 
 into 

(CONV_*)  This value is not utilized.
 
(EDGE_*) Specifies the threshold 
below which weak (low contrast) 
gradient edges a he 
lower this property is set, the more 
sensitive the system is in locating 
edges.  Please see the d n 
of the Edg

to convert gray scale values
black and white pixels. 
 

eger
re ignored.  T

escriptio
e Locator for more
n on edge 

 
informatio gradients.  The 
default value is 30. 

3A. Advanced Operation

ConvolutionSize List SIZE_3X3 / SIZE_5X5  

Specifies he convolution 
kernel is a
size of the
many neig
consider i ach 
new pixel

whether t
 3x3 or a 5x5 matrix.  The 
 kernel determines how 
hboring pixels are 

n the computation of e
 value.  

5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings 
properties

6. Results
ResultErrorCode Inte   ger
ResultAngle Single 0 (non-rotating)
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties 

osition for the centroid o
ssed area-of-interest. 

 
X and Y p f 
the proce

Remarks 
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This tool performs an image filtering, edge extraction, thresholding o
operation on a specified area in the camera image.  For example, a
applied to smooth a region to eliminate noise due to poor lighting.  C
can be sharpened to highlight features. 

While most vision tools analyze the data in the camera image and le
unmodified, these operators all alter the raw data in the image buffe
vision tools will operate on the modified image data and not the raw 
by the camera. 

revert he original raw captured image data, s
be set in the Acquisition Tool

r morphological 
n operator can be 
onversely, the image 

ave the data 
r.  All subsequent 
information captured 

pecial properties must If you wish to back to t
 at the time that the picture is first tak

The following table illustrates each of the image processing operatio

en. 

ns. 

 

Raw, unprocessed 
camera image. 

C
E
 
E
bi
sl
le

ONV_FILTER_ 
DGE_DL 

xtracts edges with a 
as for edges that 
ope down from the 
ft. 

CONV_FILTER_ 
EDGE_DR 
 
Extracts edges with 
a bias for edges that 
slope down from the 
right.  

C
E
 
E
a
e

ONV_FILTER_ 
DGE_H 

xtracts edges with 
 bias for horizontal 
dges. 

C
G
 
R
n
re
s

ONV_FILTER_ 
AUSSIAN 

educes image 
oise by blurring the 
gion.  This is a 

moothing operator.  

CONV_FILTER_ 
EDGE_V 
 
Extracts edges with 
a bias for vertical 
edges. 

C
L
G
 
E
s
G
n

ONV_FILTER_ 
APLACIAN_ 
AUSSIAN 

xtracts edges after 
moothing with a 
aussian to reduce 
oise.  

CONV_FILTER_ 
LAPLACIAN 
 
Extracts edges 
using a Laplacian 
operator. 

C
LOWPASS_H 
 
Reduces image 
n
h
c
th ntal 

CONV_FILTER_ 
LOWPASS 
 
Reduces image 
noise by eliminating 

 frequency 
nges. This i

smoothing operator.  

high
cha s a 

ONV_FILTER_ 

oise by eliminating 
igh frequency 
hanges but only in 
e horizo
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d
1
o

irection. This is a 
D smoothing 
perator. 

CONV_FILT
LOWPASS_V

s image 
noise by eli
high frequency 
changes b
the vertical direction. 
This is a 1D 
smoothing operator. 

ER_ 
 

minating 

ut only in 

 
Reduce

 

C
S
 
A
e
th

ONV_FILTER_ 
HARP 

ccentuates or 
nhances edges in 
e image. 

EDGE_THRESH 
 

utes each 
 edge stren

and sets all strong 
edges to white and 
all weak edges to 
black.  

B
 
C
w

INARY_THRESH 

onverts all pixels to 
hite or black. 

Comp
pixel's gth 

 

B
 
B
th
g
o

INARY_DILATE 

inary thresholds 
e region and 
rows white groups 
f pixels. 

BINARY_ERODE 
 
Binary thresholds 
the region and 

nks white groupshri
of pixels. 

s 

Special Feature Buttons (located above the property editor) 

hold

Pressing this button displays a pop-up window that permits
the Threshold property to be easily adjusted while dynamic

t of the new setting in the Camera Display.  In a BINARY_* 
e displayed image shows all pixels converted to black or white.  

n an EDGE , the edge pix ted and displayed in 

Se

Vis

Adjust Thres

 the value of 
ally viewing 

the effec
mode, th
I _* mode els are extrac
white. 

e Also 

ion Toolkit | Acquisition Tool
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Insp

f   

Prerequi

ect Frame Tool 
Inspection tool that passes through the XPos, YPos and Angle Results of a 
referenced tool and optionally rotates and shifts the Results based upon an 
inspection.  The inspection can consist of the arithmetic combination of the Results o
two other tools.  So, this tool also provides a means for performing simple 
mathematical operations on the results of two tools. 

sites 

FrameSource must be defined for this tool to execute. 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity 
properties

3. Operation

Camera Integer 1 - 6 Standard Operation 
property

ApplyFrameOffset List
NONE / 

OFFSET_ON_PASS / 
OFFSET_ON_FAIL / 

The nominal Results of 
this tool are equal to the 
Results of th cified 
FrameSource.  This 

hen 
, 

and OffsetAngle are 
added to the nominal 
Results.   For example, 

tput 
urce by 

upon 
e of 
n 

e spe

property specifies w
the OffsetX, OffsetY

OFFSET_ALWAYS this tool can rotate the 
orientation of the ou
of the FrameSo
180 degrees based 
the pass/fail outcom
a specified inspectio
operation. 

Fram

requiredName of the  

os and 
n as the 

is 

tool whose 
ResultsXPos, YP
Angle are take
nominal Results of th
tool. 

eSource List n/a 

InspectTool1 List n/a If the InspectType
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Insp

 
computation that 
operates on the Results 

 tools, these two 
s 

ls that are 
the sources for the 
Results. 

specifies an arithmetic

ectTool2 List n/a of two
optional propertie
specify the too

3A. Advanced Operation

SortResults List
SORTFROMLEFT / 

SORTFROMRIGHT / 
SORTFROMTOP / 

SORTFROMBOTTOM 

ty 
automatically sorts the 
Results as specified. 
This is useful for items 
on a conveyor belt that 
may need to be picked in 
order from the front to 
back. 

NONE / 

If the FrameSource 
generates multiple 
Results, this proper

ZeroAngle Boolean TRUE / FALSE 

If True, will force the 
ResultAngle to ZERO. 
This is useful for 
randomly oriented parts 
that require the angle to 

oved for picking. 
eration does 

NOT change the sorting 
operation. 

be rem
This op

4. Inspection Settings

InspectType List

NONE / 
INSP1_MINUS_INSP2 / 
INSP1_PLUS_INSP2 / 
INSPECTIONS_PASS / 
INSPECTIONS_FAIL / 

INSPECT_XY_DISTANCE / 
INSPECT_X1_MINUS_X2 / 
INSPECT_Y1_MINUS_Y2 / 
INSPECT_X1_PLUS_X2 / 
INSPECT_Y1_PLUS_Y2 / 
INSPECT_X1_MULT_X2 / 
INSPECT_Y2_MULT_Y2 / 
INSPECT_X1_DIV_X2 / 
INSPECT_Y1_DIV_Y2 / 

INSPECT_ANG1_MINUS_ANG2 / 
INSPECT_ANG1_PLUS_ANG2 / 
INSPECT_ANG1_DIV_ANG2 / 
INSPECT_ANG1_MULT_ANG2 

InspectMax Single   
InspectMin Single   
InspectActual Single  
InspectPassed List Pass / Fail

Standard Inspection 
Settings properties.  The 
InspectType can specify 
a simple arithmetic 
operation that is to be 
performed on the 
Results obtained from 
InspectTool1 and 
InspectTool2.  The 
InspectActual returns 
the result of the 
arithmetic operation and 
the InspectPassed is 
set according to whether 
the result falls within the 
specified Min and Max 
values. 
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InspectEval String   

Displays the arithmetic 
expression that is 
evaluated to compute 
the InspectActual 
results.  This expression 
is a function of the 
InspectType. 

Insp

Optional label that is 
layed in the camera 
ow.  This provides a 

venient way to 
display part ID or other 
information. 

ectString String n/a 

disp
wind
con

5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE
ResultSelect Integer 1 - n 

ShowResults List NONE / FRAME / LINE / POINT 

Standard Results 
Settings properties.  The 

re conditionally 
al 
s and 

Angle depending upon 
the setting of 
ApplyFrameOffset and 
the pass / fail status of 
the inspection operation.

Offsets a
added to the nomin
ResultsXPos, YPo

6. Results
ResultCount Integer 0 - n 
ResultAngle 60 to 360Single -3
ResultXPos mmSingle

ResultYPos Single mm

Standard Results 
properties.  The 

Ypos and 
l to the 

Results of the 
FrameSource, 

sted by 

ResultsXPos, 
Angle are equa

optionally adju
the OffsetX, OffsetY, 
OffsetAngle. 

Remarks 

This tool passes through the ResultXPos, ResultYPos
referenced FrameSource tool and optionally shifts and
pass/fail test.  This function can be used to correct the p
an object based upon an additional inspection operation

ultiple Results, the test and corre plied 

This tool can also be used to perform measurements be
tools.  For example, the InspectType property can spe
XY positions of InspectTool1 and InspectTool2 is to b
specified min/max values.   The outcome of this inspec
status of this tool.  This pass/fail value can trigger the o
used as input to other tools. 

e, when a ectivity Tool
ys ambiguous  algorithm urn the sa ven 

if an object is rotated by 180 degrees.  If the Connectivity Tool is specified as 

, and ResultAngle from a 
 rotates the Results based upon a 
osition and/or the orientation of 
.  If the referenced tool produces 

to each generated Result. 

tween the Results of two vision 
cify that the distance between the 
e computed and compared to 
tion determines the pass/fail 
ffsetting of the Results or can be 

m ction will be ap

For exampl
alwa

Conn
since this

 is executed, the orie
will ret

ntation of its Result is 
me orientation and position e
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the FrameSource of an Inspect Frame Tool, a measu  
an be perform Base en

the Conn vity Tool a

Examples 

t Fram at alte
l ased on n of a

Locator Tool measures the width of the part (along the
picture on the right) by determining the distance betwee
Depending upon whether the wide or narrow portion of 
Frame Tool conditionally applies an angular offset to ro
orientation angle. 

rement of a specific feature of the
t, the frame of reference that is 

lly rotated to correct its orientation. 
object c
generated by 

ed.  
ecti

d upon the measurem
 can be condition

Below is an example of a Inspec
output b

e Tool th
 the inspectio

rs the orientation of a 
n Edge Locator Tool.  The Edge 
 green line shown below in the 
n the first and last located edge.  
the part is detected, the Inspect 

Connectivity Too

tate the returned frame's 

     

Se

Vis

e Also 

ion Toolkit | Inspect List

144 



Vision Toolkit Description 

  

Inspect List Tool 
Inspection tool that pa
referenced tool and te

sses through the XPos, YPos and Angle Results of a 
sts up to 12 different Results from multiple tools to determine if 

the obje plex 
testing o
Pass/Fa

  

Prerequisites 

FrameSource must be defined

ct is good or bad.  This tool provides a convenient way to perform com
f a located object and generating an equivalent location with a single 
il indicator. 

 for this tool to execute. 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Nam String n/a e
Typ n/a

Standard Identity properties
e String

3. Operation
Cam Standard Operation propertyera Integer 1 - 6 

Fram n/a 

Name of the required tool whose Results 
XPos, YPos and Angle are passed through 

e position and orientation Results of the 
t List tool. 

eSource List as th
Inspec

Insp Inspection Li
button. 

n whose Results are tested 
Many 

ity) have multiple 
sults. Such tools can be referenced 

multiple times to test different Results 
property values. 

ectTool01-12 List using "Setup 
st" 

vision tools (i.e. connectiv
Re

Note: Accessed 
tools 

to determine if the part passes or fails. 
List of visio

3A. OperationAdvanced 

Sho Boolean TRUE / FALSE 
If True will display the tools defined in the 
Inspect List during execution, otherwise only 
the resulting output frame is displayed. 

wInspectTools

4. Inspection Settings
Insp List Pass / Fail Standard Inspection Settings properties.ectPassed

Insp String n/a 

Optional label that is displayed in the vision 
window relative to the position and 
orientation of this tool.  This provides a 
convenient way to display part ID or other 
information. 

ectString

5. Results Settings
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MaxResults Integer -1 or 1 to n 
ResultOnNotFound Boolean TRUE / FALSE
ResultSelect Integer 1 - n 

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings properties.  For 
this tool, the ResultOnNotFound should 
normally be enabled on the Preferences > 
Tool Operation page.  This property forces 
all tools to generate results even if their 
inspections fail.  This ensures that the 
Inspect List has a consistent set of 
complete results from all referenced tools.  If 
this property is not enabled, it is possible for 
referenced tools to past back a varying 
number of results depending which 
inspections pass and fail, with the result that 
the Inspect List will be confused and will 
not return an accurate good/bad indicator.  

6. Results
ResultCount Integer 0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm

ResultYPos Single mm

Standard Results properties.  The XPos, 
YPos and Angle Results are equal to those 
of the FrameSource. 
 
As a special case for this tool, GPL: 
VisResult.Info(0-11) are equal to the Pass(-
1) or Fail(0) results of InspectTool01-12. 
 
GPL: VisResult.Info(12-23) are equal to the 
actual values used for the pass/fail tests for 
InspectTool01-12. 

Remarks 

Many vision applications only required one or two tests to determine if a part is 
acceptable.  In these cases, the vision inspection tools can be executed directly in a 
Vision Process.  However, if many tests must be performed, the Inspect List provides a 
very convenient method for executing up to 12 tests on the Results from multiple tools 
and generating a single Pass/Fail result that indicates if all of the tests are satisfied.  This 
tool can also simplify and improve the efficiency of a GPL program that accesses vision 
results.  If the GPL program only needs to know that all tests passed, the Inspect List 
tool can return a single value instead of requiring the GPL program to read the results 
from multiple tools. 

As a further convenience, the ResultXPos, ResultYPos and ResultAngle of this tool are 
set equal to the Results of the specified FrameSource.  So, if FrameSource is a tool that 
locates the position of an object, the output of the Inspect List will provide the location of 
the object together with a single Pass/Fail property that indicates if up to 12 qualifying 
inspections were successful. 

The 12 Results tested by this tool can come from a single vision tool or multiple tools.  
This permits the Results from multiple measurement or inspection tools to be combined.  
Alternately, for tools such as Connectivity that return many independent properties (e.g. 
ResultBlobArea, ResultMajorAxisLength, ResultMinorAxisLength, 
ResultMaxRadiusAngle, etc.), multiple properties from the same tool can be tested to 
verify that the part is acceptable. 

Special Feature Buttons (located above the property editor) 
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Setup Inspection List

Since this tool has the ability to reference the Results properties from up 
to 12 other tools and each referenced tool can have properties that are 

s tool type, a special pop-up dialog is provided to specify the 
 tests.  The following is an example of this dialog page that is 

accessed by pressing the "Setup Inspect List" button above the tool's 
property list. 

specific to it
12 possible

 

Each tool to be accessed can be selected using the pul
box "Inspect Tool".  Once esult
tested can be selected us ll too
basic inspec ypes a d
ResultInspe led / Re Re
addition, some tools ha  te
the "Info()" array of the a
specific Results properties. 

l-down combo 
s property to be 
ls have the same 
 / 
sultAngle.  In 
sted.  Please see 

s to its tool 

a tool is specified, the R
ing the "Inspect Type".  A

vailable: ResultInspectPasse
sultXPos / ResultYPos / 

ve special Results that can be
 selected vision tool for details 

tion t
ctFai
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Once the Inspect Type is selected, the Min/Max inspec
filled in.  The retrieved property values are displayed in the Actual fields 
and the values are color coded to indicate if they fall wi
bounds. 

At the bottom of this dialog panel, there are buttons to a
and testing the tool.  When the "Run List" button is pres
referenced tools are executed and their properties are e

Examples 

Below is an example of a Inspect List tool that is used to locate
parts in the camera's field-of-view.  The FrameSource is a Find   There is a Edge 
Fitter tool that is placed relative to each located object returned
Fitter counts the transitions on each part.  If the count is wrong
not be picked. 

ple, a the center fail  it is missing 

tion limits can be 

thin the Min/Max 

ssist in setting up 
sed, all of the 
valuated. 

 and qualify multiple 
er tool.
 by the Finder. The Edge 
, the part will fail and will 

one of its slots. In this exam part near ed since

  

ach part, only a single tool 
 This simplification is 

Even though multiple tools were utilized to locate and inspect e
result is passed to the connected robot controller for each part. 
especially useful for more complex inspection requirements and when the num
located parts is large.  

ber of 
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See Also 

Vision Toolkit | Inspect Frame 
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Inspect Region Tool 
Inspection tool that inspects the perimeter and the interior of an
determine if there are any flaws in the object's outline or holes i
tool was designed to inspect wafers, where slight changes in th

 are permitted, but chips in the perimeter or interior holes or cracks 

Prerequisites 

FrameSource must be defined

 opaque object to 
n the interior.  This 
e overall size and   

shape of the wafer
are unacceptable. 

 for th ultiple source tools must be 
created that define the perimeter of ected. 

Pr

is tool to execute.  M
the object to be insp

operties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity 
properties

3. Operation

Camera Integer 1 - 6 Standard Operation 
property

FrameSource List n/a 

Name of the required tool 
whose ResultsXPos, 
YPos and Angle are 
taken as the nominal 
Results of this tool. 

PerimeterTool01-12 List n/a 

tools whose results define 
the outline of the region to 

e 

ed 

Series of up to 12 vision 

be inspected.  These 
tools are normally Lin
Fitters, Arc Fitters or 
computed line tools. 
These tools must be list
in sequence as the 

versed in a perimeter is tra
counter-clockwise 
direction.  The located 
lines and arcs plus the 
points of intersection that 
are automatically 

 a 
plied to the 

computed between 
adjacent tools define
mask that is ap
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image to detect flaw
The resulting mas

s.  
k must 

be a closed convex 
shape. 

SetM

 

in 

ct.  This 
 

terior 
flaws.  Any flaw that 

 a smaller 
number of pixels will be 

inBlobArea Integer 0 - n 

binary or edge pixels that 
a flaw must contain 
order for it to be 
considered a defe
test is applied both to
perimeter and in

Specifies the minimum
number of connected 

consists of

ignored. 

SetN

 
 of the 

PerimeterTools, the size 
of the mask can be 
reduced by a few pixels 

e erosion 
line of 
d in 

ewhat 
permits small 

s in the outline to be 

After the mask is 
dynamically generated
from the results

umOfErosions Integer 0 - n via an iterativ
operation.  If the out
the region to be teste
the image is som
rough, this 
error
ignored. 

SetT

ed 
when the ImageMode is 

to black 
For 

is 
ld 
w 

dient edges 
.  The lower 

e 
more sensitive the system 
is in locating edges.  

 

Threshold that is us

hreshold String   

Binary to convert gray 
scale values in
and white pixels.  
EdgeLevel mode, th
specifies the thresho
below which weak (lo
contrast) gra
are ignored
this property is set, th

Please see the 
description of the Edge
Locator for more 
information on edge 
gradients.  The default 
value is 30. 

3A. Advanced Operation

Ima
egion of 
nalyzed 

e geMode List EdgeLevel / Binary 

Specifies if the r
interest is to be a
as a binary or an edg
image. 
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Pro
THRESHOLDED_IMAGE / 

GE / 
ITH_BLOB 

aid.  It permits 
the tool to be stopped at 

 
ep 

 the 

Camera Window.  If this 
property is not set to 
Normal, the results of this 
tool will not be valid since 
the tool will not complete 
its full analysis. 

This is a setup / 
debugging 

cessMode Boolean

NORMAL / 
LINE_ARC_BOUNDARY / 

FLOODED_REGION / 
ERODED_IMAGE / 

EDGE_IMAGE / 

the completion of the
specified processing st
so that the results of
step can be viewed in the 

ANDED_IMA
ANDED_IMAGE_W

ShowPerim

Results of 

ols will be 
displayed.  These results 
can sometimes be useful 
to see, but at other times, 
can clutter the Camera 

eterTool Boolean TRUE / FALSE 

If TRUE, the 
each of the 
PerimeterTo

Window. 
4. Inspection Settings
InspectActual Single   

InspectPassed List Pa s / Fail

Standard Inspection 
Settings properties.  T
InspectActual re

he 
turns the 

number of defects that 
are detected.  If no 
defects are found, the 

o 

s

InspectPassed is set t
Pass. 

Insp
era 

Window.  This provides a 
convenient way to display 
part ID or other 
information. 

ectString String n/a 

Optional label that is 
displayed in the Cam

5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultSelect Integer 1 - n 

ShowResults List NONE / FRAME /  
LINE / POINT 

Standard Results Settings 
properties.  

6. Results
ResultCount Integer 0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm

Standard Results 
properties. 
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ResultYPos Single  mm

Remarks 

This is a specialized inspection tool that is designed to locate chips in the perimeter of a 
smooth convex outline and interior holes and cracks.  This was developed to inspect for 
defects in wafers, whose size and outline might vary slightly from one wafer to the next.  
Since acceptable wafers can vary in their exact size and shape, a fixed mask cannot be 
applied to inspect the perimeter.  Instead, a mask is dynamically generated for each 
image using the results of Line Fitter, Arc Fitter and computed line tools.  These tools 
can locate the actual perimeter to be inspected and can take into account expected 
variations in the outline of the wafer to be inspected. 

This tool can operate on any convex shape whose outline can be defined by 12 lines and 
arc.  An example of acceptable shapes are as follows: 

 

While this tool could be extended to handle outlines with concave features, the following 
shapes are currently not supported. 

 

This tool dynamically generates a mask to compare against the image using the results 
of up to 12 lines and arcs.  The intersection of the lines and arc are automatically 
computed to bound the mask.  Therefore, the lines and arc must be specified in the 
PerimeterTools list in the order in which they appear as you trace around the perimeter 
in a counter-clockwise direction.  After the mask has been created, it can be shrunken if 
desired by a series of erosion operations.  If the object to be tested has slightly rough 
edges, this will eliminate a few pixels along the perimeter from consideration. 
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The region to be tested is then converted to either a binary or an edge image and the 
mask is AND'ed with the converted region.  Any flaws along the perimeter or in the 
interior of the region will be left as non-zero pixels.  A connectivity algorithm is next 
applied to identify any collection of non-zero pixels that are large enough to constitute an 

The number of detected defects are counted and if any defects exist, this tool returns with 
a failure indication. 

ze of flaws 
sk is shrunk before it is applied. 

Examples 

 is an example of a Region Inspect tool that detects missing regions along the 
perimeter of a part.  On the left is a good part that passes.  On the right is a part that fails 

ected defects are 

important defect. 

The sensitivity of the tool can be adjusted using the SetMinBlobArea and 
SetNumOfErosions properties.  These parameters control the minimize si
that are considered defects and how much the ma

Below

due to a missing region along an "arc" and an interior defect.  Any det
automatically highlighted by a bounding red rectangle. 

     

Se

Vis

e Also 

ion Toolkit | Line Fitter | Arc Fitter
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Li  T

d vision to cquires of camera images for a 
period of time, determines ss of each image, 
e brightnes gs in an array for subsequ

ght Recorder ool 

Specialize
specified 

ol that a  a sequence 
the brightne and 

ent analysis. returns th s readin

Prerequisites 

Propert

Utilizes the camera properties (for example the ExposureTime, VideoGain, 
VideoOffset, etc.) defined in the previously executed Acquisition Tool for capturing the 
images required by this tool. 

ies 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 

YPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties. The X and Y va
the center of the to

lues define 
ol.  The Height and 

Width specify the size of the image 
region being tested. 
 
If the referenced camera supports 
hardware AOI to permit faster frames 

reciseVision 
 camera, this 

tool will automatically utilize the 
camera's AOI capability to increase 
the maximum frame rate.  Note, some 
camera's maximum frame rate occurs 
when the AOI is larger than a few 
pixels in each direction, so some 
experimentation with the AOI size 
might be require if the fastest frame 
rate is desired.  

per second rates and P
implements AOI for the

3. Operation
Camera Integer 1 - 6 Standard Operation property
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GrayMode List MEAN / MAX / MIN  
Specifies the type of result to be 
computed and returned for each 
frame.  

DesiredSampleRate Single 0 - n (msec) 

Specifies the desired amount of time 
(in msec) between each acquired 
image.  The actual time will vary 
depending upon the performance of 
the camera and the PC on which 

ion is executed.   If this 
et to 0, images will be 

ly as possible. 

PreciseVis
property is s
acquired as quick

RecordTime Single 0 - n (seconds) 

Defines the period of time during 
which images are acquired, in 
seconds.  The actual results returned 
are limited by how many values can 
be transmitted to the attached motion 
controller.  Currently, at most 3000 
sample results can be returned. 

5. Results Settings

ShowResults List NONE / FRAME / 
LINE / POINT Standard Results Settings property

6. Results
ResultErrorCode Inte   ger
ResultAngle Single -360 to 360
ResultXPos Sin mmgle

YPos Sin mm

Standard Results properties

Result gle

ResultActualTime Sin Actual time in seconds for the 
operation to complete. gle sec

Re

is vision tool capture ce o pecifie
mputes the mean, maximum or mini s of e

 in an array of va is tool w  design
LED.  However, it could al  a tim roximity sensor or 

vel detector. 

 function could be implemented with a combination of other vision tools, this 
 achieve hi e acquisition rates due to reduced overhead between 

e captures.  The i ture rate c pecially
des a h re area of int  (AOI) capability t

PreciseVision. 

To permit a detailed analysis of the results of this tool, two lues are returned for 
each image: 

• The mean, maximum or minim alue ol's 
region of interest (0-255). 

• The number of msec that elapsed from the start of 
start of the next image capture.  This time will differ

marks 

Th s a sequen f images at a s d target rate (in msec), 
ach image, and returns the 
ed to analyze the blinking 

e based p

co mum brightnes
results lues.  Th as originally
pattern of an 
light le

so be used as

While this
tool is able to
imag

gher imag
mage cap an be es  high if this tool is applied to a 

hat is supported by camera that inclu ardwa erest

integer va

 of all pixels within the to

the image capture until the 
 from the target time due to 

um gray-scale v
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variability in the camera acquisition and delays due
If pictures cannot be acquired at the specified rate,
quickly as possible.  The time for the first acquisitio
than subsequent times due to acquisition setup operati

Special Feature Buttons (located above the property editor) 

Execute and Graph 

g this cutes time
d mean, maximum or ale v

captured images.  This provides a quick graphical p  the 
data collected by this tool. 

 to the PC operating system.  
 they will be captured as 
n will be somewhat longer 

ons. 

Pressin
collecte

button exe  the tool a single 
minimum gray-sc

 and displays the 
alue for each of the 
resentation of

 

Sample GPL 

mple GPL program that executes a vision process ("main") that 
ight Reco .  The output  this program for a sample image are 

wing the pro

ub MAIN 
 
    Dim vis As New Vision 
    Dim visRes As New VisResu
 
    vis.IPAddress = "192.168.0

rocess("main
    If vis.ErrorCode = 0 Then 
        visRes = vis.Result("light_recorder",1) 
        Dim ii As Integer 

 For ii = 0 es.InfoCount-1 Step 2 
    Console.WriteLine("Gray:" & CStr(visRes.Info(ii)) & _ 
              " mSec:" & (visRes.Info(ii+1))) 

xt 

Output:

Program 

The following is a sa
includes a L
shown follo

rder tool
gram. 

of

 
Public S

lt 

.112" 
 
    vis.P ") 

        To visR
        
        CStr        
        Ne
    End If 
End Sub 
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Gray:20 mSec:193 

17 mSec:187 
:28 mSec:187 

ec:191 
ec:187 

 mSec:189 
86 
87 

Sec:187 
Sec:189 
Sec:189 
Sec:187 
Sec:187 

Gray:241 mSec:186 

See Also 

Vision Toolkit

Gray:
Gray
Gray:34 mS
Gray:38 mS
Gray:46 mSec:186 
Gray:57
Gray:65 mSec:1
Gray:73 mSec:1
Gray:79 m
Gray:49 m
Gray:29 m
Gray:26 m
Gray:32 m
Gray:84 mSec:192 

 | Acquisition Tool | Pixel Window Tool
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Line Fitter Tool 

e points and returns Vision tool that searches a specified region for edg
the line that best fits the edges. 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size 
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y 
values define the center of the 
tool and the center of the 
search region.  The Height and 
Width specify the size of the 
search region. 

3. Operation 
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

EdgeMode List 

..._NEAREST_DARK /  
..._NEAREST_NOMINAL /  

..._NEAREST_LIGHT /  
..._MAX_GRADIENTS / 

..._MAX_CONCENTRATION  

If multiple lines exist within the 
search region, this parameter 
helps to distinguish which line 
should be returned.  In addition 
to selecting the line closest to 
the dark side, light side, 
nominal (center line), or 
greatest concentration of 
edges, you can also select the 
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line with the highest contrast.  
 
The concentration mode is 
particularly useful if there are 
two or more distinct non-
colinear groups of edges and 
the returned fit line is 

o span multiple 
 If con de 

 th s tool will select 
the largest cohesive group of 
edges as the basis for the line 
fitting. 

attempting t
groups.
is specified,

centration mo
i

EdgeThreshold Integer 0 - 254 

Specifies the threshold below 
which weak (low contrast) 
gradients edges are ignored.  
The smaller the number, the 
more sensitive the system is in 
locating edges.  Please see the 
description ocator of the Edge L  
for more information on edge 
gradients.  The default value is 
30.  

3A. Advanced Operation 

AllowedAngular-
 Single 0.01 

(MAX_CONCENTRATION 
mode only)  This limits the 
orientation of the line that will 
be returned.  It is specified in 
de  
ro  
an
 
In
ar
pa
combination with the MAX_ 
CONCENTRATION mode to 
locate the dominant line with a 
selected orientation. 

Range

grees and is a plus or minus
tation relative to the nominal
gle of the tool.   

 special cases when there 
e multiple uneven edges, this 
rameter can be utilized in 

- 89 (deg)   

BiasFilter List 
..._BIAS_

..._BIAS_TO_LIGHT /  
..._BIAS_TO_DARK 

Fo ar or 
ja  this parameter 
ca
we
that are clo
dark side of the search region.  
For example, for a saw toothed 
pattern, this property could be 
set to fit the line to the tips of 
the high or low points rather 
than along the center line.  

r lines with an irregul
gged edge,
n be set to provide extra 
ight (importance) to edges 

sest to the light or NONE /  

DrawEdgePoints List 
..._NO_EDGE_POINTS / 
..._ALL_EDGE_POINTS / 
..._USED_EDGE_POINTS  

If set, draws yellow dots to 
indicate ALL edge points that 
are selected after the 
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Ed
th
fit  
ap
el  
fo
ch
se
NO
de

geMode is applied or only 
ose edges that are USED to 
 lines after the EdgeMode is
plied and all outliers are 

iminated.  This is very helpful
r understanding the effect of 
anging various property 
ttings. This value is 
_EDGE_POINTS by 

fault.  

MaxEdgePoints Integer 2 - n  

M
po
Hi bers produce 
gr
ex eed.  
Th
pa
automatically limited to the 
number of pixels across the 
width of the tool.  The default 
va

aximum number of edge 
int searches to perform.   
gher num
eater accuracy at the 
pense of execution sp
e minimum value of this 
rameter is 2.  This value is 

lue is 30.  

MaxIterations Integer 

M
fo

es 
 

ne
m
a

di
va

0 - n  

al
ou
ea

aximum number of iterations 
r filtering.  The filtering 
gorithm repeatedly remov
tlier points, refitting the line
ch time, until no more points 
ed to be removed or the 

aximum number of iterations 
ve occurred.  A value of zero 

sables filtering.  The default 
lue is 5.  

h

MinFilterDistance Single 0 - n.nn  

Ab
di
po
th
th
m
be tion 
of
ca
go
Th

solute minimum filter 
stance in pixels.  No edge 
ints closer to the fitted line 

an this are discarded during 
e iterative process.  A 
inimum distance is needed 
cause the standard devia

 distances to the fitted line 
n be less than a pixel with a 
od image of a clean edge.  
e default value is 1.  

Integer 1 - 100  

(M
m
M
pe
th
sp
ac
 
Fo
a very powerful feature to filter 
out short undesirable lines. 

MinPercentEdges  

AX_CONCENTRATION 
ode with BiasFilter only) 
inimum width (as a 
rcentage of the tool's Width) 

at a candidate edge must 
an in order to be an 
ceptable result. 

r special cases, this can be 
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SigmaFilter Single 

Filter width in units of standard 
deviations.  This value is 
mul
deviation of oints’ 
distances to the fitted line to 
compute the distance threshold 
beyond which edge points are 
removed during the iterative 
fitting process.  The default 
value is 1.5.  

0 - n.nn  

tiplied by the standard 
 the edge p

4. Inspection Settings 
InspectActual Single  

List 
NONE / PASS_AND_FAIL / 

S / FAIL / VALUE_REAL / 
VALUE_INTE

InspectLabel PAS
GER 

List 
NONE / ..._RMS / 

..._ANG
NUM_EDGES_FOUND / 

..._NUM_EDGES_USED 

LE / InspectType ..._

InspectMax Single   
InspectMin Single   
InspectPassed List Pass / 

St

Fail

andard Inspection Settings 
properties

5. Results Settings 
OffsetAngle Single degre es 
OffsetX Single mm 
OffsetY Single mm  
ResultOnNotFound Boolean TRUE / FALSE
ShowResults List  / FRAME /  POINT 

Standard Results Settings 

NONE  LINE /

properties

6. Results 
ResultErrorCode Integer   
ResultAngle Single -360 to  360
ResultXPos Single mm
ResultYPos Single mm

St sandard Results propertie

ResultNum-
EdgesFound Integer   Nu

[G (1)] mber of edge points found. 
PL: VisResult.Info   

Integer   

Nu
re
pr 

mber of edge points 
maining after the filtering 
ocess. [GPL: 

ResultNum-
EdgesUsed 

VisResult.Info(2)]  

ResultRMS Single   Root mean square of the line 
fit. [GPL: VisResult.Info(0)]  

Remarks 

The Line Fitter searches the region defined by its green and blue outlined rectangle for 
edge points and fits a line to the edge points using a least squares technique.  By 
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computing the edge positions to a sub-pixel accuracy and by employing multiple such 
edges in its computation, this tool is able to generate very accurate sub-pixel results. 

nd, 

In order to make this tool more discriminating, the Line Fitter only utilizes edges whose 
 

ter 
(nominal) line of the search region at approximately the position and orientation that you 

steps.   

1. All of the edges in the rectangular region are extracted by performing 
MaxEdgePoints number of linear edge searches using the Edge Threshold.  

2. For each edge search, the single edge point that best fits the EdgeMode criteria 
(nearest dark, nearest light, etc.) is retained and the other edge points are 
discarded. 

3. A straight line is fit to the selected edge points. 

Typically, the Line Fitter will perform the fitting process iteratively to increase the 
robustness of the results.  During each line fitting pass, edge points that are too distant 
from the line (outliers) are discarded.  This filters out edges that are not a part of the line 
and whose inclusion would incorrectly offset the result.  MaxIterations specifies the 
maximum number of fits to perform.  After each line fit, edges that are beyond 

terations 
are performed, (ii) no further edges are discarded, or (iii) only two edge points remain. 

Of the various operations, the tool spends most of its time in the first step, extracting all of 
o, the speed and the accuracy of the Line Fitter can be traded-off by 
xEdgePoints.   This property determines how densely the tool scans to 

detect e e minimum 
number ach pixel 
along th e value 
of MaxE
approxi
MaxEd  by a factor of 4, the tool execution time will quadruple but the accuracy 
will only double. 

r to address some unusual cases, the Line Fitter provides special modes of 
ion.  For lines with an irregular or jagged edge, the BiasFilter property can provide 

extra weight (importance) during the line fitting operation to edges that are closest to the 
ht or dark side of the search region.  This has the effect of causing edge points that are 

furthest from the biased edges to be discarded. 

As another special case, if the search area has two or more distinct groups of edges and 
it is not possible to utilize the EdgeMode nearest dark, light or nominal methods to 
distinguish the desired line, the "MAX_CONCENTRATION" mode can be utilized to 
locate the most prominent line.  During Step 2, this method analyzes all of the edge 
points and computes a best guess line within the specified range of orientation that has 
the highest concentration of strong edges.  Then, for each edge search, the point that is 

This tool is very useful for accurately locating straight edges of objects.  Once fou
these fit lines can be used to compute distances between important features or for 
generating reference frames that can accurately locate an object or features in an object. 

dark and light sides have roughly the same orientation as the dark (blue) and light (green)
sides of the search area.  So, when positioning this tool, you should place the cen

expect to find the line with the blue side on the anticipated dark side of the object.  

The operation of this tool is generally performed in the following three 

SigmaFilter standard deviations are rejected, unless the edge is within 
MinFilterDistance pixels of the fit line.  The iterative process stops if (i) MaxI

the edges.  S
adjusting Ma

dges.  This parameter must be set to at least 2 in order to detect th
 of edges to define a line.  At most, one edge search is performed for e
e width of the Fitter.  Execution time increases roughly in proportion to th
dgePoints.  On the other hand, the accuracy of the tools increases 

mately as the square root of MaxEdgePoints.  That is, if you increase 
gePoints

In orde
operat

lig
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closest to this best guess line is retained and all other edges points are discarded.  Step 
3 progresses as usual to compute the best fit line to the selected edge points. 

At the conclusion of the Line Fitter, the center position and orientation of the best fit line 
ical data on the number of edges finally used and the root 
turned.  This statistical data indicates the quality of the 

final fit and can be tested via the "Inspect Settings" to yield a pass/fail indication for the 

Special Feature Buttons (located above the property editor) 

Adjust Threshold 

tton displays a pop-up window that permits the value of 
the Edge Threshold property to be manually adjusted while dynamically 
viewing the effect of the new setting in the Camera Display.  The edges 
that satisfy the threshold criterion are displayed in white. 

Examp

llowing example, two Line Fitters are utilized to accurately determine the 
sitions and orienta the straight s of an object.  A Computed Line-Line 

ction tool then take f the two Fitters and generates a reference frame 
hose origin is at the ction of the  fit lines.  Since the two Line Fitters compute 

ts based upon multiple pixel values, their output values are very accurate. 

are returned.  In addition, statist
mean square of the line fit are re

operation.  

Pressing this bu

les 

In the fo
po tions of  side
Interse
w

s the output o
 interse two

their resul

 

here the outer or inner edge of a 
itter is applied with

The followi
series of f

ng example de rates t l case w
ingers is to b ated.  F  

NE, the fit line is loca ere along the center of the fingers.  
rly locate th r outer edge f the fingers, the BiasFilter should be set to 
_BIAS_TO_ r FITLINE_BIAS_TO_LIGHT.  

monst
e loc

he specia
 If the standard Line

ted somewhFITLINE_BIAS_NO
To prope e inner o  o
FITLINE DARK o

164 



Vision Toolkit Description 

 

The following example demonstrates the special case where there are a series of closely
spaced discontinuous parallel edges and you wish to locate the strongest edge.  If you 
are not able to accurately position the finder and use EdgeMode to distinguish the 

 

 the 
re 

e fitting.  

desired line by specifying the nearest light, dark or nominal, 
FITLINE_MAX_CONCENTRATION may be of use.  This method locates the line with
greatest concentration of strong edges and uses this to select the edge points that a
considered during the iterative lin

 

See Also 

Vision Toolkit | Arc Fitter | Edge Locator | Find Centerline Tool | Point-Point Line Tool 
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Line-Line Frame Tool 

Comp
vision 

utational tool that determines the intersection of two lines defined by 
objects and returns a reference frame. 

Prerequisites 

ion o that each s ther a line or a frame

Pro

Requires two vis bjects upply ei . 

perties 

Property Name Data 
Type Ra   nge Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceLine1Name n/a 
Name of the vision object that defines 
the line that determines the X-axis of 
the computed reference frame. 

List 

SourceLine2Name 
Name of the vision object that defines 
the second line that is intersected with List n/a 
the first line. 

4. Inspection Settings 
InspectActual Single  

InspectLabel 

NO  / 
PASS_AND_FAIL / 

PASS AIL / 
VA

VALUE_INTEGER 

List 

NE

 / F
LUE_REAL / 

InspectType List NONE / 
ULT_ANRES GLE 

InspectMax Single   
InspectMin Single   
InspectPassed List Pass / Fail

Standard Inspection Settings 
properties.  Can be used to validate 
the ResultAngle. 

5. Results Settings 
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OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE

 List NONE / FRAME / LINE 
/ POINT 

opertiesStandard Results Settings pr

ShowResults

6. Results 
ResultAngle Single -360 to 360
Res mmultXPos Single 
ResultYPos Single mm

sStandard Results propertie

Remark

s computational tool combines the results of two vision tools to compute a new 
el 

e 

ute the position of a corner of an object as 
determined by its two adjacent straight sides. 

Examples 

The following example illustrates how two Line Fitters can be applied to accurately 
identify the position and orientation of two adjacent sides of an object.  The results of the 
two Fitters are then fed into a Line-Line Frame Tool to yield a reference frame that 
accurately represents the position and orientation of the enclosed corner. 

s 

Thi
reference frame.  The inputs to this method from the vision objects are two non-parall
lines.  The X-axis of the new reference frame will be collinear with the first input line.  Th
origin of the new frame will be at the point where the two lines intersect. 

This method is often used to uniquely define the position and orientation of a simple 
object or a section of an object.  The resulting reference frame can then be used to 
position additional vision tools.  

Alternately, this method can be utilized to comp

 

See Also 

Vision Toolkit | Fixed Frame Tool | Point-Line Frame Tool | Point-Point Line Tool 
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Pixel Window Tool 

Vision tool that counts pixels of a specific type or computes pixel 
statistics within a rotated rectangular or circular region. This tool is 
typically used to quickly determine if a feature is present or to verify that 
the average gray-level reading of a region is correct. 

Prerequisites 

None 

Properties 

Property Name Data 
Type R e  ang Description 

1. Identity 
Name String n/a 
Type String 

S
n/a

tandard Identity properties

2. Placement/Size 
Angle  Single -360 to 360 
Height Single  0 - AOI (mm)
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos  0 - AOI (mm) Single
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 
define the ce
b
W
r

nter of the region to 
e processed.  The Height and 
idth define the dimensions of the 

egion.  

3. Operation 
Camera Integer 1 - 6 
Relative-ToolName 

S
List n/a 

tandard Operation properties

PixelMode List  
BINARY_STATS / 
GRAY_STATS / 
EDGE_LEVEL  

W
o nt 
m
 
"
w
t
"  
s . 

hen this tool executes, it 
perates in one of three differe
odes: 

BINARY_STATS" counts 
hite/black pixels after 

hresholding. 
GRAY_STATS" returns gray-level
tatistics (i.e. mean gray-levels)
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" e 
p  
a
 
W  is only relevant 
f  
l
E

EDGE_LEVEL" counts edg
ixels after a gradient operator is
pplied. 

here a property
or a specific mode, the property is
abeled as BINARY, GRAY or 
DGE. 

CountWhitePixels Boolean TRUE / FALSE  

(BINARY) If TRUE indicates that 
the white pixels are to be 
c ixels 
a
ounted.  Otherwise, black p
re counted. 

Threshold Integer 0 - 254 

(BINARY) This is the value used 
to convert gray scale values into 
black and white pixels. 
 
( his value is ignored. 
 
(EDGE) Specifies the threshold 
below which weak (low contrast) 
gradi
l more 
sensitive the system is in locating 
edges.  Please see the description 
o

GRAY)  T

ent edges are ignored.  The 
ower this property is set, the 

f the Edge Locator for more
nformation on edge gradients. 

0. 

 
i  
The default value is 3

ToolShapeType List 
RECTANGULAR / 

RO ND / 
SQUARE 

S
p
w
to 1:1. 

U

hape of the window in which the 
ixels are analyzed.  A square 
indow has its aspect ratio forced 

4. Inspection Settings 
InspectActual Single  

Insp
VALUE_REAL / 

ectLabel List 

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 

VALUE_INTEGER 

InspectType List 

NONE / MEAN / 
NUM_PIXELS / 

STANDARD_DEV / 
MINPIXELVAL / 
MAXPIXELVAL / 

PIXELSUM / 
PIXELSUMSQUARE 

Insp

Standard Inspection Settings 
properties

ectMax Single   
InspectMin Single   
InspectPassed List Pass / Fail
5. Results Settings 
OffsetAngle Single degrees Standard Results Settings 
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OffsetX Single mm 
OffsetY Single mm 

properties

 

ShowResults List NONE / FRAME / 
LINE / POINT 

6. Results 
ResultErrorCode Integer   
ResultAngle Single 0 (non-rotating)
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties 

nd Y position 
represent the centroid of the 
counted binary or edge pixels. 

 
(BINARY,EDGE) X a

ResultPixel
(BINARY,EDGE) Total number of 

els in 
n. [GPL: Count Integer   counted binary or edge pix

the rectangular regio
VisResult.Info(0)]

ResultMean
cale value of 

n. [GPL:  Single   
(GRAY) Mean gray-s
all pixels in the regio
VisResult.Info(1)]

ResultMaxPixelValue Integer   
(GRAY) Maximum gray-scale 
value of all pixels in the region. 
[GPL: VisResult.Info(4)]

ResultMinPixelValue Integer   
(GRAY) Minimum gray-scale value 
of all pixels in the region. [GPL: 
VisResult.Info(3)]

ResultPixelSum Integer   
(GRAY) Sum of gray-scale values 
of all pixels in the region. [GPL: 
VisResult.Info(5)]

ResultPixelSumSqr Integer   

(GRAY) Sum of the squares of the 
gray-scale values for all pixels in 
the region. [GPL: 
VisResult.Info(6)]

ResultStandardDev Single   

(GRAY) Standard Deviation of the 
gray-scale values for all pixels in 
the region. [GPL: 
VisResult.Info(2)]

Remarks 

This tool very quickly processes a rectangular or circular region of a gray-scale image 
and either counts black or white pixels after thresholding, counts edge pixels after 
applying a gradient operator or collects image statistics, such as mean, maximum, 
minimum and standard deviation of the pixel gray-scale values. 

This tool provides a very efficient means for quickly extracting gross statistical information 
about a rectangular or circular region.  This tool is often used to quickly verify the 
presence of a feature or obstacle or to collect gray-scale statistics.  For example, this tool 
can be employed to inspect a part to ensure that expected holes are present or that tabs 
have been removed.  The BINARY mode can be applied to detecting defects in a uniform 
area such as inspecting for scratches or pits in a lens.  The GRAY mode can be used as 
a simple light meter to adjust the threshold for other operations or can determine the 
gray-scale uniformity of the region. 
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When this tool is operated in the BINARY mode, the specified region is converted to 
white and black pixels based upon the Threshold property.  Then, either the white or the 
black pixels are counted based upon the CountWhitePixels property.  The number of 
counted pixels and the centroid of all of the positions of the counted pixels are returned in 

If this tool is operated in the EDGE mode, the specified region is converted to edge pixels 
ng 

centroid 
ed in the results. 

ool is operated in GRAY mode, statistics are collected on all of the pixel gray-scale 
values within the specified region.  The returned results include the mean value, 

um value, minimum value, sum of the squares, and standard deviation. 

ture Buttons (located above the property editor) 

Adjust Threshold 

Pressing this button displays a pop-up window that permits the value of 
the Threshold property to be easily adjusted while dynamically viewing 
the effect of th tting in the era Display.  In BINARY mode, 
the displayed image shows all pixe nverted to black or white, where 
the white pixels are the ones that a ounted.  In EDGE mode, the edge 
pixels that are extracted and will be counted are displayed in white. 

Se

Vision Toolkit

the results. 

using a gradient operator and the setting of the Threshold property to select only stro
edges.  Then, the edge pixels are counted.  The number of edge pixels and the 
of all of their positions are return

If this t

maxim

Special Fea

e new se Cam
ls co
re c

e Also 

 | Pixel Color Window
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Pixel Color Window Tool 

Vision tool that tests if the color of a region matches a trained colo
r image, this tool compute

ity value for a sp gion and determines if eac
an acceptable tolerance of the trained value for the color l

r. Within 
s the mean 
h mean is within 
ayer. 

each of the RGB layers of 
intens

a colo
ecified re

Prerequisites 

Requires a color camera. 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
N String  ame n/a
T ing n/a

Standard Identity properties
ype Str

2. Placement/Size 
Angle Single 0 (non rotating) 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAn Single 0 gle 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X an
values define the center of 
the region to be processed
The Height and Wid

d Y 

.  
th define 

the dimensions of the region.

3. Operation 
Came  1 - 6 ra Integer
Relative-ToolName List n/a 

Standard Operation 
properties

ToleranceBlue Integer 0-100%  
ToleranceGreen Integer 0-100%  

Define the tolerances that 
must be satisfied between 
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ToleranceRed Integer 0-100%  

the computed mean intensity 
values of the specified region 
in each color layer and the 
corresponding trained mean 
values.  For example, if the 
ToleranceBlue is set to 5%, 
the computed mean of the 
pixel values in the specified 
region of the blue color layer 
must be within +/-5% of the 
InspectNominalBlue value 
for the inspection to return 
"Pass".. 

ToolShapeType List  RECTANGULAR / ROUND / 
SQUARE  

Shape of the window in 
which the pixels are 
analyzed.  A square window 
has its aspect ratio forced to 
1:1. 

4. Inspection Settings 
InspectActualBlue Integer 
InspectActualGreen Integer 
InspectActualRed Integer

0-255  

InspectLabel List 
NONE / PASS_AND_FAIL / 

PASS / FAIL / VALUE_REAL 
/ VALUE_INTEGER 

InspectType List  
NONE / 

RESULT_NORMALIZED / 
RESULT_FIXED  

InspectPassed List Pass / Fail

Standard Inspection Settings 
properties.  In the 
RESULT_FIXED mode, the 
tolerance comparison is 
performed with the raw 
nominal and actual mean 
intensity values. This can be 
used when the lighting is 
very controlled and the 
product color does not vary.  
In the 
RESULT_NORMALIZED 
mode, the nominal and 
actual mean values are 
adjusted each time the tool is 
executed to compensate for 
uniform variations in the color 
intensity values. This enables 
the color matching to be 
robust even when there is 
some variation in the lighting.

InspectNominalBlue Integer
InspectNominalGreen Integer 

InspectNominalRed Integer 
0-255 

These properties define the 
nominal mean values for the 
three color layers.  These 
values are compared to the 
actual mean values for the 
color layers in the region of 
interest to determine if the 
color matches the expected 
value.  These values are 
typically taught by pressing 
the Train Color button (see 
below). 

5. Results Settings 
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OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 

ShowResults List NONE / FRAME / LINE / 
POINT 

Standard Results Settings 
properties

6. Results 
ResultErrorCode Integer   
ResultAngle Single 0
ResultXPos Single mm
Resul

Standard Results properties

tYPos Single mm

ResultMeanBlue Single 0-255 
Mean color value of pixels in 
specified region. [GPL: 
VisResult.Info(2)]

Re Single 0-255 
Mean color value of pixels in 
s . [GPL: sultMeanGreen pecified region
VisResult.Info(1)]

R eanRed Single 0-255 
Mean color value of pixels in 

[GPL: esultM specified region. 
VisResult.Info(0)]

ResultPercentBlueMatch Integer 0-100 Match percentage for a color 
layer [GPL: VisResult.Info(5)]

ResultPrecentGreenMatch Integer 0-100  for a color 
)]

Match percentage
layer [GPL: VisResult.Info(4

ResultPrecentRedMatch Integer 0-100 or 
3)]

Match percentage for a col
layer [GPL: VisResult.Info(

ResultHSVI_Hue Single 0-360 
Mean Hue (color) of the 
pixels in the specified region 
[GPL: VisResult.Info(6)]

ResultHSVI_Saturation Single 0-255 

 

cified region [GPL: 

Mean Saturation (intensity of
the Hue) of the pixels in the 
spe
VisResult.Info(7)]

R alue Single 5 esultHSVI_V  0-25

Maximum lightness of the 
RGB color in the specified 
region [GPL: 
VisResult.Info(8)]

R nsity Single 0-255 

Mean lightness or darkness 
of the color in the specified esultHSVI_Inte region [GPL: 
VisResult.Info(9)]

Re

This tool compares the gene nterest with a taught color and returns 
a Pass/Fail indication of whether th tched within a specified tolerance.  The 

n be def  rectangular, square or circular shape.  The color of the region 
ined by computing the mean in nsity value for each of the three color layers 

n values are compared against three taught mean values.  If all 

marks 

ral color of a region of i
e colors ma

region ca ined as a
is determ
(RGB).  These actual me

te
a
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three pairs o
match and this tool retu

f numb re within specified % tolerances, the colors are considered to be a 
rns a pass indication. 

 the ro s of this tool  the lightin
Type can be set to RESUL ORMALIZE

nominal values and the actual computed mean intens
all brightness of the region of interest. 

always  all three s of the captured color image independent 
of which layer the Acquisiti aded into the current frame buffer. 

ssist in teach ool, the cen  the tool is always di
parent circul hat is tinted with the mean c

d in the following picture where the center is tinted in blue. 

er a

To improve
Inspection

bustnes  when
T_N

g conditions may vary, the 
D.  In this mode, the taught 

ity values are adjusted for the over-

This tool accesses  color layer
 picture on Tool lo

To a ing this t ter of splayed with a semi-
olor for the region of interest.  This trans ar area t

is illustrate

 

In addition, the camera display window can always be switched into color display mod
by pressing on the "Toggle Color Display Mode" button in the main Toolbar. 

 Feature Buttons (located above the property editor) 

Train Color

e 

Special

 

current mean values of the selected region of the currently displayed 
image. 

Exampl

See Also 

Vision 

Pressing this button assists in teaching the color for the region of 
interest.  After confirmation, the values for the InspectNominalRed, 
InspectNominalGreen, InspectNominalBlue properties are set to the 

es 

none 

Toolkit | Pixel Window
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Point-Line Frame Tool 

Computational tool that takes a point and a line from two vision objects 
and returns a reference frame. 

Prerequisites 

Requires two vision objects, one of which supplies a line or a frame and the other of 
which supplies a point. 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceLineName List n/a Name of the vision object that defines 
the line. 

SourcePointName List n/a Name of the vision object that defines 
the point. 

4. Inspection Settings 
InspectActual Single  

InspectLabel List 

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 

InspectType List NONE / 
RESULT_ANGLE 

InspectMax Single   
InspectMin Single   
InspectPassed List Pass / Fail

Standard Inspection Settings 
properties.  Can be used to validate 
the ResultAngle. 

5. Results Settings 
OffsetAngle Single degrees Standard Results Settings properties
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OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE

ShowResults L

 

ist NONE / FRAME / LINE 
/ POINT 

6. Results 
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

This computational tool combines the results of two vision tools to compute a new 
reference frame.  The inputs to this method from the vision objects are a line and a point 
that is not on the line.  The X-axis of the new reference frame will be collinear with the 
input line.  The Y-axis of the new frame will pass through the specified point. 

This method is often used to uniquely define the position and orientation of a simple 
object or a section of an object.  The resulting reference frame can then be used to 

closest to the input point. 

The following example illustrates how a Line Fitter and an Edge Locator can be applied to 
accurately identify the position and orientation of one side of an object and a point on a 
perpendicular side.  The results of the Fitter and Locator are then fed into a Point-Line 

ately represents the position and 
n of this reference frame also specifies 

position additional vision tools.  

Alternately, this method can be utilized to compute the distance between a point and a 
line since the origin of the generated reference frame defines the position on the line that 
is 

Examples 

Frame Tool to yield a reference frame that accur
orientation of this section of the object.  The origi
the point on the line that is closest to the point determined by the Edge Locator. 

 

See Also 

Vision Toolkit | Fixed Frame Tool | Line-Line Frame Tool | Point-Point Line Tool 
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Point-Point Line Tool 

Computational tool that computes a line given two points from vision 
objects. 

Prerequisites 

Requires two vision objects that each supply either a point, a line or a frame. 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourcePoint1Name List n/a Name of the vision object that defines 
one of the two points on the line. 

SourcePoint2Name List n/a Name of the vision object that defines 
one of the two points on the line. 

4. Inspection Settings 
InspectActual Single  

InspectLabel List 

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 

InspectType List NONE / 
RESULT_ANGLE 

InspectMax Single   
InspectMin Single   
InspectPassed List Pass / Fail

Standard Inspection Settings 
properties.  Can be used to validate 
the ResultAngle. 

5. Results Settings 
OffsetAngle Single degrees 
OffsetX Single mm 

Standard Results Settings properties
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mm OffsetY Single 
Resul tFou TRUE / FALSEtOnNo nd Boolean 

ShowResults List NO NE / FRAME / LINE 
/ POINT 

 

6. Results 
ResultAngle gle 360 Sin -360 to 
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

This om s
inpu  to i
interc p ne

Once co g line
referenc tum fo

ow two Edge Locators can be applied to find two 
reference points on the edge of an object to sub-pixel accuracy.  The results of the two 

e frames.  Note that, in 
general, a more accurate line fit can often be obtained using the Line Fitter Tool.  
However, there are incidences where an edge is non-uniform and selecting two good 
points to construct a line is advantageous. 

c
ts

putational tool combine
 this method from the vis

 the results of two vision tools to compute a line.  The 
on objects are two points.  The resulting line will 

e t each of the two input li s. 

mputed, the resultin
e frames or as a da

 can be combined with other vision results to establish 
r measurements. 

Examples 

The following example illustrates h

Locators can then be fed into the Point-Point Line Tool to compute a line that represents 
the location of one side of the object.  This line can then be combined with other tools to 
measure the dimensions of the object or to establish referenc

 

See Also 

Vision Toolkit | Fixed Frame Tool | Line-Line Frame Tool | Point-Line Frame Tool | Line Fitter Tool
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Sensor Window Tool 

Vision tool that detects part movement or no movement within a specified 
region of the image. This tool takes multiple camera images in 
succession using a single camera and determines if there are any 
significant changes. 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 

Standard Placement / Size 

  

properties.  The X and Y values 
define the center of the tool.  The 
Height and Width specify the size 
of the image region being tested. 

3. Operation 
Camera Integer 1 - 6 Standard Operation property

DelayAfterComplete Single 0 - n 

Specifies an amount of time to 
wait after the operation is 
completed (post-processing dwell 
time). 
Specifies the threshold below 
which weak (low contrast) 

EdgeThreshold Integer 0 - 254 more sensitive the system is in 

gradients edges are ignored.  
The lower this property is set, the 

locating edges.  Please see the 
description in the Edge Locator 
Tool for more info
edge gradients.  The defaul

rmation on 
t 

value is 30. 
Maximu i m time (in mT meout Single 0-n (seconds) Specifies a maximu
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seconds) that the tool will 
execute. If this time is exceeded, 
the tool stops processing and 
returns an error. 

Pixe

If more than this specified 
number of edge pixels change 

is 

been detected. 

lChangeAmount Integer 0-n between successive images, th
tool declares that motion has 

Sen OTION_START this tool. The default is to "wait 
for no motion". 

seMode List WAIT_MOTION_STOP / 
WAIT_M

Specifies the operating mode of 

3A. Advanced Operation 
ExposureTime Integer   
VideoGain Integer   
VideoOffset Integer   

Same properties as in the 
Acquisition Tool.  See that tool for 
details. 

5. Results Settings 

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings 
property

6. Results 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultActualTime Single sec
Actual time in seconds for 
operation to complete. [GPL: 
VisResult.Info(1)]

ResultPixelCount Integer   
Actual number of pixels detected 
during the operation. [GPL: 
VisResult.Info(0)]

Remarks 

 images to detect how many edges are changing.  Based upon the number of 
changed edges, this tool decides upon whether any movement has been detected. 

This tool determines movement by performing the following operations.   First, it acquires 

ges are counted and compared to the 
PixelChangeAmount to determine is sufficient pixels have changed to declare that 

This motion sensing tool acquires a series of pictures sequentially and compares 
successive

a new image.  Then the new image is subtracted from the previous image.  A cross 
gradient edge extraction algorithm is performed across the resulting image and the edges 
are thresholded to produce a binary image.  The binary image is eroded to eliminate 
insignificant changes.  The resulting binary ed

movement has been detected.  Based upon the setting of the SenseMode property, this 
tool either takes another picture and repeats the process or it terminates.  

This tool requires successive images so a minimum of two pictures are always taken.   
During this operation, no graphics are displayed on the screen.  A dialog is placed above 
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the vision window to indicate that the operation is in progress and permits the operator to 
abort the tool. 

This tool can be applied in applications where parts may be falling or moving (e.g. rolling 
parts). Instead of applying a worst case fixed delay time, the S
used to ensure the parts are not moving before locating or executin

ensor Window Tool can be 
g the remaining 

processes. 

Special Feature Buttons (located above the property list): 

Show Motion Image 

Displays the output of comparing a single pair of images. Any pixels that 
are detected as changed (moving) are drawn in white.  If zero motion is 
taking place, the entire image will be black. 

Test Motion (Continuous) 

Places tool in a continuous execution mode that allows the user to see 
the results of the motion dynamically. A small dialog box will appear in 
the center of the vision window that displays the number of pixel counts 
sensed as being in motion. Click the 'abort' button on the dialog to stop 
the test operation. 

See Also 

Vision Toolkit | Acquisition Tool | Edge Locator Tool
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Text Label Tool 
Text labeling tool that displays string constants plus inspection and results data from 
a referenced tool.  Text is shown in the Camera Display Window relative to the 
position of the referenced tool. 

  

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Typ

Standard Identity properties
e String n/a

2. Placement/Size 
Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 
define the starting point for the text 
output and the Angle defines the 
orientation of the text string. 

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceToolName List  n/a Name of the vision object whose 
results are displayed by this tool. 

EnableResultName Boolean  True / False specified by ResultToolInfo will 
automatically be included in the 
output text string. 

If True, the name of the results data 

NONE / InspectPass

This is a list of Inspection and 
Results properties that can be 

ResultToolInfo List ResultXPos / 
ResultYPos / 

ResultAngle / ... 

a function of the type of the tool 
selected by SourceToolName. For 
most too

ed 
/ InspectFailed / displayed.  The items in the list are 

ls, at least the properties 
listed in the Range field are 
available. 

TextColor Window 
Color n/a Permits the font color to be 

selected from the system color 
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Selector palette. 

TextForceZeroAngle Boolean  True / False   

If True, will force the output text 
string to have a zero Angle even if 
the text is relative to a source tool 
whose result is rotated. 

TextOut t
ould 

pu Type List FORMAT_REAL be output as integer or real 
numbers. 

FORMAT_INTEGER / Defines if numerical values sh

TextSize 
utput 
 (not Integer  1 - 50 

Specifies the font size of the o
string as a Windows Font Size
in pixels). 

TextTitle 

d at the 

e 

iter pipe 
character '|'. When this character is 
encountered, subsequent items will 
automatically be placed on the next 

String  n/a 

Optional string that is place
start of the output text. This 
provides a way to customize th
label for the results data. For 
multiple lines use the delim

line, including the results. 
5. Results Settings 

ShowResults List NONE / FRAME / LINE Standard Results Settings 
/ POINT properties

6. Results 
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

This tool displays text labels either in fixed positions in the Camera Display Window or 
relative to the results of other tools.  If the text tool is relative to a source tool, the text can 

NOTE:  This tool cannot be specified as one of the source tools in an Inspect List Tool. 

Examples 

automatically include the values of selected Inspection and Results properties of the 
source tool. 

Below is an example of the Text Label Tool.  In this example, each of the objects that 
has been located by a Finder Tool is labeled with the Finder's recognition score. 
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See Also 

Vision Toolkit
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Tool Filter Tool 
Filter tool that takes the output from another vision object that generates multiple sets 
of results, and returns a subset of the results based upon specified criteria.    

Prerequisites 

Requires another vision object that generates multiple sets of results.  

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceToolName List n/a 
Name of the vision object that outputs 
multiple sets of results.  These sets of 
results serve as the input to this tool.  

3A. Advanced Operation  

SortResults List 

NONE / 
SORTFROMLEFT / 

SORTFROMRIGHT / 
SORTFROMTOP / 

SORTFROMBOTTOM  

Automatically sorts the results based on 
the selection. This is useful for items on 
a conveyor belt that may need to be 
picked in order from the front to back of 
the conveyor. 

ZeroAngle Boolean True / False  

If True, will force the ResultAngle to 
ZERO. This is useful for randomly 
oriented parts that require the angle to 
be removed for picking. This operation 
does NOT change the sorting 
operation.  

4. Inspection Settings 
InspectActual Single  

InspectType List 

NONE / RESULT_ID / 
RESULT_X_POS / 
RESULT_Y_POS / 
RESULT_ANGLE / 

RESULT_INSPECT_-
STATUS  

InspectMax Single   
InspectMin Single   

Standard Inspection Settings 
properties.  All of the sets of results 
generated by the SourceToolName 
object are tested against this inspection 
criteria and those that pass become the 
output of the Tool Filter. 
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InspectPassed List Pass / Fail  

InspectString String n/a 

Optional label that is displayed in the 
vision window on all input results that 
satisfy the inspection criteria.  This 
provides a convenient way to display 
part ID or other information. 

5. Results Settings 
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultSelect Integer 1 - n 

ShowResults List NONE / FRAME / LINE / 
POINT 

Standard Results Settings properties

6. Results 
ResultCount Integer 0 - n
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

This tool inputs the results from another vision object that generated multiple se
results, and applies criteria specified by the "Inspection Settings" to filter the resu

ts of 
lts.  This 

allows a process to isolate results that require further special processing or to create 
queues of results based upon specified criteria.  Multiple Tool Filters can be applied to 
the same vision object to allow all of the results of the input tool to be segmented and 
processed. 

For example, if the input tool is a Finder, special processing can be applied to all objects 
located by the Finder that are in a specific region of the screen by defining a Tool Filter 
with the InspectType set to "RESULT_X_POS" or "RESULT_Y_POS".  

Examples 

Below is an example of a single Finder that has located 6 identical parts.  You will note 
that the bottom left part was used as the tool template, so that all future part orientations 
will be with respect to this horizontal position with the top of the "T" pointed to the right.  
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If we now wish to segment these 6 parts by their orientation, we can apply a Tool Filter 
that references the output of the Finder by specifying the Finder's name as the Filter's 
SourceToolName.  By setting the Tool Filter's InspectType to "RESULT_ANGLE", we 
can select only those parts with a specific orientation.  If we set the InspectMin and 
InspectMax to -90 degrees and 90 degrees respectively, only those objects that are 

as the output of the Filter.  We can also 

ote 
ool Filter.  If we 

wanted to further process these four parts, the Tool Filter output could be utilized as the 
ool.  

approximately pointed to the right will be selected 
add a label to these parts by filling in the InspectString.  The picture below shows the 
results of this filter where InspectString has been set to "Pointed Right".  You will n
that only four of the six parts located by the Finder will be output by the T

input to yet another t

 

See Also 

Vision Toolkit | Finder Tool 
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nvert camera pixel 
positions into real world units of measure, typically millimeters. For robot guidance, this calibration also 
translates came its a robot to grasp a part 
that has been lo spect to a 
robot before a v s
PreciseVision is ed), 
since the calibra
perpendicular to the imaged plane, which cau s 
parts rotate to e omputed the same independent of the part's 
orientation. 

So, when a cam n data should be 
updated if a nt camera 
lens is used or t ered. In general, it is always best to calibrate each 
camera that is place er any of the optical characteristics of a camera are 
modified. 

In the next section, e n methods are 
presented.  This is follow ethods. 

tions 
This section includes descriptions of general procedures that apply to all calibration methods.  This 

o executing any of the calibration methods.  

Standard Calibration Target Sheet

Camera Calibration Introduction 
The PreciseVision camera calibration procedures generate the data necessary to co

ra positions into the robot's world coordinate system.  This perm
cated by the vision system.  Consequently, a camera must be calibrated with re
ision-guided application can be executed.  Even for simple vision te ting where 
 not communicating with a robot, calibration is still highly desirable (but not requir
tion process corrects for non-square pixels and cameras that are not perfectly 

ses perspective distortion.  This correction is important a
nsure that dimensions are always c

era is first put into use, it should be calibrated.  In addition, calibratio
 camera with different optical characteristics is utilized, a camera is moved, a differe

he length to the focal plane is alt
d into service and whenev

gen ral instructions and information that apply to all calibratio
ed by information concerning the various calibration m

General Calibration Instruc

section should be read prior t

 

sion between camera pixel positions and 
millimeters. In most cases, PreciseVision determines this relationship based on viewing a Standard 

tomatic motion. This sheet looks like the following: 

All calibration methods are required to establish the conver

Calibration Target Sheet that contains patterns of squares that have a known size and pitch. Three 
different pattern sizes are provided to accommodate different camera fields of view.  The target sheet can 
be used without a robot or any au
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This target shee

Start > 
Precise ationTarget.pdf 

or by brows t

\Program Files\Precise Automation\PreciseVision 
#.#\resource\PreciseVisionCalibrationTarget.pdf 

The calibration target sheet should be printed out at the highest possible resolution and quality.  When 

atures to be 
located or inspected. 

Camera Setup

t is provided as a .pdf file and can be found via the Windows Start menu: 

Programs > Precise Automation > PV xxx > Documentation > 
VisionCalibr

ing o the “\resource\” folder created upon installation of PreciseVision. 

you are instructed to do so, this sheet should be placed in the focal plane of the camera. The focal plane 
of the camera should be as close as possible to the actual Z height of the primary part fe

 

Prior to exe nd 
carefully setup. he 
aperture and foc If the 
camera is not in  camera 
gain and offset ge should be set by selecting Tool > 

.  

cuting a calibration process, the camera must be rigidly mounted, selected in software a
The camera can be selected from the View > Select Camera top-level menu.  T
us can then be manually set by viewing the camera image in "live video" mode.  
 this mode, it can be initiated by pressing an icon in the main toolbar.  Finally, the
that control the brightness and brightness ran

Camera Video Properties 

Camera Calibration Wizard 
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When you select Tool > Calibrate Vision > Camera Calibration Wizard, a wizard is initiated and the 
following pop-up is displayed. 

 

This wizard takes you step-by-step through the process of calibrating a camera either for standalone 
vision or for a vision-guided robotic application with the camera mounted in a variety of configurations.  
The instructions are fairly self-explanatory. 

While each page of the wizard is different, the following toolbar buttons are available on every page to 
assist you with the calibration process. 

CalibrationWizard Toolbar 

Icon Tool Tip Title Description 

 Live Video  Continuously updates the displayed camera image to 
show a "live" image.  

 Single Picture Captures a single picture (snap shot) from the selected 
camera.  

 Load Robot Calibration  

Displays a pop-up file folder window that permits an 
existing vision calibration file to be selected and loaded. 
This allows an old calibration file to be loaded and 
tested.  

 Save Robot Calibration  Displays a pop-up file folder window that permits the 
current calibration data to be saved to a disk file.  

 Continuous Threshold  Updates the displayed camera image as a thresholded 
binary image instead of the standard gray scale.  

 Open Threshold Tool  threshold for the binary image.  
Displays the pop-up that permits changing the 

 libration  default (unity scaling).  Reset Ca Provides a way to reset the camera calibration to its 
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Calibration Layout  

ra Calibration Wizard is selected, the layout of the main PreciseVision windo
anges to the following "Calibration Layout". 

When the Came w 
automatically ch

 

This arrangement has a large Camera Display Window on the left and a panel on the right that is 
provided as a convenience for moving a robot in manual control.  The robot panel is utilized if a camera-
to-robot calibration is performed.  The Calibration Wizard includes a panel for connecting to a robot 
controller.  When this connection is established, the manual control panel becomes active.  

To switch back to the default arrangement for the main PreciseVision window, select View > Layouts > 
Load Default or View > Layouts > Load Edit Layout.  

Calibration Data Files  

Calibration information is stored in disk files with a “.dat” extension. By default, these files are stored in 
the “ExampleProjects” folder in the PreciseVision directory. For example, for the default installation 
directory for PreciseVision version 1.2, the calibration files will be stored in the following directory:  

C:\Program Files\Precise Automation\PreciseVision 3.0\ExampleProjects  

After a calibration data disk file has been created, it has to be specified in each Vision Project in which it 
is to be used.  When a Vision Project is opened, to associate a calibration file with a camera, open the 
Camera Calibration Configuration pop-up by selecting Tool > Camera Calibration Configuration.  The 
pop-up panel should appear as follows: 
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Click the Load button to select a calibration file to be associated with a camera.  A dialog window will be 
displayed th
you wish to e button. 

Once a camera calibration file is specified in the Camera Calibration Configuration menu, the calibration 
will automatically be applied whenever a picture is acquired from the referenced camera within the Vision 
Project.  Also, whenever the Vision Project is opened, the specified calibration files will be automatically 
opened and reloaded. 

Basic Camera Calibration 
All of the calibration methods including standalone vision (Camera Only) and robot guidance begin by 
calibrating the camera's pixel coordinate system into real world units of measure, typically millimeters.  In 
addition, this procedure adjusts for perspective distortion, which occurs when the camera is not perfectly 
perpendicular to the plane of the objects to be located.  The origin of the camera's coordinate system is 
set to the bottom left-hand corner of the camera image.   

After this basic calibration is completed, the vision system can be used for metrology operations or for 
other applications not needing a robot.  However, since this step does not include a transformation 
between the camera frame of reference and the world coordinate system of a robot, this step is not 
sufficient for vision-guided robot applications. 

This procedure relies upon the Standard Calibration Target Sheet and does not require a robot or any 
automated motion.   

Prior to executing the Calibration Wizard, the following steps must first be performed: 

at will allow you to browse to the directory location that contains the calibration (.dat) file. If 
del te an association between a camera and a calibration file, click on the Reset 

• The "General Calibration Instructions" section of this manual should be read.  
The Standard Calibration Target Sheet must be printed and available.  
The camera must be rigidl

• 
• y mounted, selected, and accurately setup in terms of 

its focus, aperture setting, and gain and offset. 
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The Calibration Wizard is fairly self-explanatory.  The following provides some additional information for 
first time users.  

»   To start this calibration method, select Tool > Calibrate Vision > Camera Calibration 
Wizard. 
 
»   Advance past the title page by pressing the Next key.  You can stop the calibration process 
at anytime by pressing the Cancel key. 
 
»   Sele orm the ct the type of camera calibration you wish to perform.  Camera Only will not perf
camera to robot calibration and is only appropriate for testing and standalone vision.  

 

»   Advance to the next page of the wizard and specify the size of the calibration target you will 
be using. 

194 



Camera Calibration 

 

This page permits you to select from one of the standard sizes that are provided on the PreciseVision 

that is fully visible within the camera's field-of-view.   

Calibration Target sheet or to manually enter the target dimension parameters if you have generated a 
custom sized target that is more appropriate for your application.   You should select the largest pattern 

The standard target has black squares printed on a white background, so the Dark Squares should 
normally always be checked.  

»   Place the Calibration Target Sheet in the same focal plane that you expect the primary part 
features to be located.  Position the sheet such that the pattern you have selected is fully visible 
in the field-of-view. 
 
»   Advance to the next page of the Wizard to adjust the binary threshold of the image and to 
set the size and position of the AOI that contains the target.  
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As instructed in the Wizard, you should view the Camera Window and adjust the size and position of the 
red square outline using the green handles so that the red outline completely surrounds the calibration 
squares. 

 

When the image is thresholded, it will appear as follows: 
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»   Follow the Wizard's instructions to compute the camera calibration using the target image. 

 

At the completion of the process, the Camera Window will appear as shown above, which indicates how 
vision tools were used to locate the calibration squares.  Each of the four sides of each square should 
have been automatically and accurately located with a Line Fitter tool. If a message indicates that an 
error has occurred, most likely, the Threshold value or the Dark Target check box were not set correctly.  
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This completes the Basic Camera Calibration procedure. 

Robot Visi
After the Basic Camera Calibration is completed, if vision is being used with a robot, the transformation 
from the camera's frame of reference to the robot's world coordinate system must be computed.  This 
information permits PreciseVision to send object X/Y/Z/Theta values to a motion controller in a form that 
can easily be used to define a pick-up location.  PreciseVision includes several different methods for 
performing this calibration because cameras can be mounted in a number of different positions (e.g. fixed 

lied 
 

 correspondence between vision 

 Calibration Instructions

on Camera Calibration 

in a stationary position, mounted on a link of the robot, etc.).  

Since the instructions for executing the Calibration Wizard are fairly self-explanatory, this section includes 
just an overview of the methods that are common to all of the procedures. 

In general, these methods compute the calibration data by having the operator move a customer supp
calibration disk to several positions in the camera's field of view.  At each position, a gripper or pointer
attached to the robot must be moved to the same position to establish a
positions and robot positions.  In order to execute this procedure, the robot's controller must be powered 
up and properly setup so that it can be safely operated. 

Prior to executing this calibration method, the following steps must first be performed: 

• The "General " section of this manual should be read.  

lar, relatively flat calibration disk and a pointer or gripper mounted to the 
ge of the robot must be obtained. The calibration disk's diameter is 

recommended to be roughly 10-15% of the width of the camera's field of view. 
The calibration methods typically rely upon locating the center of the disk at 
several different positions.  Consequently, if the disk is too large, its size would 
limit the maxim r of this disk should 
be selected to maximize its contrast with the background. The disk should also 

• The Guidance Controller for the robot must be powered on and interfaced via 
Ethernet to the PC that is executing PreciseVision. 

• The robot must be homed and capable of being moved.  Some procedures do 
not require the robot to nder power, while other do. 

• The Standard Calibration Target Sheet must be printed and available.  
• The camera must be rigidly mounted, selected, and accurately setup in terms of 

its focus, aperture setting, and gain and offset. 
• A circu

tool flan

um distance between center points. The colo

have a feature that aids the user in aligning the center of the pointer with the 
center of the disk. 

 be moved automatically or u

 
requi
mus

DANGER: Before proceeding with this procedure, please ensure that the 
robot has been properly mounted, all required safety interlocks have been 
installed and tested, and power has been connected. All safe guards 

red to permit the robot to be manually or automatically repositioned 
t be in place. For the Precise robots, this information is provided in the 

robot's Hardware Introduction and Reference Manual.
 

The following general instructions and  the conc he robot 
vision calibration procedur

 pictures illustrate epts at are common to all of t
es. 



Camera Calibration 

»   When prompted by the Calibration Wizard, s d pecify the IP address of the robot controller an
press the Connect button to establish an Ethernet connection between the PC and the 
controller. 

 

This connection is required in order for PreciseVision to d to 
permit manual and automatic control of the robot.  After nel 
in the main PreciseVision window will become active, al
based Virtual MCP can be used as well.  

As you execute the Wizard, you will be presented with v  
the teaching method, and moving the robot automatical
picture area.  These options are dependent upon the sp
performed. 

Independent of the specifics of the calibration procedure e a 
means for taking multiple pictures, visually locating a ca
camera's field of view, and recording the robot's corresp

The following series of pictures illustrates how a disk is  field 
of view and PreciseVision locates disk and marks the spot
robot's location also needs to be recorded. 

 automatically read the position of the robot an
 this connection is made, the manual control pa
though a hardware MCP or the standard web 

arious options for teaching locations, selecting
ly to return to picture locations or to clear the 
ecific camera calibration method being 

, fundamentally, all of these methods provid
libration disk in different positions within the 
onding positions.  

moved to various quadrants of the camera's
 with a circular indicator.  At each position, the 
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After this or sim rmation 
between the cam
the camera calib

This completes 

ilar data is collected, PreciseVision will automatically compute the required transfo
era and the robot.  This information is then stored in a camera calibration file along with 
ration data for subsequent use. 

the overview of the Robot Vision Area Camera Calibration procedures. 
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Appendix A: FAQ 

This section contains a compilation of frequently asked questions related to PreciseVision.  

A. General Questions  

1.  Wha

Frequently Asked Questions 

t do you do if PV was working but will no longer properly start up? 
 do I transfer my PV license to another host computer?2.  How  

3.  Wha

B. DALSA Cam

1.  What doe D indicate?

t PC TCP/IP ports are used by PreciseVision? 

eras 

s the DALSA camera LE  
2.  What do you do if you are not able to get an image with a DALSA camera? 
3.  What do you do if other NIC's stop operating after DALSA drivers are installed? 
4.  How do you eliminate diagonal stripes in the DALSA camera image?

C. IDS uEye USB Cameras 

1.  What do you do if you are not able to get an image with an IDS or USB camera? 
2.  What IDS uEye camera trigger and strobe parameters are available?

General Questions 

What do you do if PV was working but will no longer properly start up? 

Sometimes the preferences information for PreciseVision can become corrupted or can reference a PV 
project that is corrupted.   When this occurs, PV will fail to launch.  To work around this problem, do the 
following. 

1. Locate the folder where PreciseVision is installed. Typically, this will be 
"C:\Program Files\Precise Automation\PreciseVision V__\". 

2. Rename your preferences file "Preferences.vpr" to "Preferences.bad". 
3. Restart PreciseVision. 

If PreciseVision starts properly, please email your bad Preferences file and your PreciseVision projects to 
support@preciseautomation.com with a short explanation so we can diagnosis the problem. 
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How do I transfer my PV license to another host computer? 

The PreciseVision software is only licensed to execute on a single PC.  In general, if you need to execute 
PV on additional PC's, additional licenses must be purchased. 

However, if the PC on which PV is licensed to execute is being obsoleted, you can transfer a purchased 

V will no longer be permitted to execute 
on your old PC. 

To transfer a purchased PV license to another PC, perform the following procedure. 

1. Follow the standard procedure for installing PV on the new

PV license to a new PC.  

Note, as soon as you execute the following procedure, P

 PC. 
2. On the new PC, execute the procedure for licensing PV to obtain the PC's ID 

information.  This is needed to issue you a new license for this PC. 
3. Execute PV 2.0 or later on the old PC.  If you are executing an older version of 

PV, obtain a new version from the Precise Support website and install it on the 
old PC. 

4. Select "Help > Product Activation". 
5. Click the "Uninstall" button. 
6. Follow the instruction to execute the uninstall procedure.  After you execute this 

procedure, you will no longer be able to execute PV on the old PC. 
7. Email the following information to sales@preciseautomation.com and request 

that the license be transferred. 
o Your company name 
o The name of the individual that the license was issued to, if you know 
o The original license code displayed by the uninstall procedure 
o The uninstall code displayed by the uninstall procedure 
o The new PC's ID displayed by the licensing procedure 

8. Once you obtain your new license key, execute the standard activation process on the 
new PC. 

This completes the license transfer process. 

DALSA Cameras 

What does the DALSA camera LED indicate? 

The back surface of the DALSA camera that contains the Ethernet and DC power plugs includes an LED 
that indicates the current status of the camera.  The interpretation of the LED's color and blinking state is 
described in the following table. 

LED State Camera Status 

Off Camera is not receiving power 
Steady Red Camera is not initialized 

Slow Flashing Red Camera initialization problem.  Most likely indicates a 
camera hardware failure. 

Fast Flashing Red Camera is too hot 
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Slow Flashing Blue Waiting for an IP address 
Fast Flashing Blue Ethernet cable disconnected (no link) 

Steady Blue IP address assigned, PreciseVision not connected to 
camera 

Steady Green PreciseVision connected to camera, standard 
operational state 

Slow Flashing Green Camera waiting for hardware trigger to take picture 

Fast Flashing Green video state 
Continuous acquisitions in progress, standard live 

  

What do you do if you are not able to get an image with a DALSA camera? 

If you are not able to get a image from a DALSA camera from within PreciseVision, there are several 
possible s r this problem.  Most of the s and remedies d ply to systems 
that are being executed for the first time, but some are 
operated. 

A.  The DALSA camera may not be configured as t

ources fo  problem escribed below ap
appropriate for systems that have already 

he hardware to use within PreciseVision.  
mera devices and can even operate in a PreciseVision can operate with a variety of Ethernet ca

demonstration mode without a camera.  However, at a
The following procedure verifies that PreciseVision is c . 

ch typica
Automation > PV_ > PreciseVision. 

2. Open the Preferences pop-up by sele
Preferences. 

3. Select the "Camera Hardware" tab in 
4. Ensure that the "Genie" option is selec

Mapping" to specify the logical camera
camera. 

ny given time, only one camera type is permitted.  
onfigured to capture images from DALSA cameras

ecting Start > Programs > Precise 

cting the following within PV:  File > 

1. Laun PreciseVision, lly by sel

the Preferences pop-up window. 
ted.  You can also click on "Genie 
 number associated with each physical 
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B.  The required software drivers may not be installed.  The use of the DALSA cameras with PV 
requires the installation of three separate software packages on a Windows PC system. 

1. To verify that all three software packages have been installed, bring up the 
Windows Control Panel typically by selecting TStart > Settings > Control Panel.T 

2. Select T"Add or Remove Programs".T 
3. Verify that the following packages are installed:  (i) DALSA Coreco Sapera LT, (ii) 

DALSA Genie Framework, (iii) DALSA Sapera Network Imaging Package, and 
(iv) PreciseVision. 

4. If any of these packages are missing, refer to the PV installation instructions for 
installing the missing application packages. 

C.  No cameras found by the PC.  Typically after the software is installed and the PC is rebooted, any 
DALSA cameras will immediately be located by the PC and be accessible.  However, if you click on the 
small camera icon that is displayed in the Window's start bar  and see the "No Device Found" 
message in the Device's pop-up, it means that the PC could not locate a camera on its local Ethernet 
Network. 

 

1. Verify that the camera is receiving power and is properly connected to the 
network.  The LED on the camera should have initially been red and then 
changed to a blue color.  If the LED is not lit or is red, either the camera is not 
receiving power or is defective or is not connected to the network. 

2. If the camera LED is blue, the PC's firewall or virus protection is probably 
blocking the camera connection.  Disable your PC's firewall and turn off any virus 
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protection.  If the camera becomes visible by the PC, go to the DALSA website 
(Twww.imaging.comT) for information on how you still might be able to enable your 
virus protection or firewall. 

D.  The camera may not have an IP address compatible with your PC.  Normally, the camera will 
automatically obtain an IP address from a DHCP server within your network.  However, a DHCP server 
may not be available or the camera may have been set to a fixed (Persistent) IP address that is not 
consistent with your network.  If you click on the small camera icon that is displayed in the Window's start 
bar  and see "IP Error" in the Status area of the Device's pop-up, it indicates that the IP address of the 
camera is not set compatibly with your Ethernet network. 

 

1. Execute the "TDALSA Network Configuration ToolT".  Typically this is launched by 
selecting TStart > Programs > DALSA > Sapera Network Imaging Package > 
DALSA Network Configuration Tool.T 

 

 

 

2. Click on the Ethernet network interface card (NIC) that is connected to the 
camera. 

3. Select the "NIC Configuration" tab on the right.  This tab will permit you to 
change the IP address of your PC. Change the IP address and subnet mask to 
be compatible with the address of the camera as displayed in the Devices 
window shown above.  For example, in the previous picture, the camera IP 
address was 169.254.241.145.  IP addresses whose first number are between 
128-191 fall into Class B and require a subnet mask of 255.255.0.0.   Set a 
compatible IP address and subnet mask and click "Apply". 
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4. After you have selected a compatible address, the camera information should be 
displayed in the left hand window below the NIC.  If you click on the camera 
information, its IP information will be displayed on the "Device Configuration" tab 
as shown below. 

 

 

5. Enter the desired IP address and subnet mask for the camera and press "Apply". 
6. Repeat steps 2 and 3 to reset your PC to the previous IP information. 
7. Close the Devices window and double click on the camera icon in the start bar to 

redisplay this window.  The status should no longer indicate an IP Error. 

E.  The camera Ethernet drivers may be incorrectly configured.  If the camera and its Windows 
drivers are compatible and properly configured, the CamExpert Windows applications should always be 
able to display a live camera image. 

1. To test the camera and its Windows driver, launch the DALSA CamExpert, 
typically by selecting TStart > Programs > DALSA > Sapera LT > CamExpert. T  You 
should see the following application window. 
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2. Click on the camera listed in the top-left hand window and click the "TGrabT" button 
above the camera display window. 

3. If the camera and its Windows drivers are operating properly, you should see live 
camera video in the camera window and the "Frame/sec" above the video should 
be displaying the frame capture rate.  If this is all correct, close the CamExpert 
and restart PreciseVision T(NOTE:  The CamExpert and PV can not be 
executed simultaneously).T  PreciseVision should now be able to capture 
images. 

4. If the live video output of the camera was not displayed, try disabling 
unnecessary NIC's (especially wireless NIC's) by opening TMy Network Places > 
View Network Connections T.  Right click on unnecessary NIC's and select 
T"Disable"T. 
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5. If this did not resolve the problem, try disabling all unnecessary software options 
associated with the NIC connected to the camera.  To do this open TMy Network 
Places > View Network ConnectionsT. 

6. Double click the NIC attached to the camera to display the "Local Area 
Connection" window. 

7. Click on the "Properties" button. 
8. In the Properties window, uncheck all software services except for "CorSnid 

Driver" and "Internet Protocol (TCP/IP)", and press "Ok". 
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9. If this does not resolve the problem, there may be a fundamental incompatibility 
between your NIC and the DALSA camera.  Please contact Precise Automation 
for further assistance. 

  

What do you do if other NIC's stop operating after DALSA drivers are installed? 

When you install the DALSA camera drivers, they automatically add camera specific software that is 
executed as part of the driver for every Ethernet card (NIC) in your PC.  For certain NIC's, this additional 
software can cause the Ethernet interface to malfunction even if you do not connect to a camera using 
this device.  This seems to often be the case with wireless Ethernet interfaces in particular. 

To disable the DALSA specific software for a NIC, do the following: 

1. Access the software options for the NIC by opening TMy Network Places > View 
Network ConnectionsT. 

2. Double click the NIC that is causing the problem to display the "Local Area 
Connection" window. 

3. Click on the "Properties" button. 
4. In the Properties window, uncheck the software labeled "CorSnid Driver" and 

press "Ok". 
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How do you eliminate diagonal stripes in the DALSA camera image? 

You may sometimes see a blinking pattern of diagonal stripes in the live video image generated by a 
DALSA camera.  For example, in the image below, the true image should be a grid of horizontal and 
vertical lines.  Interspersed in the grid is a pattern of diagonal lines that is not in the real image. 

 

This pattern of lines is due to a problem with the DALSA communications buffer size.  To correct this 
error, do the following:. 

1. Exit from PreciseVision. 
2. Start the DALSA CamExpert application.  Normally, this can be launched from 

the Start bar by selecting:  TStart > Programs > DALSA > Sapera LT > 
CamExpertT. 

3. Press the "Grab" button to verify that the problem can still be seen. 
4. Press the "Grab" button again to stop the live image capture mode. 
5. In the "Camera Information Parameters" table, select the "GigE Vision" tab. 
6. Change the "Network Configuration Mode" from "Automatic" to "Manual". 
7. Decrease the size of the "Packet Size (in Bytes)".  This value might be set to 

1984.  Set it to 1500 instead. 
8. Press the "Grab" button to verify that the problem has been corrected. 
9. Exit the CamExpert application, saving your changes and restart PreciseVision. 
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IDS uEye USB Cameras 

What do you do if you are not able to get an image with an IDS or USB camera? 

If you are not able to get a image from an IDS or other USB camera from within PreciseVision, there are 
several possible sources for this problem.  Most of the problems and remedies described below apply to 
systems that are being executed for the first time, but some are appropriate for systems that have already 
operated properly. 

A.  IDS uEye/USB cameras may not be configured as the hardware to use with PreciseVision.  
PreciseVision can operate with a variety of USB and Ethernet cameras and can even operate in a 
demonstration mode without a camera.  However, at any given time, only one camera type is permitted.  
The following procedure verifies that PreciseVision is configured to capture images from IDS uEye or 
other USB cameras. 

1. Launch PreciseVision, typically by selecting TStart > Programs > Precise 
Automation > PV_ > PreciseVision.T 

2. Open the Preferences pop-up by selecting the following within PV:  TFile > 
PreferencesT. 

3. Select the "Camera Hardware" tab in the Preferences pop-up window. 
4. Ensure that the "Direct Show (USB)" option is selected.  
5. Restart PV to put this change into effect. 
6. Return to this panel and click on the "DS Mapping" button to select the USB 

cameras to utilize and define their operational parameters:  image resolution, 
color or grayscale mode, and whether the image is to be reversed. 

 

B.  The required software packages may not be installed.  To utilize the IDS uEye cameras with PV 
the following software must be installed on the PC: PreciseVision, DirectShow (DirectX) and the IDS 
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camera driver.  DirectX is shipped as part of the Windows operating system and should therefore not be a 
problem.  However, if the other software packages are missing, you will not be able to capture camera 
images. 

1. To verify that all of the required software has been installed, bring up the 
Windows Control Panel typically by selecting TStart > Settings > Control Panel.T 

2. Select T"Add or Remove Programs".T 
3. Verify that the following packages are installed:  (i) IDS uEye, and (ii) 

PreciseVision. 
4. If either of these packages are missing, refer to the PV installation instructions for 

installing the missing application packages. 

C.  Cameras may not have proper unique or registered ID's.  Each IDS camera must have a unique 
ID stored into its NVRAM and these ID's must be registered with DirectShow in order for PreciseVision 
communicate with the camera.  If an IDS camera is being used and it has the default ID of "1", it should 
be possible to communicate with the camera.  However, if multiple IDS cameras are being used or the 
default camera ID is not set to "1", one or more cameras may not be operating properly. 

Please refer to the PreciseVision IDS Camera Interface Installation section for instructions on setting the 
camera ID's and registering the ID's with DirectShow. 

D.  The camera resolution or display mode may be incorrect or incompatible.  USB cameras 
typically have several different resolutions that they will operate at and several different formats that can 
be used to fetch their image data.  The formats that are supported by PreciseVision and its DirectShow 
interface, which are the most common formats, are as follows: 

RGB8 (8-Bit Grayscale) 
RGB24 (24-bit color with 8-bit R,G,B components) 
YUY2 (16-bit color) 

All IDS cameras have resolutions and formats that are compatible with PreciseVision.  However, if you 
are not able to view the image, please refer to the IDS Camera Interface Installation section for a 
description of how to select the resolution and display format. 

If you are using a third party camera, there is a possibility that your camera driver does not support 
DirectShow or that it does not have an image format that is compatible with PreciseVision.  If this is the 
case, you will not be able to use the camera with this software.  However, please refer to the IDS Camera 
Interface Installation section for a description of how to select the resolution and display format to see if 
these setting can resolve your problem.  Please keep in mind that Precise cannot provide assistance 
with cameras that are not tested and fully supported by Precise. 

What IDS uEye camera trigger and strobe parameters are available? 

Most IDS uEye cameras have a hardware input signal for triggering the start of a camera acquisition and 
a hardware strobe output signal for triggering a strobe to freeze moving parts.  In their native operating 
mode, IDS cameras provide a number of parameters for controlling the operation of these two hardware 
signals.  Unfortunately, IDS does not currently provide the full set of parameters when a camera is 
operated via DirectShow, as is the case for PreciseVision. 

The following table describes the parameters that can currently be modified within PreciseVision and the 
fixed values for those parameters that cannot currently be altered. 
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IDS Camera Parameter Setting Within PreciseVision 

Trigger Mode 

This specifies if the trigger occurs on the rising or falling edge 
of the external hardware input trigger signal.  This parameter 
can be specified within PreciseVision by setting the 
TriggerActive property of the Acquisition Tool that defines 
the picture to be taken. 

Trigger Delay 
This defines the delay between when an external hardware 
trigger signal is received and the start of the camera 
acquisition.  This is currently fixed at 0 microseconds. 

Flash Delay 

This is the delay between when an external hardware trigger 
or internal software trigger (from PreciseVision) arrives and the 
strobe output is asserted.  This is currently fixed at 0 
microseconds. 

Flash Duration 
This is the time that the hardware output strobe signal is 
asserted high when the strobe is triggered.  This is currently 
fixed at 5000 microseconds. 
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Appendix B: Remote PC Control 

PreciseVision Remote PC Control 
Even though PreciseVision executes as a standalone application within a PC environment, its user 
interface and vision processing capability can be integrated with the user interface of another PC 
application.  PreciseVision provides the ability for any PC application to send commands to PreciseVision 
using TCP/IP.  These commands can specify the format of the PV window and its size and position on the 
screen.  This set of commands also includes methods for triggering the execution of vision processes and 
for reading and writing data within PreciseVision.  So, these commands allow any PC application 
environment to manipulate PreciseVision to look and feel like it is part of the environment without the 
need for complicated installation of COM objects or distribution issues. 

The communication interface uses simple string messages that are passed through an open TCP socket 
connection.  When PreciseVision begins execution, it automatically runs a remote TCP server in a 
background thread.  This thread listens on port (1450) and is dedicated to servicing commands from 
external applications.  This interface can be tested and debugged using any Telnet session connected via 
the communication port. 

Whenever the communication connection is lost, the PV user interface is automatically restored to its 
normally stand alone mode, i.e. the form title, status, menu and toolbars are all displayed. 

Command Definition 

Each transmitted command must conform to the following string format: 

command [key] arg1 arg2 arg3 … arg20 {LF} 

While in Telnet mode, the command response may be as simple as a {LF} or it may be a string that 
returns requested information.  Please see the command description table below for details. 

In general, the format of the response returned for each command is formatted as follows: 

errorcode arg1 ... argN {LF} 

If no error occurs, the returned "errorcode" will have a value of "0" to indicate success.  If an error occurs, 
a negative error code is returned and "arg1" contains the string representation of the error.  For some 
commands, "arg1 ... argN" contains information returned by PreciseVision.  

Supported Commands 

The following table describes the legal commands.  Please note that the CMD name is case sensitive. 

CMD KEY Argument List Description & Responses 
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getnumresults   T<tool>T 

Retrieves the number of results that exist for 
the specified tool.  The T<tool>T must be of the 
form Tprocessname.toolname.T 
 
The information returned by this command is 
as follows: 
 
T    <err> <num_results> T 
where 
    T<err>T:    Standard error code or 0 for 
success. 
    T<num_results>T:   The number of results 
available for this tool. 

getresults   T<tool> <index> T 

Retrieves the numeric results for a specified 
tool that was executed as part of a specified 
process. The T<tool>T must be of the form 
Tprocessname.toolname.T 
 
The information returned by this command is 
as follows: 
 
T    <err> <x> <y> <z> <yaw> <pitch> <roll> 
<objectID> <passed> <value> <info_array> T

TwhereT 
T    <err>:T         Standard error code or 0 for 
success. 
T    <x> <y> <z> <yaw> <pitch> <roll>:  T 
Cartesian coordinates for the located object.
T    <objectID>T:  Optional index that some 
tools return to identify the specific instance of 
an object that is located.  
T    <passed> T:    0 if tool's inspection was 
successful or -1 if the inspection failed.  
T    T<value>:     Value of the tool property that 
was tested by the vision inspection process. 
T    <info_array> T:  Please see the information 
on the specified tool for a description of any 
additional result values that are returned.  

getstringresults   T<tool> <index> T 

Retrieves the results for tools that return a 
string value instead of numerical results. For 
example, this command should be used for 
the Barcode Reader tool.  The T<tool>T must 
be of the form Tprocessname.toolname.T 
 
The information returned by this command is 
as follows: 
 
T    <err> <string>T 
TwhereT 
T    <err>:T         Standard error code or 0 for 
success. 
T    <string> T:    String value that is returned by 
the tool.  This is identical to the output that is 
sent to a Guidance Controller.  Please see 
the information on the specified tool for a 
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description of any string result values that 
are returned.  

load image T<file_name>T 

Loads an image from a specified file into the 
camera display buffer. 
 
    T<file_name>T:  The full path and name of a 
image file to be loaded. 

load importproject T<file_name>T 

Loads a PreciseVision project from a 
specified file and mergers its contents with 
the currently loaded project. If the new 
project contains any processes or tools 
whose names conflict with items that are 
already loaded, "_r" is appended to the name 
of the new item. Also, any camera calibration 
information that is contained in the new 
project is ignored. 
 
    T<file_name>T:   The full path and name of 
the PreciseVision project file to be loaded 
and merged.  

load layout T<file_name>T 

Loads a window layout given a specified 
path and file name. 
 
    T<file_name>T:  The full path and name of a 
compatible PV layout file.   This type of file is 
created when a layout is manually saved. 

load project T<file_name>T 

Loads a PreciseVision project file from the 
disk. 
 
    T<file_name>T:   The full path and name of 
the PreciseVision project file to be loaded. 
This allows a PC based application to 
change the project or override the default 
project loaded when PV starts. 

property set/get T<property> 
<value> T 

Reads or writes the value of a specified 
property of a specified tool.   The T<property>T 
must be of the form Ttoolname.propertyname.T

 
For write operations,T <value> Tdefines the 
new property value that is set.  
 
Not all properties are available for reading 
and/or writing. Please see the vision tool 
definitions for details on each tool type's 
properties.  
 
As a means for transmitting system 
information between PreciseVision and 
Precise Guidance Controllers, a special built-
in T"System"T tool always exists.  For the most 
part, this tool duplicates functionality 
available via explicit Remote PC Control 
calls.  However, some functionality is only 
available via the System tool.  If required, the 
System tool can be accessed by specifying it 
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as the Ttoolname T in this command.  For a 
explanation of the available Tpropertyname' Ts, 
please consult the TGuidance Programming 
Language Dictionary Pages T. 

run   T<process>T 

Initiates execution of the specified vision 
process. 

set displaymode T<mode>T 

Dictates the contents and visibility of the PV 
window.   The permitted values for T<mode>T 
are as follows.  
 
    0: Resets display mode to normal display. 
PV returns to stand alone mode with all 
normal windows, toolbars, menus etc. 
available for use. 
    1:  Displays only the camera window and 
the current Tool's window.  The PV form 
border, title, and status bars are all hidden. 
    2:  Displays only the camera window. The 
PV form border, title, status bars and all 
dockable controls are all hidden. 
    3:  Minimizes the PV window. 

set layout T<layout_type>T 

Selects one of the predefined panel layouts 
to display within the PV window based upon 
the value of T<layout_type>T: 
 
    0:   Edit mode 
    1:   Runtime mode 
    2:   Calibration mode 

set position T<xpos> <ypos> 
<width> <height>T 

Positions and sizes the PV window relative 
to the screen. 
 
    T<xpos>T:   X position relative to top left of 
screen 
    T<ypos>T:   Y position relative to top left of 
the screen 
    T<width>T:   width to set window 
    T<height>T:  height to set window 
 
All units are in pixels. 
 
Note: T<width> Tand T<height>T are optional. If 
not specified, only the X,Y position of the 
window will be altered. 

set topmost T<mode>T 

Specifies whether the PV window is on top or 
other windows.  The value of T<mode>T is 
interpreted as follows:  
 
    0:   Normal (resets topmost property) 
    1:   Keeps window on top. 
 
This allows PV to stay on top of another 
application while the user clicks or drags 
windows. 

set zoom T<scale_factor> T 

Selects the Zoom scale factor for the camera 
window.  The T<scale_factor>T ranges from 0 
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to 5 in steps of 0.1. A value of 0 will 
automatically set the zoom so that the entire 
frame buffer will be displayed within the 
camera display window. 
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Appendix C: Multi-Instance Execution 

PreciseVision Multi-Instance 
For most applications, a single copy of PreciseVision is connected to a single robot. If an application 
requires PreciseVision to communicate with multiple robots or if one or more robots need to overlap the 
processing of several cameras, the Multi-Instance version of PreciseVision should be utilized. This 
version of the software permits several instances of PreciseVision to be executed concurrently on the 
same PC.  

Each instance of PreciseVision executes completely independently of other instances. In particular, each 
instance:  

1. Connects to its own set of cameras with their own camera calibration data.  
Individual cameras cannot be shared by different PV instances. Different 
instances can simultaneously capture images from separate cameras subject to 
the bandwidth limitations of the PC. In the standard version of PreciseVision, if 
two or more cameras are connected to a PC, pictures must be sequentially 
captured and analyzed. In a PC executing multiple instances of PreciseVision, 
each instance can take a picture at any time without regard to any acquisitions 
being performed by another instance, subject to the bandwidth limitations of the 
PC's hardware interfaces.  

2. Can only connect to a single camera interface type (i.e. Ethernet GigE or USB), 
but different instances can be connected to different camera interface types.  

3. Connects to a single robot or a single motion controller or nothing. This allows 
multiple robots to share a single PC and permits a robot or motion controller to 
perform simultaneous frame grabs and vision analysis by referencing different 
instances of PV on the same PC. In the standard version of PreciseVision, only a 
single robot or motion controller can be connected to a single instance of PV 
running on the PC.  

4. Loads it own Vision Project and executes its own Vision Processes. This enables 
each robot to execute either the same Vision Process or independent Vision 
Processes.  

5. Operates with its own set of Preferences. This enables independent control of 
display options and other parameters.  

Software Installation and Activation  

The Multi-Instance capability is only supported in PreciseVision 3.0 and later versions. Both the standard 
and the Multi-Instance software are provided in the same software installation distribution. To load the 
software and camera drivers, follow the standard software installation instructions detailed in the 
TSupported Hardware and Software Installation ChapterT of this manual.  

The only difference in the installation procedure is the specific software license key that is utilized to 
activate the software. The “PreciseVision Multi-Instance” key must be installed in place of the standard 
“PreciseVision” key.  



Appendix C:  Multi-Instance Execution 

223 

NOTE: When the PreciseVision Multi-Instance key is installed, it replaces any 
previously installed standard key. Unfortunately, this will de-activate any 2.x and older 
versions of PreciseVision that are still installed on the PC. 

 

Executing Multiple Instances  

Once PreciseVision 3.0 or later is loaded and the Multi-Instance key is installed, multiple instances can be 
executed. Each time the TStart > Programs > Precise Automation > PV 3.0 > PreciseVisionT menu item is 
selected; only the first instance of PreciseVision is initiated.  

To execute instances 2 to N, a command line switch must be specified when starting PreciseVision. In 
Windows, the simplest means for accomplishing this is to create a “Shortcut” to PreciseVision.  

1. To create the shortcut, locate the PreciseVisionGUI.exe file. This is normally 
stored in TC:\Program Files\Precise Automation\PreciseVision x.x\T. 

2. Right click on this file and select TCreate ShortcutT.  
3. Right click on the new shortcut and select TPropertiesT.  
4. On the Shortcut tab of the Properties page, edit the TTargetT to add a number from 

2 to N after the “.exe” to specify the instance of PreciseVision that is to be 
launched by the Shortcut. 

At the conclusion of this process, a typical Shortcut Property page that would launch the second instance 
of PreciseVision will look like the following: 
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Below is a screen shot that illustrates two instances of PreciseVision Multi-Instance simultaneously 
executing.  Pleases note that the second instance is recognizable by the "(2)" following "PreciseVision" 
name in the title bar. 

 

Once multiple instances of PV have been launched, a robot controller can communicate with a specific 
instance of PV by executing the GPL Tvision_objectT.IPAddress and Tvision_objectT.Instance methods to 
specify the specific PC and instance of PV to be accessed.  
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Appendix D: Error Messages and Warnings 

PreciseVision Error Messages and Warnings  
PreciseVision displays error messages and warnings in the Vision Results window and the Tool Property 
Lists.  Errors indicate more significant problems and may stop the execution of a Vision Process.  
Warnings are typically benign.  Most of the error messages and warnings are self explanatory.  The 
following table describes a few of the more important messages. 

Code  Text  Type  Description  

  
FINDER_DIFFERENT_ 

CALIBRATIONS  
Warning  

If the camera calibration pixel-to-mm X or Y scale 
factors are changed after a Finder Tool template 
has been taught, the template must be retrained.  
While the Finder produces results in calibrated units, 
some of its calculations rely upon these scale factors. 

-4024 
VISION_TOOL_ 
NO_RESULTS 

Warning 

Indicates that a vision tool generated results data, but 
that the tool failed its inspection operation.  Normally, 
this error is not seen because if a tool fails, it will not 
produce any results.  However, if the 
ResultOnNotFound property is TRUE, vision 
tools generate results for successful and failed 
operations.  This warning marks results that were 
produced by a failed tool.  

-4025 
VISION_TOOL_ 

RESULTS_MISMATCH Error 

This error is typically generated by an Inspect List 
Tool if its output is invalid because one or more of the 
referenced tools did not generate the same number of 
results.  This can occur if the Inspect List operates 
on the output from a tool that generates multiple 
results, such as a Finder, and the Inspect List 
contains multiple inspection operations.  If one or more 
of the inspection tools fail, they will not generate 
results so the Inspect List will be operating on 
arrays of results that are different in length.  To resolve 
this problem, in the Preferences, turn on "Return 
results if not found".  This will enable the 
ResultOnNotFound property and force tools to 
return results even if if the tool's inspection operation 
fails.  
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